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Preface
Despite the expenditure of millions of dollars for computer hardware by universities, the 
microcomputer revolution in higher education has not yet fulfilled its promise. Perhaps the 
promised benefits will materialize, but we doubt that will happen until a more balanced 
view of the relative importance of investments in hardware and software occurs. Without 
innovation in serious software designed to serve the special needs of scholars, much of the 
potential impact of computers cannot materialize. In our opinion higher education has yet 
to realize a fact well known to agricultural engineers, power units without the implements 
to connect them to the tasks leads to severe loss of benefit.

DiscoverPro™ (DP)was designed and created specifically as a productivity tool for higher 
education. Scholarship in both teaching and research requires access to the relevant, ever-
increasing literature. Traditionally this has meant tracking citations and abstracts for the 
published literature in your personal library and in public libraries. DP ‘s graphic interface 
makes this task easier, but also expands the scope of bibliographic support dramatically.

DP breaks many traditional barriers. For example, citations usually have been restricted to a 
single language because of the character set limitations, regardless of the language of 
publication. Full sets of special characters for mathematical and chemical symbols have not 
been supported. Likewise, bibliographic software designed for personal computers has not 
supported the full scope of the citations required by professional librarians, i.e., such as 
provided by the USMARC system used by the United States Library of Congress. 

Rather than simply pointing to the actual literature, DP also supports the storage, retrieval 
and distribution of the actual scholarly materials—including fully formatted documents 
that include color, sound, complex visual images, and animations. DP provides a link to 
existing Internet software for the remote, unassisted retrieval of documents and other 
multimedia, instructional materials by scholars. In other words, DP supports ‘electronic 
publishing’.

Many people have contributed to the creation of this software. At Cornell University many 
individuals helped nurture the evolution of DP. M. Stuart Lynn’s vision of the potential of 
electronic publishing was particularly influential. He suggested treating fully-formatted 
documents as QuickTime™ movies, a concept we implemented. Lynne Personius suggested 
that professional librarians need a microcomputer-based USMARC bibliographic retrieval 
tool; we implemented it. Celeste Roach shared her suggestions concerning ease-of-use of our 
graphical interface at an early stage of its evolution, and were implemented. Bill Garrison 
also provided timely suggestions, especially concerning the import features that we believe 
to be vital for improving the cost to benefit relationship that has heretofore limited the 
usage of personal bibliographic tools. John Saylor’s enthusiasm for DP lead to an extension 
that allows you to automatically catalog the files on your hard disk and to extract the 
contents of text files (such as e-mail) for automatic indexing and searching for related items. 
Naomi Dushay facilitated the early testing by distributing DP to beta testers at Cornell.
Bob Thomas, also at Cornell, but representing the requirements for the NSF sponsored 
SYNTHESIS Coalition of eight engineering campuses, suggested that we enable DP to be 



used for the search, remote retrieval, and launching of multimedia teaching materials. To 
do this we added a file pointer field type to the existing four—text, picture, sound and 
QuickTime movie—making DP an extraordinary organizer of resources external to DP. We 
created several separate, optional applications linked to DP via Apple Events to provide this 
support. Steve Worona’s and Mark Mara’s experience were useful in guiding our approach 
to the networking connection. We are pleased to participate in this bold and ambitious effort 
led by Tony Ingraffea to improve engineering education. Their project is a wonderful 
exception to the hardware-centered approach common to higher education.

Our quality assurance efforts have been aided significantly by members of our families—
especially Nancy, Patti, A. Ted, John, and Dick. Patti provided the original art for the logon 
splash banner. Franklin Griffin III provided extensive debugging support. We are grateful to 
the many other unnamed individuals who also contributed to the creation of DP.
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DiscoverPro™

The Bibliographic / Multimedia Database

Introduction

Overview: DiscoverPro (DP) is a completely new multimedia database 
program created specifically to serve the needs of scholars. In common with 
other general database programs, DP provides an environment for storing, 
locating, and retrieving information. As with traditional database programs, DP 
organizes the stored information as records consisting of one or more fields. For 
example, if DP were used as a telephone directory, it would store as a block the 
information pertinent to a particular person . The record would consist of one or 
more fields of information such as the person’s name, address, and telephone 
number. Each field would have an identifying name. 

An efficient database, even one as simple as a telephone directory, has to be 
structurally organized A simple record might consist of a single, free-form text 
field, but suppose you wanted to use multiple fields to organize the information, 
e.g., to store both home and business phone numbers, both home and business 
addresses, fax numbers and e-mail addresses. Suppose you wanted to add fields 
later. With DP you can do all of these and more.

To create records, you manually type the data using the typing aids DP provides. 
For example, If you type frequently repeated entries, such as a city or state in 
abbreviated form , DP can automatically replace those entries with an expanded 
form. Alternatively, you can transfer into your records the information from a 
previously created text file if the data in that file was created according to one of 
three common formats (tagged, character-delimited, and fixed length) and have a 
common, consistent organization. This capability for reading files (called 
importing) endows DP with a crucial productivity advantage when you use if for 
bibliographic retrieval. Rather than manually typing these citations, you can 
build your personal bibliographic files by selecting records from commercially 
available sources. DP provides two additional labor saving features. When 
entering records manually, you can easily select the fields that appear on the 
screen and their sequence to match your interests and the organization of the raw 
data. Rather than requiring publisher-supplied import translators, you create 
your own using a ‘drag and drop’ technique in a word processor -like window. 
The process of creating a database might extend over an extended period as your 
needs evolve.
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After you create the records, DP provides powerful tools for locating the records 
of interest to you. You can sort the records alphabetically by the last name of the 
person, and then scroll through the records to inspect those of interest. If your 
database has thousands of records, you will need the more powerful tools 
supplied in DP. You can locate records that have a particular text string 
embedded somewhere within, regardless of the position of the text within the 
record. A somewhat more specific search could restrict ‘matches’ to a text string 
that appears within the name field, but not the city field. Very complex 
conditions can be applied to such searches. DP has two innovative features that 
make searching easier. Eight user-named folders are provided to group the 
records you select. You can manually select specific records in the database and 
‘drag and drop’ them into the folders or automatically select records matching 
user-specified search criteria. As a way of refining a search, you can search any 
folder and store the matching records (or ‘hits’) in any other folder. The other 
innovation is a graphical approach to the forming of search criteria. Traditionally 
you would have formed these search criteria (called Boolean statements) using 
algebraic statements containing the ‘and’, ‘or’, and ‘not’ operators and grouping 
parentheses.

After locating the specific records of interest, you can create output (referred to as 
‘exporting’) in various forms. The simplest form, of course, is to display the 
records on the screen. You can create and name multiple formats for displaying 
the records—either all records or just those stored in a particular folder. By 
sorting records you can put them in the order you want. To format the output, 
select the select the records and the specific fields, e.g., the name and phone 
number, and specify the order of the fields within the records. You define this 
output format in DP’s word processor-like formatting environment using the 
convenient ‘drag and drop’ technique. You can create and name any number of 
alternative formats for future use. The USMARC format used by professional 
archivists is pre-defined for you. You send the output to the screen or to a file 
using one of the output formats. If you follow a standard format for field entries 
(such as a person’s last, first, middle names in a particular order), DP can create 
the bibliographic output that matches the requirements of a particular publisher. 
You can send output to a standard text-only file without preserving the character 
formatting or in a format-preserving RTF file used by most word processors.

DP provides numerous database maintenance tools. For example, you can locate 
and remove duplicate records (a feature especially useful when you import 
records automatically from multiple commercial sources over an extended time 
period. A generalized find and replace capability permits global modifications to 
the fields such as replacement of abbreviations. At any time you can add a new 
field to any specific record or to all records. When you remove records, DP 
simply disconnects the pointer that points to that record without erasing the 
record and without moving all the following records to reclaim its file space. A 
compact command allows you to force the recovery of the disk space freed by 
deleted records. Splitting a database into two parts or conversely, merging two 
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compatible database files into one is easily accomplished by a ‘dragging and 
dropping’ action. Finally, in the event of a corrupted file, DP can recreate the 
pointers to recover intact records.

Besides handling free-form text, DP also supports multimedia formats: pictures, 
sound, and movie fields, all now widely used in scholarly work. Any record can 
consist of any combination of any number of these field types. This means that 
DP is a general-purpose Macintosh database application designed to handle non-
numeric ‘data’ with ease. 

DP’s forte is the handling of bibliographic data. Special assets include: entries of 
widely variable lengths; citing of numerous and diverse types of intellectual 
materials (books, journal articles, software, sound recordings, movies, etc.); 
multilingual diversity (Roman and Non Roman fonts); handling of special 
symbols for mathematics and the sciences as well as for languages; support 
needed by professional librarians (such as required for the transfer of complex, 
machine-readable records produced by the U.S. Library of Congress); and a 
simple interface for handling a less complex, but different set of bibliographic 
tasks by individual scholars in all fields.

To be an acceptable, working bibliographic tool, a database must handle routine 
tasks in a way that is intuitive and easy. The most nettlesome obstacle faced by 
the user of bibliographic software is convenient and accurate data entry. Easy, 
manual data entry remains necessary for some tasks, but is much less important 
now because obtaining machine-readable records from on-line and CD-ROMs 
has become commonplace. Therefore, accurate, timely and convenient transfer of 
records from these sources into a well-designed, personal database has become 
essential.

By implementing the tag system used in the USMARC standard for citations, DP 
can import all records generated by the U.S. Library of Congress. Because DP’s 
structure-defining tag file is editable, you can handle many applications besides 
bibliographic citations. DP supports the standard uses of so-called ‘flat-file’ 
databases, such as mailing lists, inventories, etc. 

DP’s unique file structure allows you to modify the organization of records at 
any time. Furthermore, you can define and use any number of formatted views 
of DP records (choice of field entries, their order, text attributes, layout), yielding 
an uncommon degree of flexibility. Remarkably, DP offers many of the 
advantages of a relational database while retaining simplicity of structure.

Educational uses of DP hold great promise. For example, DP provides a tutorial 
framework which supplements and extends the traditional text and static picture 
paradigm with digitized sound and movies. Instructional materials augmented 
with color pictures, sounds (including voice), and color movies with 
synchronized sound result in greater clarity and usefulness. For example, 
learning a foreign language vocabulary should be faster with DP than with flash 
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cards because it lets you hear correct pronunciations and see the correct font. 
Printed results of such self-diagnostics can further aid the learning process. 
Engineering courseware can include movies of dynamic processes (e.g., 
vibrations used during mechanical fruit harvesting or the movies of rapid 
infiltration of chemicals through the soil) which you can view frame-by-frame for 
detailed analysis. 

Electronic publishing is now feasible with DP. DP displays electronic documents 
ranging from text-only documents such as course catalogs and course and room 
rosters to complex technical documents involving text, graphics, mathematics, 
etc. By transforming each page of a word processor document into a movie frame 
and transforming scanned images, VCR movies, etc., into QuickTime movies, DP 
can play them back. The customary publishing cycle of ‘print, then distribute’ can 
change to ‘distribute, then print’ for more economy. This format is especially 
suited for browsing complex, fully-formatted documents distributed in electronic 
format, making possible immediate distribution worldwide via computer 
network. In addition to supporting QuickTime movies having larger than usual 
frame sizes and color, we have extracted the QT handling code to form a simple 
display application called DocuView™ that we describe in the Appendix.

These examples illustrate non-numerical uses of DP; this first version 
intentionally does not include any computational capabilities. Furthermore, the 
screen and page layout capabilities of DP intentionally differ significantly from 
those customarily found in business oriented databases. The remainder of this 
chapter is more technical, but provides a context for understanding DP 
innovations more easily.

Graphical Interface: The DP interface reflects the ‘look and feel’ of Apple’s 
System 7 to promote user-friendliness. For example, the tag editor window for 
creating the database structure for fields and subfields mimics System 7’s 
hierarchical approach to folders. The document window uses System 7-like 
folders for storing subsets of records generated during searches. DP uses the 
‘drag and drop’ paradigm throughout. For example, to define a sort or a search, 
you simply drag a field name from a list in a floating window to the Sort or the 
Search window, eliminating errors due to spelling inconsistency. To rearrange 
lists manually, simply drag and drop the entries at a new location. 

Besides the System 7 features alluded to earlier, such as QuickTime movies, DP 
supports Publish and Subscribe. DP-generated results can be ‘published’ as a 
special intermediate file called an ‘edition’; then another application can 
‘subscribe’ to that edition file by linking to it. Whenever you update an edition 
using DP, the contents in the linking automatically reflect the change. DP 
supports Apple Events which provides an even more immediate 
communications linkage. Another application with Apple Events support can 
send requests to DP and retrieve the generated results for its own use. This 
means, for example, that an Apple Events savvy word processor can use DP to 
retrieve correct citations to journal articles without visibly switching between 
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applications such as required to perform a copy and paste operation. DP’s 
functionality is expandable through Apple Events linkages as discussed later in 
this Chapter.

Interface Innovations: DP complies fully with ‘the’ Macintosh interface 
standards. However, some interface innovations implemented in DP provide 
even greater ease of use in this multimedia database. To move user-selected 
records into the grouping folders called ‘Set Folders,’ simply drag and drop them 
there. Similarly, to drag records from the window of an open database into 
another database, simply drag and drop them into place. To assign field names 
for a sort or search, just drag the names from the Fields window into the Sort or 
Search window. To remove fields from either list, simply drag the entries past the 
window border until the cursor changes into a trash can and release the mouse 
button.

DP supports four types of views of records: Browse, Edit, Import, and Export. 
The Browse mini window displays multiple, user-selected, user-ordered, 
formatted fields in a window simultaneously. This ‘mini’ window provides a 
non-editable, compressed view of one or more lines for comparative purposes. 
Very rapid scrolling makes this an excellent environment for manual searching. 
Up to nine browse mini-windows (one for each of the eight ‘Set Folders’ and one 
for the ‘All Records’ Set can be open simultaneously. Switch to the Data Entry or 
Edit view to examine and to modify records individually. To switch to the Edit 
view of a record, double-click on a record in the Browse view. To revert to the 
Browse view, click on the ‘End Editing’ button in the Edit view. The Import 
process brings organized data from a text file into an open DP database having a 
selected, previously defined tag file. DP imports tagged, character delimited, and 
fixed record length text files. The Export window displays the output reports you 
generate, including text attributes and paragraph formatting. Output can 
originate from ‘All Records’ or from any of the ‘Set Folders’. DP routes output to 
the screen, to an existing file, or to a new file. Output files may contain text—with 
or without out character formatting. Rather than using a specialized scripting 
language, DP uses a format-by-example word-processor style window to define 
the transformation process for these windows.

DP introduces a graphical interface for defining search criteria that are always 
syntactically correct. Select a record attribute, such as ‘Date Created’ or ‘Record 
Size’, from a scrollable list, or select and drag a field name from the Fields 
window into the scrollable Search list to create ‘tiles’. The ‘AND’ and ‘OR’ 
operators connect these Boolean statements (or tiles) to form arbitrarily complex 
search conditions. 

DP Menus: According to the Macintosh interface standard, the main list of 
pull-down?pop-down menus appears across the top of the screen, grouping 
related commands. The Apple menu is always the leftmost menu and provides 
access to the items placed in the Apple Menu folder of the System 7 System 
folder and to the ‘About DiscoverPro™...’ information. The standard File, Edit, 
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and Windows menus are always present. The File menu provides access to file 
handling commands and importing and exporting records to and from files; file-
related utilities such as file compaction and repair are included here. Also 
reflecting the standard, printing and exit from DP are handled at the end of the 
File menu. The Edit menu provides access to record modification commands 
such as cut, copy and paste, record selection, the find and replace commands and 
various operational preferences. The Windows menu provides commands for 
bringing any open window to the front and, therefore, making it the active 
window. In addition, this menu provides access to the Abbreviations window 
(used to define field-specific control of input and abbreviation expansion) and 
the floating window that list your working subset of the field names. This menu 
also provides access to the tag files of field names which define the file structure. 
Finally, this is where you gain access to the applications which are compatible 
with Apple Event and, therefore, can interact with DP.

Depending upon the situation, other menus supplement these: Records, Formats, 
Font, Size, Style, Text, Picture, Sound, Movie, etc. When dimmed, menu 
commands are not applicable under the current circumstances and, therefore, are 
not available. Even if the menu bar is unchanged, entries on the menus may 
change names and meaning, e.g., Import on the File menu can become ‘Import 
Text’, ‘Import Picture’, ‘Import Sound’, or ‘Import Movie’.

DocuView: The stand -alone DocuView (DV) application is a small QuickTime 
movie player especially adapted for viewing QT movies which have oversized 
frames such as occur when you create a movie from a document. The File menu 
permits you to save QT movies as DocuView files that open DV when you 
double-click the document’s icon. QT movies consist of a collection of bit-
mapped, graphic images, and DV provides a limited print capability for these 
images. A non-functional Edit menu occurs in its standard location. The Movie 
menu provides controls for viewing the frames—stepping forward or backward, 
playing, or stopping or rewinding the movie. Use the ‘Play Every Frame’ 
command to over-ride the sound synchronization algorithm when ‘playing’ a 
large document for hands-off scanning. Controls for repetitive playback and 
choice of screen are included. The Size menu controls the size of the frame 
display. ‘Fit Screen’ and ‘Fit In Window’ do not preserve the width to height ratio 
of the frame. You can click in the frame scroll bar or drag the button to move 
quickly and to locate approximately a particular frame. Create and use 
‘Bookmarks’ as you use a book’s table of contents to move immediately to 
specific frames of particular interest. Use the Windows menu to select among the 
open document windows or to access the Shortcuts help window. This window 
lists the keyboard commands for viewing the frames.
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Chapter 2

Basic Tasks

 

This chapter provides a step-by-step guide for the basic tasks performed by DP. For the eager, 
this shoul d serve as  a jump-start. Here, you will learn to use an existing database. The more 
advanced tasks, such as creating a new database, are described in Chapter 3 without repeating 
the contents of Chapter 2. In contrast, Chapter 4 is command centered, rather than task 
centered, and systematically describes all commands in detail.

In this documentation we assume you already know the basics of the Macintosh interface. If 
not, pause to review the guided tour shipped with your computer. 

In this introduction you learn how to

install and start DP
look at records
modify records
add records
search for information
print information

To use DP effectively, you must understand how it organizes information. Records are the basic 
organizational structure for handling related data. DP creates, modifies, stores, retrieves, and 
organizes (searches and sorts) records and generates reports from records to send to the screen, 
printer, or a file. 

The individually addressable components of a record are called fields. For example, a 
bibliographic citation can be stored as a record, and its constituent components, e.g., author, 
date, title, etc. are the fields. In a name and address directory, a person’s name, street address, 
etc. are the fields. Each field can store either text, picture, sound, a QuickTime™ movie, or a 
pointer to a file.

Before you begin
• Complete and return the product registration card.

• Copy the files on the distribution disk onto a hard disk or a floppy and place the original in a 
safe place.

The original diskette might be needed later to restore the working copy if it becomes damaged.
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DP should be used with a hard disk because of the larger capacity and faster access, although 
smaller databases can be handled using two floppy drives. To utilize the QuickTime movie 
feature, you should have a 68020 (or higher) CPU and color monitor.  DP can be used with the 
68000 CPU, but the QuickTime extension will not be operational. 

There are three principal types of DP files (Figure 1) on the distribution disk (the application, 
database, and tag files). The database file can be located anywhere and stores the information 
DP manages for you. The tag file stores the names of the fields used in the database file as well 
as various formatting and other information related to the database file. Ordinarily you will 
place all your tag files in a Tags folder because that’s where DP first looks for them. Actually 
you can place tag files anywhere on the hard disk but placing them in a common folder is best. 
If DP is unable to locate the tag file associated with a particular database file when you open the 
database the first time, you may be asked to locate it. 

Fig.  1 Primary DiscoverPro Files

DP will open a database file even if the tag file that defines the file structure is not available, but 
you will be unable to edit the database file. A single tag file can be associated with and define 
the structure of multiple database files.

• Optional: If you are using System 7, use the Make Alias command and transfer the alias 
(Figure 2) into the Apple Menu folder within the System folder. 

This makes DP accessible from the Apple menu, regardless of its actual location.

Fig.  2  The DP alias icon

The suggested memory allocation for DP is 1,000K. Depending upon your hardware configura-
tion you may adjust this using the Get Info command on the Finder’s File menu. If you work 
only with small databases or only browse or make simple searches, this should be adequate. If 
you work with large databases, you should use the Index command to create indices, i.e., key-
words for locating records without reading every record during a search.  If you edit, sort, in-
dex, import, or search for duplicates, the more memory you allocate, the better. 

As a rule of thumb, allocate memory to DP comparable to the size of the database file for best 
performance. (To adjust the memory allocation, use Get Info on the Finder menu before 
launching DP.)
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Starting Up

• Activate DP by double-clicking the DP icon, by selecting DP from the Apple menu using its 
alias, or by double-clicking on a database file icon. 

Once DP is operational, open an existing database, as discussed in the next section. In Chapter 3 
we discuss the steps for creating a new database. 

Opening a database file

To open a database file:

• Select the Open command on the File menu (unless you have already done this by double-
clicking a database file icon in the previous step) and select a file, e.g., ‘Demo’.

Note: Supplemental comments, shown indented, can be skipped during your first reading.

The number of files DP can open simultaneously is limited only by the available 
memory. If DP is unable to locate the tag file associated with the database, you 
must do this manually using a standard file dialog. If necessary, you can 
subsequently use the ‘Assign Database Type’ command on the File menu to make 
this assignment. If the tag file is unavailable to DP, you can open and read, but not 
edit, the database.

To close a database at any time, use the Close command on the File menu or click the close box 
at the top-left corner of the window. Alternatively, select Quit from the File menu to close all DP 
windows and terminate the session. 

There is no Save command on the File menu because that task is performed 
automatically by DP—either when you leave a modified record or when you end 
the editing session (as specified in the Preferences command).

DP is organized into ‘records’ and ‘fields’. If you want to store a list of the names, addresses, 
and phone numbers of a group of people, a ‘field’ would consist of a name, a street address, a 
city, a state, or a phone number. A ‘record’ would consist of all five of these items collectively 
for one individual. In other words, a record is made up of a group of related fields. To work 
with the records and fields, DP gives you three main windows.

Three Main Views: Database, Browse, and Data Entry
When you open a database file, one of three views appears: the Database, Browse or Data Entry 
(as specified using the Preferences command on the File menu). In the Database view an icon 
represents all records and eight folders that you can use to group records.  

In the Browse view, a scrollable, read-only list of records is displayed. Multiple records are 
displayed simultaneously in a list format for easy visual comparison. You select a subset of all 
fields and their sequence for display.  The set of records displayed is either the ‘All Records’ 
icon or one of the eight Finder-like folders.
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In the Data Entry view only one record at a time is displayed, the individual fields are labeled, 
and the contents of fields modified.

The Database window 

The Database view (Figure 3) is the organizing window of DP. It gives you access to any record 
in the database. It contains an icon for ‘All Records’ of the database and eight folders into which 
you group and store subsets of the database records. Double-click on ‘All Records’ or a folder in 
the Database window to open a Browse view (Figure 4) listing of all of the records stored in that 
particular folder. Then double-click on a particular record in the Browse view to examine that 
particular record in the Data Entry view (Figure 5)— the most detailed view of a record and the 
environment where you can modify the record. 

Fig.  3  Database view

To retrace this process, click ‘End Editing’ in the upper right corner of the Data Entry view 
(Figure 5) to return to the Browse view. The Browse view enables you to scan and visually to 
compare many records quickly. The Browse view simultaneously displays user-selected fields 
of several records  in a view-only  manner. You can define any number of browse formats (choice of 
fields, sequencing of those fields, and text formatting) and quickly switch among them. Within a 
particular ‘Browse Format’, all records have a common height. All searching and sorting of 
records, checking for duplicates, and creating output files is handled from this view.
In contrast, the Data Entry view (Figure 5) displays user-selected fields of an individual record 
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and is where you edit  (create and modify) a record. You can define any number of data entry 
views (choice of fields, sequencing, and formatting) and quickly switch among them. In all Data 
Entry views the field names (and optionally the associated tag numbers) identify the fields. Text 
fields expand as necessary and support word wrap and text style attributes. Alternatively, a 
field can store (or point to) a picture, sound, movie, or a file.

• To switch from Browse to the Data Entry view, double-click a record.
• To switch from Data Entry to the Browse view click on ‘End Editing’. 

Fig.  4  Browse view

The effective utilization of the information in a database depends upon the ease and speed with 
which you can locate, examine and extract records relevant to your interest. Both the Browse 
and Data Entry views provide rapid scrolling among records. Whether you locate records of 
interest by scrolling or by search techniques described later, grouping them for further study or 
report generation becomes important. DP provides an innovative approach to this task.
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Fig.  5  Data Entry view

The particular Browse and Data Entry views shown above display ‘All Records’ of the database. 
However, DP provides eight folders (or Sets) for storing subsets of records (Figure 3). You access 
these folders from the Browse view—either close the mini views (such as ‘All records in Figure 4) 
by clicking in its close box (NOT the close box for the database located just above it) or by 
dragging the mini views by their title bars to uncover these set folders. 

We return later to a discussion of these sets. At present you need to know only that from this 
view you can double-click on a folder or on ‘All Records’ to view that set of records in Browse 
view, and by double-clicking on a record in Browse view you can view that set of records in 
Data Entry view. 

Data Entry View:

Let’s continue our discussion with a more detailed Data Entry view. If you are not already in a 
Data Entry view, go to one now.

• If the tag numbers (Figure 5) are not visible along the left border of the computer screen, select 
‘Show Tags’ on the Edit menu. 

• If the Field Description (Figure 5) and the name of the tag file are not visible along the bottom 
border of the Data Entry/Edit view, select ‘Show Field Description’ on the Edit menu. The 
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Field Description in Figure 4 is ‘[Main entry-personal name] Personal Name - Main Author. 
The tag file name in this example is Bibliographic Database.

DP can store either text, a picture, a sound recording, a movie, or a pointer to a file in any field, 
hence the subtitle of DP—a multimedia database. To assign a field type, first click to select the 
field and then choose the field type from the pop-up menu labeled as ‘Field Type’. When you 
paste into the field, DP automatically assigns the field type to match the contents.

Each field appears in the Data Entry view as a rectangular region next to its field name. The 
currently selected field is enclosed by a dotted rectangle (e.g., Main Author in Figure 5). Due to 
screen size or to the number of fields associated with the current record, you may not be able to 
see all fields simultaneously. 

• To display all (and only) the non-empty fields in the current record, choose Tagged Format on 
the Formats menu .

• If necessary, use the grow box, zoom box, and vertical scroll bar to reveal the contents of this 
record.

• Choose Demo Data Entry Format from the Formats menu to select a particular subset of fields 
and a particular display sequence from among previously user-defined formats.

This level of user control allows you to adapt the data entry template to match the order of 
input data and to hide irrelevant fields, protecting them against accidental modification and 
avoiding unnecessary tabbing.

• Click to select any field and observe that a dotted selection frame surrounds the field.

• Examine the Field Type pop-up menu above the fields and successively select each field type. 

The current contents in the field, if any, will be lost when you change the field type. To restore 
the original content of the record after making changes, click the ‘Revert Record’ button.

Click the pencil icon  to the left of the tag icon at the base of the data entry view to toggle 
between write protect and write enable status for the open database file. When the database file 
is write protected, the record contents cannot be altered, although you can perform non-
destructive tasks such as sorts and searches.

• Examine the Record Type pop-up menu for the choices currently defined for this tag file.

Note: One way to identify a specific record for subsequent action when you are using the Data 
Entry view is to check its ‘Selected’ box or use  M to ‘mark the record’ by keyboard.

You edit text fields just as you do in a word processor. DP provides word-wrap and even 
adjusts the word-wrap when you change the view width. 

DP saves edited records to disk automatically when you finish an editing session or after you 
edit each record, depending upon which option you choose using the Preferences command on 
the File menu. Immediate saves provide additional data loss protection, but delayed saves 
provide greater responsiveness. Because record saving is automatic, the File menu does not 
contain a Save command.
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Moving to Other Records

To view another record (in the Data Entry view):

• Click on the arrow icons  at the top-right corner of the Data 
Entry view to go to the first record (or type  1 or select First from the Records menu), or the 
previous record (  2 or select Previous command), or the next record (  3 or Next command), 
or the last record (  4 or Last command), or 

• Drag the small horizontal scroll bar , or

• Double-click on the record number above the scroll bar (  G or choose Go To Records on the 
Records menu) to go to a specific record.

The displayed record number is a relative record number, i.e., not absolute, 
because deletion of a record changes the record number of all higher numbered 
records. In the next chapter you will learn how to locate records using a unique 
record number (based upon the time the record was created).

This completes our review of the Data Entry view.

• Click the ‘End Editing’ button or press the ‘enter’ key to return to the Browse view. The 
current Data Entry record will be displayed within the visible portion of the Browse view. 

Browse View: 

A Browse view (Figure 4) is associated with each of the set folders and with All Records of the 
Database view. The browse view displays multiple records simultaneously in a list 
arrangement. Individual fields may occupy more than one line, but all records have a common 
height within each Browse format. This view allows you to compare records and to rearrange 
the display order by the sort command and by manually dragging the records in this view.

The Browse view has close, zoom, and resize boxes as well as horizontal and vertical scroll bars. 
Its title bar is black to distinguish this mini view from the traditional views used for the database 
file; you can reposition the Browse view by dragging its title bar. The Browse view does not 
extend beyond the bounds of its host Database view.
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Fig.  6  Database and Mini windows Controls

WARNING: Don’t confuse the close box of the Browse and Database views or you 
may unexpectedly close the database file.

Each record occupies one or more lines in the Browse view. All records have a 
common, but user-definable height. If the height of a line containing a picture or 
movie field is less than 32 pixels, DP replaces that field with a message, e.g., 
<picture>. When you format a text field  for a fixed length, DP truncates a 
multiple line text field,, and you can replace the missing text with an ellipsis. A 
text field ordinarily occupies a single line in Browse view unless you assign fixed 
field lengths and  a fixed line height in the Browse format view.

As discussed in detail in Chapter 3, you select the fields displayed in the Browse 
view as well as their order Furthermore, you can assign text attributes (font, size, 
and style) to the text fields. Various other display attributes are under user 
control. You can switch quickly and easily among the user-defined formats. 

• Successively choose each of the Browse formats listed at the bottom of the Formats menu to 
observe the effect. 

Because you are currently in the Browse view, the Browse command in the Formats menu is 
underlined, the names of the currently defined Browse formats appear at the bottom of the 
Formats menu, and the ‘Edit...’ command in the middle section of the menu provides access to 
the current Browse format name (checked) at the bottom of the list for editing.

The four types of DP formats are listed at the top of the Formats menu (Browse, Data Entry, 
Import, and Export). As we discussed in Chapter 3, you choose these commands to create or to 
modify that format type.

NOTE: To use (rather than to modify) a format for the current Browse or Data Entry 
view, choose the name of an existing format from the lower portion of the Formats 
menu.  Selecting the format type at the top of the Formats menu opens the format 
editing window for that format.
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To examine, a Browse format:

• Choose Browse... on the Formats menu.

You cannot modify the italicized format listed here. It is the default applicable to all records; it 
displays attributes common to all records—the record type and record size.

• Double-click one of the other formats in the Browse Formats dialog.

The word processor-style view allows you to specify the fields included in the Browse view as 
well as their order. To add a field token at the position of the insertion point, simply drag the 
field name from the Fields view into the format view. If the floating Fields window is not 
visible, use the Windows menu to display it. You can add supplementary text between the field 
tokens and assign text attributes (font, size, and style) to that text and to the field token (and 
therefore, to the text it represents) as if this were a normal word processor view. We return to 
this in Chapter 3. 

• Click the close box to return to the Browse view.

Now let’s consider the useful relationship between the Browse views and the host Database 
view. First, consider a way manually to  rearrange records within the Browse view (and within 
the Database view).

Manually Rearranging Records

To manually rearrange records:

• Drag a record vertically from one position in the list to a different position within the list.

The message ‘Rearrange Record Order’ appears at the base of the Browse view. This ‘drag and 
drop’ technique applies to the manual grouping of records into the set folders and to most other 
tasks in DP.

• Position the Browse view such that the set folders of the Database view are visible.

• Drag a record from the Browse view into one of the folders in the Database view (not onto the 
All Records icon).

The ‘drag and drop’ process is equivalent to a cut and paste command. Use  click to select 
multiple, noncontiguous records or shift-click to select a contiguous range of records in the 
Browse view. You can drag multiple records simultaneously into a set folder. DP will not 
duplicate in that folder any record already in the set will not be duplicated in that folder.

• To remove a record or selection of records from a set folder, just drag the selection outside the 
borders of the host Database view.

The cursor changes to a trash can, and an outline of the records follows the cursor. If the 
Database view border is too close to the edge of the screen, drag the cursor into the view title 
bar. To remove a selection, both the trash can icon and the outline of the selection must  be 
visible when you release the mouse button.
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Removing a record from a set folder does NOT remove the record from the database—only 
from the set folder—unless you option-drag the record(s), i.e., press and hold the option key 
while dragging the record past the borders of the Database view. 

Whenever the permanent loss of a record is impending, DP issues a warning  to allow you to 
abort the process, if necessary.

These set folders contain only pointers to the actual records in the All Records set. 
The record contents are not needlessly duplicated. When you rearrange the 
records in the subsets,, you also rearrange their order in All Records’ and in any 
other set folder that includes these records and vice versa. These folders provide 
the equivalent of eight sets of marked records.

In Chapter 3 you will learn how to copy records from one database to another by dragging the 
records from one open database view and dropping them into another

New Records:

To create a new record:

You can initiate the creation of a new record from either the Browse view or from the Data 
Entry view.

• Choose New Record from the Records menu.

• If necessary, select the desired Data Entry format from the bottom third of the Formats menu.

Each field can contain one of five field types–text, picture, sound, movie, or pointer to a file.

To assign a field type:

• Select a field by clicking its field name or by clicking within the space adjacent to the field 
name that holds the contents of that field.

• Choose a field type from the pop-up menu at the top of the Data Entry view of the record.

To supply field contents:

You can 

• Type in text fields.

• Paste data into the field. When you paste, the field type adjusts to the clipboard contents.

• Import directly from a file. The Import command on the File menu adjusts to the field type of 
the field where the insertion point is currently located.

• Press Tab to move the insertion point to the next field or shift-tab to move to the previous 
field. Alternatively, use the mouse to move through the fields in an arbitrary order.
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DP saves new and modified records automatically when you end an editing session, i.e., leave 
the Data Entry view or when you move to another record. DP has no Save command. 

Delete Records:

You can use the Delete record command to delete one or more selected records in the Browse 
view or to delete the current record from the Data Entry view if you have selected All Records. 
In Browse view, if you drag a selection of one or more records from lAll REcords to a place 
outside the Database view or a place in the title bar or if you option-drag a selection from a set 
folder, DP permanently removes the selection from the database.

To permanently remove records while in Browse view:

• Select the record(s)

— To select a single record, click on it.

— To select a contiguous block of records, click a record at one end of the range and press shift 
while you click on the record at the other end of the range.

— To select several records not in a contiguous block, press the command ( ) key while you 
select by clicking on the records.

To remove a selection (such as just established):

— Select Delete Record from the Records menu and

— Drag the selection from the All Records set into the title bar of the database or anywhere 
outside the Database view, but not within four pixels of the edge of the screen.

— Or press and hold the option key and drag the selected records from a Set folder into the title 
bar of the database or anywhere outside the Database view not within four pixels of the edge of 
the screen.

When you drag a selection, the outline of the selection moves with the cursor; and the cursor, 
when moved outside the view (but not within four pixels of the screen border), changes to a 
trash can. When both of these conditions pertain, if you then release the mouse button, DP 
remove the selection. This innovation minimizes the mouse movements required for 
housekeeping.

• Approve the permanent removal when a warning dialog appears.

Deletion of a record from a set folder does not remove it from the database UNLESS you 
simultaneously press the option key and drag the record off the Database view. The Records 
menu command, Remove Record From Set, does not remove the selected record from the entire 
database even if the option key is pressed.
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To permanently remove a record from the database while in Data Entry view:

• Scroll to the record you want to delete, using the small horizontal bar at the upper right of the 
viewso it becomes the current record.

• Select Delete Record from the Records menu.

• Approve the permanent removal when a warning dialog appears.

Locate Records:
One of the primary tasks for a database program is the efficient location of records of interest. 
You have already learned to scroll manually through the records in both Browse and Data Entry 
views. For a large database containing hundreds or thousands of records, a more powerful 
method for locating records is necessary. A powerful, yet simple, search command is discussed 
in this chapter, but a far more powerful and flexible search command is presented in Chapter 3.

A Simple Text Search:

Record searching, both simple and complex, is always performed from the Browse view. A 
simple search consists of examining the entire text of every record in the database for a match 
with one, two, or three supplied text fragments. The match of the text fragment is unaffected by 
case—any combination of upper and lowercase text is equivalent. The text fragments can be 
whole words or embedded within the text of a field; wild card characters are supplied 
implicitly. DP finds any record that contains either one, two, or all three of the search fragments 
anywhere within a record. The Browse view opens with all the records matching these simple 
search conditions highlighted. 

To perform a simple text search:

• Select Simple Search from the Records menu.

• Supply one, two, or three text string fragments embedded in any field (Figure 7).
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Fig.  7  Simple Search Dialog Box
• Click the Search button.

The Browse view opens, if not already open, and the records matching the search condition(s)  
highlighted. DP automatically scrolls the list to the first ‘hit’. 

To examine the selected records:

• Review the selected records in the Browse view.

• Drag them into a set folder, as discussed above, to save the set. 

Remember, double-click on a record in Browse view to open the Data Entry view. If you click 
anywhere except on a selected record in the Browse view, the search results will be 
lost;therefore, drag the ‘hits’ into a folder if you wish to preserve them for further examination.

Group Records:
Grouping records into set folders facilitates the examination of records of interest. Sorting is 
another way to organize records into useful patterns for study. DP maintains only one sort order 
at a time, and it applies to all records in the database—to All Records as well as to the records in 
each of the Set folders. The sorts are performed only on text fields. In addition, DP treats all 
characters in text fields as text, even if that text happens to represent dates or numbers. There-
fore, unless you pad numerical fields on the left to preserve a common field length, DP does not 
give you the normally expected sort order. For example, an ascending sort of the number 10 will 
precede the number 9, unless you pad the ‘9’ on the left with a ‘0’, i.e., an ascending sort places 
09 before 10, but ‘9’ follows ‘10’ otherwise. DP sorts, in chronological order, dates entered in 
yymmdd format (i.e., two digits for year, two for month, and two for the day). For example use 
‘920924’ for September 24, 1992.
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• If necessary, switch to the Browse view.

• Choose the Sort command from the Records menu to open the Sort dialog (Figure 8).

Fig.  8 The Sort window

• If necessary, open the Fields window by selecting Fields from the Windows menu.

• Drag the name of each field you want included in the sort from the Fields window and drop 
them into the scrollable sort list.

Fig.  9  Fields Window (Name and Tag Number Orders)
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You can select any number of fields. The topmost field is the primary sort key. Records having 
that field in common are further sorted according to the second field, and, likewise, for 
successive sort fields. To rearrange the order of the sort fields simply drag and drop them into 
place. To remove a field from the sort list, just drag the name beyond the border of the sort 
window or into the title bar and drop it.

• To select ascending or descending for each field, click on the arrow opposite each field name.

If you expect to use a particular sort combination frequently, you can name the combinations 
within the sort dialog and quickly recall the combination by name when needed.

Extract Information:
Of course, you can read from the database records. So far we have concentrated on text 
handling, but you can also view pictures, listen to sounds, and view (and listen to) movies. Let’s 
examine these techniques now.

Picture:

Pictures can be viewed in both the Browse and Data Entry views.

To view a picture in the Browse view:

• Choose a Browse Format (from the bottom of the Formats menu) that includes the picture 
field of interest.

• Locate a record (Figure 10) by scrolling or by searching on an associated keyword text field as 
described above.

The size of the picture field depends upon the line height established in the picture 
format you chose. This is expressed in pixels and can range between 32 and 500. 
This value determines the number of lines of text displayed for fixed length, text 
fields, but for a picture field this value determines the scaling applied to the 
picture. If tyour format choice for line height was ‘Automatic’, DP replaces each 
picture with the word ‘<picture>’. Otherwise, the scaled image has the height you 
assigned in the Browse format. 
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Fig.  10 Pictures in the Browse view

To view a picture in the Data Entry view:

• Locate a record by scrolling in the Data Entry view. 

Alternatively, locate the record in the Browse view, e.g., the diskette, and then double-click the 
record to view that record in the Data Entry view (Figure 11).

Fig.  11 Data Entry view Showing a Picture
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• Click on the picture to select that field.

A dotted rectangle identifies the selected field and a zoom icon  appears at the top right 
corner of the picture field. The Picture menu (Figure 12) also appears on the menu bar.

Fig.  12 The Picture Menu

• Toggle the size of the selected picture field (Figure 13) between Thumbnail and Full Size by 
clicking the zoom icon in the field or by choosing a menu command by mouse or keyboard.

Fig.  13  Full Size Picture

• Use Command-Y or the menu to display a picture in its own floating window (Figure 14).

The Picture Window has close, zoom, and resize controls in the customary 
positions, and you can drag the window by its title bar to another location on this 
or another monitor connected to your Macintosh. In addition, you can choose from 
six standard size options: scale to completely fill the screen using different scalings 
for the width and height; scale to fill the screen, but use the same scaling for the 
width and height; and scale both the width and height to 200, 100, 75, and 50 per 
cent of original picture size.
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Fig.  14 Floating Picture Window

Scale to fill the screen
Scale to fill the screen while
   preserving the width-to-height ratio

Frequently used scalings

Fig.  15 Size Submenu
If the image in Figure 14 is larger than the picture window, or conversely, if the window has 
been sized smaller than the image, DP enables scroll bars  on the Picture window (but not on 
the Data Entry view and not on the field, even when you select them). The usual mouse controls 
for horizontal and vertical scrolling are enabled (clicking and pressing the arrows, clicking on 
the gray scroll bars, or dragging the scroll button). In addition, simultaneously pressing the 
command key and an arrow key is equivalent to use of a scroll bar arrow.
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Sound:

To play a sound recording:

• Locate a non-empty sound field in the Data Entry view (Figure 16) and click to select it.

Fig.  16 A Sound Field
• To control the playback :

— Click the play (on the right) and stop buttons (Figure 16). 

— Use the play and stop commands on the Sound menu that appeared on the right end of the 
menu bar when you selected the sound field (Figure 17).

— Use the keyboard command equivalents (command <space> and command <period>.

Fig.  17  Sound Menu
Movie:

You can view a movie field in both the Browse and Data Entry views. Only a user-selected 
frame of the movie, the ‘Poster Frame’, can be viewed from the Browse view.

To view the Poster Frame of a movie in the Browse view:

• Choose a Browse Format (from the bottom of the Formats menu) that includes the movie field 
of interest.

• Locate a record (Figure 18) by scrolling or by searching using an associated keyword text field 
(as described above).
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Fig.  18 Poster Frames in The Browse view

To view a movie in the Data Entry view:

• Locate a record by scrolling in the Data Entry view. 

Alternatively, locate the record in the Browse view, and then double-click the record to view 
that record in the Data Entry view (Figure 19).

• Click on the miniature image representing the movie, i.e., the Poster Frame of the Movie, to 
select that field.

A dotted rectangle identifies the selected field (Figure 20). The Movie menu (Figure 21) also 
appears on the menu bar.

• Use Command-Y or the menu to display the poster frame in its own floating view (Figure 22).

The Movie Window has close, zoom, and resize controls in the customary 
positions, and you can drag the window by its title bar to another location on this 
or another monitor connected to your Macintosh. In addition, you can choose from 
six standard size options: scale to completely fill the screen using different scalings 
for the width and height; scale to fill the screen, but use the same scaling for the 
width and height; and scale both the width and height to 200, 100, 75, and 50 per 
cent of original picture size.
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Fig.  19 Record With a Movie Field
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Fig.  20 Movie Field Selected
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Fig.  21 Movie menu
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Fig.  22 Movie Window
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To adjust movie volume:

• Press on the speaker icon and drag the volume control.

Fig.  23  Speaker volume pop-up

To view an electronic document:

DP can display and print a document or manuscript stored as a movie. This capability allows 
you to store documents more compactly than you can in a word processor file and to display 
documents with greater speed than you can with a word processor. You can freely use text, 
mathematics, graphics, sound, and color and, of course, include movies Movies can contain 
color, still images, and converted VCR movies with synchronized sound. See the Appendix for 
a discussion of the process of converting word processor files into a movie. 

DP provides the search, sort and manual grouping support. The search and sort operations are 
based upon text fields associated with the record, rather than upon pattern matching of the 
movie image (a graphic). After locating and reviewing a document, you can also produce a 
printed copy of the document.

Use of the QuickTime environment has many benefits—including the data compression and use 
of an established standard file format. However, to do this we had to overcome two obstacles 
had First, single-step viewing of frames becomes more important and, second, document size 
often exceeds the normal size of a movie image. DP provides controls to address these needs.

To single-step through the frames in a movie window: 

• Open a floating movie window and use the frame change and scrolling keys.

When a movie window is open, three sets of movie controls become available. Two have been 
discussed already (Figure 21 and Figure 22). The additional keyboard controls (Figure 24) use 
single arrow keys to replace the most frequently used commands that, otherwise, would require 
two keystrokes or a mouse command. If the frame height exceeds the size of the movie window, 
you combine a frame change and a scroll to the top or bottom of the new frame: Option ← and 
option → display the bottom of the previous frame or the top of the next frame.
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Key  Frame Change Equivalents

← Step backward  -         

→ Step forward  =         

↑ Rewind   0             

↓
Play

Stop

 <space>

 .              

opt ← Bottom previous
opt → Top next

Fig.  24 Frame Change Commands

Key Scroll Witnin Frame Equivalent 

 ← Scroll left 

 → Scroll right 

 ↑ Scroll up

 ↓ Scroll down

 opt ← Scroll left one window width

 opt → Scroll right one window width

 opt ↑
Scroll up one window height

(& go to bottom of previous page,
if already at top of page.)

page up

 opt ↓
Scroll down one window height 

(& go to top of next page,
if already at bottom of page.)

page down

home Top of page

end Bottom of page

Fig.  25 Movie window scroll commands

If the height of the document (movie) image exceeds the height of the Movie window, you must 
be able to scroll to read the entire image. In addition to the movie window scroll bars, DP 
provides convenient keyboard equivalents (Figure 25). 

Use the Command key ( )  modifier to change the frame-change arrows for scrolling within a 
frame. Use the command and option keys simultaneously as modifiers to scroll in larger 
increments, i.e., window width or height. Use Command-option-down/up arrow (or ‘page 
down’ and ‘page up’ on extended keyboards) to snake through a document in newspaper style 
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if the page size exceeds the height of the window. The extended keyboard provides single key 
control for scrolling immediately to the top or bottom of the manuscript page.

All output techniques in DP are referred to as Exporting—whether the records, or parts of 
records, are sent to the screen, the printer, or to a disk file. Printed versions of the Browse and 
Data Entry displays are the simplest to produce, as follows.

Printing:

To print the screen displays:

• Select a printer using the Chooser command on the Apple menu.

• Use the Page Setup command from DP’s File menu to check the various paper and printer 
options.

Fig.  26  LaserWriter Page Setup Dialog

• Select the records you wish to print.

When in the Browse view, use the standard mouse selection techniques of clicking, shift-
clicking, command-clicking. Use Unselect All Records on the File menu before making 
selections to assure that no extraneous files are included. Numerous formatting options for the 
Browse view are discussed in Chapter 3.

When in Data Entry view, click the ‘Selected’ checkbox to mark specific records for printing. If 
you prefer, you can return to the Browse view to select records and then return to the Data 
Entry view by clicking on one of the selected records. If you select only one record, you can also 
use ‘Edit Record’ on the Records menu. Only limited formatting is available in the Data Entry 
view. You can use the Preferences on the File menu to assign a default font and font size for all 
records viewed in Data Entry view.
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If you intend to print all the records in the window currently selected, you can specify ‘All’ on 
the print dialog. If you wish to print only the current record in the Data Entry view, make that 
choice in the print dialog too. If you opened the Data Entry or Browse view using ‘All Records’, 
then all the records in the database will be printed. If you opened either view from one of the set 
folders, as noted at the top of the view, only the records from that set will be printed.

• Select the desired view.

The view displayed is the view printed.

• Choose the Print command on the File menu to select the printing options (Figure 27) and to 
initiate the printing operation.

Fig.  27  LaserWriter Print Dialog

The print dialog differs slightly among the various printer devices. You can elect to include a 
header; and if you wish, a header can appear on all pages or just on the first. Page numbering 
can be placed at the bottom of the pages starting with a user-supplied initial value. All records 
in the database or all the records in the current set folder can be selected, depending upon the 
source of the records.

The primary channel for extracting information from a DP file is the export window. The first 
step consists of defining a format using the Export command on the Formats menu. A detailed 
discussion of that process appears in the next chapter so only a cursory discussion is presented 
here. Here we simply choose an existing format and review it.

• Choose Export from the Formats menu.

An export formats dialog appears.
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• Double-click on the ‘Demo Export Format’.

A format-by-example window appears (Figure 28). Each field to be included in the output is 
represented by a token that contains the tag number and informal name for the field. Additional 
text can precede or follow each token, and you can assign text attributes to the text and to the 
tokens using the Font, Size, and Style menus. A pop-up menu provides access to field length 
and other options. You drag field names from the Fields window (opened from the Windows 
menu) into this window. The usual cut, copy, and paste operations apply to the text and to the 
tokens.

Fig.  28 Format-by-Example Window

• Click the close box after examining, but not altering, the contents of this window. If you do 
modify the format, choose ‘Don’t Save’ when asked.

• Select the records you want to export.

The selection process is the same as described above—select individual records or place the 
records of interest in one of the set folders.

• Choose Export from the File menu.

The Export dialog (Figure 29) allows you to select ‘Selected Records’, ‘All Records’, or any set 
folder. Let’s choose the simplest.

• Select ‘New Window’ from the ‘Send Records To:’ pop-up menu.

Note: To send the output to a new file you must name the file, specify a 
destination, and choose between plain text (ASCII) or styled text (to preserve text 
style attributes). The plain text file can be read by any word processor; but the 
styled text can be used only by DP.

• Select ‘Demo Export Format’ from the ‘Export Format’ pop-up menu.

• Click the ‘Export’ button to initiate the export process.
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Fig.  29 Export Dialog

Upon completion of the export to an export window, examine the results. If 
necessary, modify the format, and again use the Export command. You can edit 
the text in the export window, save it as a file, and print it, if you wish. As 
described in Chapter 3, you can use the Publish and Subscribe feature supported 
by System 7 to publish (create) an ‘edition’ file for text. Other applications which 
are compatible with System 7can subscribe (link and read) the ‘published’ 
intermediate file. 

Quit DP

To quit DP:

•Optionally choose Compact Database from the file menu if you have deleted any records and 
wish to reclaim that disk space.

• Choose Quit from the File menu.

DP automatically closes all windows at shutdown so you don’t have to worry about losing data. 
This completes the brief introduction to the basic skills. You have learned to:

Open and close DP
Open and close database files
Browse records
Edit records
Search for records
Group records into sets
Sort records
Send records and parts of records to the screen, printer, and files

In the next chapter we discuss the more advanced tasks DP can handle.

DiscoverPro  2.30



Chapter 3

Advanced Tasks

In Chapter 2 we examined the techniques for managing records in an existing database—
viewing, modifying, adding, locating, grouping and sorting records, and printing simple 
reports. In this chapter we present step-by-step instructions for handling some of these tasks 
in more sophisticated ways and for handling other more advanced tasks which fall into 
some of the following catagories. 

Input: enter data rapidly and consistently, store and display text, pictures, 
sounds, and movies, import data files generated by other software 

Locate: perform complex searches

Output: export records and reports to other applications 

Interact: interact with other software 

Maintain: maintain databases, structure your own databases.

Input
Let’s consider three different types of data input supported by DP—manual, individual 
fields, and records. Consider manual entry first.

Manual Data Entry

Go to the Data Entry view (Figure 1) for manual data entry. Each record can have an 
arbitrary number of fields and any combination of the five types of fields—text, pictures, 
sound, movies, and pointers. You can import data from a file and from the clipboard into a 
specific field . In addition, you can create text and sound fields within DP.   You create file 
pointers manually using the usual file opening dialogs; an automated process is described in 
the appendix.  Consider each type of field separately. 
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Fig. 1 Data Entry view

Text Fields 

To enter text in an existing record:

• Select a record.

To select an existing record scroll (in either the Browse or the Edit view) as discussed in 
Chapter 2. If scrolling in Browse view, double-click on a record to open the data entry view. 

• Select a Record Type from the ‘Record Type:’ pop-up menu in the upper left of the 
window. Check to be sure the type you want is displayed. 

Note:  Refer to the discussion of Tags if you wish to create new field names or to assign a 
Record Type to a particular combination of fields.

• Select the desired field such as ‘Au:’ for author or ‘Ti:’ for titles by clicking in that field 
(adjacent to the field name).

A dotted rectangle bounds the selected field.
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If the desired field is not visible on the screen, scroll within the record until the field comes 
into view. If the field still does not come into view, pull down the Formats menu to verify 
that you have chosen the intended format. All current data entry formats for this tag file are 
listed in the lower portion of the Formats menu; the current format choice is checked. If you 
wish, select another format from the menu; and the screen reformats immediately. If the 
desired field is not present in any of the formats, you can add it, as described later in this 
chapter. The Tagged Format default is always present and displays all the non-empty fields. 
A new or completely empty record lists no fields if you use the tagged format. All other 
formats list the designated fields, even if empty.

• If necessary, set the field type by choosing ‘Text’ from the Field Type pop-up menu. If you 
have entered data in a field, a change in field type causes DP to lose any existing data in the 
field.

When you select (or create) a text field, a Text menu appears (Figure 2).

Fig. 2 Text Field Menu
• Type the text.

The rectangular field expands in height as required. Word wrap is supported. All the text 
entered has the default font and size attributes prescribed by the Preferences command in 
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the File menu. You can, however, supersede this default by selecting text and then selecting 
a size, style and font in word processor fashion from the Text menu. Naturally, this extra, 
character attribute information increases the record size slightly. 

As discussed in the next example, you can repetitively enter text quickly and consistently 
using the support provided by the floating Abbreviations Window.

The Undo, Cut, Copy, Paste Text, Clear, and Select All commands on the Edit menu apply to 
the contents of the field and have the same role that they have within a word processor.

If necessary, you can restore the record to the state it had when you opened it using the 
‘Revert Record’ button near the top of the window; otherwise, when you leave the record, 
DP automatically saves all modifications to the record . If no other changes are required,

• Store the record by clicking ‘End Editing’ to leave the Data Entry view, by choosing Close 
database, or adding or scrolling to a new record while remaining in Data Entry  view. Note: 
Use the Preferences command in the File menu to establish your file saving preferences. 

DP automatically stores records without requiring an explicit command at this time, unless 
you have previously chosen Confirm Changes on the Edit menu; then DP asks you if you 
want to ‘Save this New Record?” If you did not choose Confirm Changes, DP saves the 
changes and moves on to the next record without a reminder.

Abbreviations for Rapid Data Entry: Frequently used text entries, such as the names of 
journals, can be entered quickly and consistently using the Abbreviations feature.

To create Abbreviations Lists:

• Choose Abbreviations Window on the Windows Menu, if necessary, to open the floating 
Abbreviations Window (Figure 3).

 
Fig. 3 Abbreviations Window
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There are two columns— ‘Abbrev.’ and ‘Name’ —separated by a horizontally ‘draggable’ 
divider. Across the top of the window are the words ‘List Entries View’. Each one of these 
words identifies a pull-down menu (Figure 4).

  
Fig. 4 Abbreviations Window Menus

• Press on the word ‘Lists’ to get its pull-down menu.

• Choose New Abbreviations List on the List menu and supply a descriptive name, such as 
Journals, (Figure 5) and click New. The name ‘Journals’ appears at the base of the Window 
and on the View menu.

Fig. 5 New Abbreviations List Dialog

If you wish to add to an existing list of abbreviations, 

• select that abbreviation list name from the lower portion of the View menu (Figure 4) of 
the Abbreviations Window, rather than choosing New Abbreviations List on the 
Abbreviations Window.

• Choose New Entry from the Entries menu of the Abbreviations Window, supply a name, 
and an abbreviation of up to ten characters in the dialog box (Figure 6), and click ‘OK’.
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Fig. 6 Create New Entry

If you wish to modify or remove an abbreviation,

• Open the Abbreviations list using the View menu (Figure 4).

• Highlight the name and choose Edit Entry... or Delete Entry from the Entries menu 
(Figure 4).

If you have previously typed a name in the Data Entry view and wish to avoid retyping it 
add it to the Abbreviations list,

• Highlight the text.

• Choose ‘New Entry from Selection’ in the Entries menu (Figure 4). 

Using the Abbreviation List: When enabled, the abbreviations feature scans the keyboard 
input for matches with the abbreviations in the abbreviation list, regardless of whether the 
Abbreviations window is visible, and substitutes the expanded version ‘on the fly’.

To enable the abbreviations feature, first establish a keyboard command which you want to 
serve as a trigger for a lookup.  The lookup trigger can be any single keystroke, with or 
without any combination of command, shift, or option key(s).

• Pull down the Lists menu to Set Lookup Key from the Lists (Figure 7).
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Fig. 7 Lookup Key Dialog

• Type beside the word ‘Key:’,the name of the key you want to trigger a substitution. One, 
two, or three modifier keys can be specified. For example, if you type  <Spacebar> beside 
the label ‘Key:’ and check  the command box in the Set Lookup Key dialog box,  DP  
searches the Abbreviations list for an abbreviation which matches Command spacebar. If 
DP finds a match, it substitutes in your database the expanded expression for the 
abbreviation.

To activate the lookup feature,

• Select Automatic Lookup on the Lists pull-down menu. 

When activated and you type the abbreviation followed by pressing the spacebar and the 
Command key, DP substitutes the expanded equivalent for the typed abbreviation. In other 
words, the signal for DP to look up an abbreviation in this case is a space character (or any 
other key you designate) and any combination command, shift, or option key you select.

To use the abbreviations list manually,

• Double-click on either the abbreviation or the expanded entry, and DP inserts the 
expanded version  at the insertion point in the current field.

Uses of Abbreviations: You can use this feature to standardize the format of entries such 
as journal names, making them consistent throughout your database. For example, you 
could use ‘usa’ to get a consistent entry of U.S.A, USA, U.S., etc. Note: Use the Index 
command to help locate alternative (or incorrect) spellings.

As a space saving alternative to storing the fully expanded names, you can store 
meaningful, but shorter, mnemonics and use the Lookup Abbreviations options during 
output (i.e., as part of the export format).

Authority List: You can restrict field entries to an ‘authority’ list to assure consistency.  
Misspelled words, for example, can thwart your search efforts.
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To make Abbreviations Lists field specific:

• Click the Abbreviations Window zoom box (in the upper right corner, Figure 3) to access 
the list box.

• Choose a list of names in the Views Window.

• Open the Fields Window, if not already open, and drag and drop field names from the 
Fields window into the ‘Applies To These Fields’ list.

• Repeat these steps for other lists, as needed.

• Click the Zoom box to hide the expanded portion of the Abbreviations window.

Sound Field

If your Macintosh is equipped with a microphone and appropriate software, you can create 
digitized sound recordings within DP. You can store the recording within a database field or 
in a separate file linked to that database field. Many newer Macintoshes are shipped with 
this support as standard equipment.

To record sounds within DP:

• Select the desired record and then select the desired field by clicking it.

A dotted rectangle bounds the selected field.

• If desired, set the field’s type by choosing ‘Sound’ from the Field Type pop-up menu. 

Any existing data in the field that you may have entered will be lost when you change the 
field type.

The Sound menu (Figure 8) appears on the menu bar when you choose ‘Sound’ as the field 
type.

Fig. 8 Sound Field Menu

• Choose a Recording Quality (Good, Better, Best) from the submenu.

• Choose a Record To destination (Database or File).
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If you chose ‘File’, you must supply a file name and destination when you make the 
recording.

• Choose the Record command (Figure 8).

If you chose a file destination above, you must name the file and its destination. Then the 
Record dialog (Figure 9) appears (if your computer is properly equipped for recording).

Fig. 9 The Recording Dialog

• Click the Record icon (shown selected in Figure 9) to start the recording session. Click 
‘Pause’ and ‘Stop’ or their keyboard equivalents as appropriate. The speaker icon indicates 
the signal strength.

• Choose Play to review the recording.

The Undo, Cut, Copy, Paste Text, Clear, and Select All commands on the Edit menu apply to 
the  contents of the field and have the same role that they have within a word processor. 

• Click the Play and Stop buttons in the field or on the Sound menu (or their keyboard 
equivalents) to control playback.

If necessary, you can restore the record to the state it had when you opened it using the 
‘Revert Record’ button. If no other changes are required,
• Store the record by clicking End Editing, Scroll to another record, or Close the database. 

Refer to the Preferences command on the File menu for details.

DP automatically stores records without requiring an explicit command. If you have 
previously clicked Confirm Changes on the Edit menu, DP asks you if you want to “Save 
this New Record?” If you do not enable Confirm Changes, DP saves the changes and moves 
on to the next record without asking.

Unlike text and sound field types, DP does not support the creation of the contents of 
graphics or movies fields. Additional software or hardware is required. 

Pointer Fields (when operating under System 7)

To enter a file (or document) pointer in an existing record:

• Select a record.
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To select an existing record scroll (in either the Browse or the Edit view) as discussed in 
Chapter 2. If scrolling in Browse view, double-click on a record to open the Data Entry view. 
• Select a Record Type from the ‘Record Type:’ pop-up menu in the upper left of the 
window. Check to be sure the type you want is displayed. 

Note: Refer to the discussion of Tags if you wish to create new field names or to assign a 
Record Type to a particular combination of fields.

• Select the desired field by clicking in that field (adjacent to the field name).

A dotted rectangle bounds the selected field.

• If necessary, set the field type by choosing ‘Document’ from the Field Type pop-up menu. If 
you have entered data in a field, a change in field type causes DP to lose any existing data 
in the field. The name of the Import command on the File menu becomes ‘Select 
Document...’ and the message ‘Select a document from the File menu’ appears in that 
field.

• Use the Select Document...’ command to identify the file you want DP to link to the 
pointer field using the usual file opening dialogs.

Fig. 10 Document (File Pointer) Field

If you link to a TeachText file ‘Demo CAB/SP.text’, the field (Figure 10) display includes the 
file’s icon, its name, location, file creator, and file type.

While the Document (pointer) field is selected, an associated menu appears on the menu 
bar (Figure 11).  There are two commands.  Find Document locates and selects the file? 
pointed to by the DP field.  The other, Open Document, not only finds the file pointed to by 
the field, but also launches the  host application (if present) and opens the document.

Fig. 11Document Field Menu

This feature greatly extends the scope of DP, allowing it to be the organizer and launcher of 
files of any type stored external to DP.  In the Appendix we describe an AppleEvents linked 
application (File Finder) that creates a database of records of pointers to any or all of the files 
on your hard disk. A special case of this feature handles QuickTime movie files stored 
external to DP.
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Movie Field

The handling of Movie fields parallels the procedures for Document fields.

• Select a field.

• Choose Movie field type.

The field now displays an identifying movie clip and the File menu now has an Import 
Movie... command.

• Use the customary file location techniques to identify the desired movie file.

While this movie field is selected, a Movie menu appears on the menubar (Figure 12).  The 
commands are described in detail in the Appendix that describes DocuView. The one 
difference is that DP can play the movie in place in the Data Entry window, or you can move 
it  into a separate window, drag it to a second monitor, re-size it, and execute it.

Play movie
Stop movie
Go to previous frame
Go to next frame
Go to first frame

Play repeatedly
Play forward & backward repeatedly

Play asynchronously

Multiple screen 
choices

Fig. 12 Movie Menu

Importing Text, Picture, Sound, and Movie Fields

To import the contents of a field (text, picture, sound, movie):

• Select the desired field by clicking (or by using tab to move forward or shift-tab to move 
backward).

A dotted rectangle bounds the selected field.
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• If necessary, set the field’s type from the Field Type pop-up menu. 

Remember that you must import data that matches the data field into which you are 
importing. Picture data must enter a Picture field. Material you paste from the clipboard 
contains the field type information and the field type adjusts automatically. The Import 
command on the File menu also adjusts to Import Text, Import Picture, Import Sound, or 
Import Movie according to the field type you assign.

• Choose the Import command on the File menu.

A dialog applicable to the specified field type appears. 

— For a text field, the input file must be a plain text file.

— For a picture field, the input file must be of the ‘PICT’ type.

This command can also extract pictures from all resource files, including applications, 
if you choose to list ‘All Resource Files’.

— For a Sound field, the input file can be Macintosh Sound, AIFF, and AIFC types. 

This command can also extract sound resources from all resource files, including 
application files, if you choose to list ‘All Resource Files’.

— For movie fields, the input should be a QuickTime file.

Importing Records

Because of the central importance of importing records (in contrast to the contents of single 
fields as just discussed), we gave some examples in Chapter 2 on basics. We now return to 
that topic for a discussion of DP’s interface for interactively defining a template for import 
records. Refer to Chapter 4 for a discussion of the centrally important Formats menu.

Librarians must work with diverse record types, including very general USMARC records. 
DP imports and exports these very general and complex records more easily than the 
simpler, but less structured, formats; therefore, lets consider that class first.

To import USMARC records:

• Create a database file using the Bibliographic Database Tags distributed with DP.

As we discussed in Chapter 2, you use the New command to select the Bibliographic 
Database tags (from the pop-up menu) and to name the database file. The database window 
opens, indicating that the ‘All Records’ set is empty. The name of the tag file is visible at the 
bottom of the window. You now have a structured environment to receive the records.

Because DP does not check for all possible violations of record structure for proper format, 
we recommend that you always import into a new database to avoid corruption of an 
existing file. As discussed elsewhere, subsequently combining this file with an existing 
one is trivially easy if you use the same tag file.
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• Click the Import command on the File menu.

Use the open file dialog to select the file of USMARC records to be imported, specify 
USMARC in the Format pop-up menu, and select a destination. The destination of the 
imported records can be All Records or set folder; the current number of records is shown 
between brackets on the pop-up menu. Since this is a new database, choose ‘All Records’. 

Given the ease with which you can join database files, i.e., append a copy of one file to an 
existing database, creating a new database reduces the risk of corruption of the existing file or 
unsuccessful import due to a faulty import file. However, if you have an established import 
routine from a standardized source, you might import the records into one of the empty set 
folders. EP add the imported records to ‘All Records  and Places pointers to the record in the 
selected set folder. After reviewing the records in the set folder, you can select and a) remove 
records from the set ONLY by dragging those records individually or dragging them 
collectively as a single selection into the title bar or outside the Database window, or b) press 
and hold the option key as you drag the records in the set outside the window to remove 
them from the set and from All Records, too. When you remove records irretrievably from 
the database, DP asks you to confirm your intentions.

• Click the import button or press return to select the highlighted import button from the 
keyboard.

The Database view reports the number of records now in the database, i.e., in ‘All Records’, 
and the number in each set. 

• Double click one of these nine icons to open its Browse view. 

The ‘Default Browse Format’ is always available. It shows the default record type and record 
size of each record. The record type is NOT automatically discerned from the imported 
records. If desired, you can manually assign this using the pop-up menu.

• Optionally, choose one of the existing Browse formats from the Formats menu or create 
one to serve your needs.

The imported record is now displayed in a format intended for human, rather than 
computer, use.

• Optionally, double-click one of the records in the Browse view to examine it in the Data 
Entry view. 

• Optionally, choose one of the existing Data Entry formats from the Formats menu or 
create one to serve your needs. 

You can use this import process for the other record formats (tagged, delimited, and fixed 
length). A single file must consist of only one of these as a common record structure. You 
must assume responsibility for matching the database structure with the import file 
structure. DP provides a review window  for you quickly to make interactive adjustments to 
match the format to the record structure. Several sample tag files (and related import 
formats) are included on the distribution disk.
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Bibliographic database programs, such as Pro-Cite® , export and import records using the tab-
delimited structure. EndNotePlus and most online and CD ROM-based bibliographic sources 
use the tagged format. Let’s consider the details for importing data from these sources.

Delimited Record Import

Before you can import data, you must define the DP database structure needed to receive the 
data. This means you must select, modify, or create a tag file. Let’s use a supplied tag file 
called Pro-Cite Tags. The procedures for creating a tag file are discussed at the end of this 
chapter. 

• Optionally, choose Pro-Cite Tags 2.0 from the Windows menu to review the tags.The file 
contains numbered tag icons, the formal (or extended) name for a field, and an informal 
(or abbreviated) name for the same field. The informal name and optionally the tag 
number, are displayed in the Data Entry view next to the space reserved for the contents of 
that field. These field names are the identifiers used by Pro-Cite®  2.0 (Figure 1). Scroll to 
review the entire list.

• Click the close box of the Tag Window or choose the Close Tag File command on the File 
menu (  W).

DP exported the Pro-Cite file  as a text file (Pro-Cite 2.0 Sample) using the following options: 
Custom format, separate fields with horizontal tabs (ASCII 9), end records with carriage 
returns (ASCII 13), no field delimiters, no record numbers, workform, and include all fields.

To import tab delimited records:

• Use the New command to create a database file using the Pro-Cite Tags, i.e., select the 
database icon, choose Pro-Cite 2.0 Tag from the pop-up list, supply a name for the database 
file (e.g., Pro-Cite Example), and choose a file destination. 

Refer to the discussion in the preceding example for additional details. The database name is 
displayed in the open database view.

• Choose the Import command on the File menu.

In the dialog (Figure 13) that appears:

DiscoverPro  3.14



Fig. 13 Import File Dialog

• Select the Pro-Cite Import Format from the pop-up menu.

• Choose a destination (Import Into) for the records, e.g., ‘All Records’.

This is a new database so there are no previous records in the database.

• Select the file containing the tab-delimited text file created by Pro-Cite, e.g., Pro-Cite 
Exported.

At this point there are three alternatives: 1) Import proceeds immediately, 2) New Format 
allows you to begin anew with an import definition as if you had used the Import command 
on the Formats menu, and 3) New Format opens theImport Format window with the Pro-
Cite Import Format (you selected above) displayed; DP shows the contents of the first record. 

• Verify that the fields and data match (Figure 14a - Figure 14c). 

• Scroll through several records using the arrows at the bottom right corner of the window 
 (Figure 14a). 

DP immediately implements interactive changes, e.g., choice of fields, field delimiter, etc. 

The import tab-delimited format must match the choice and  sequence of fields in the file 
being imported and must use the same field separators and record terminators. Figure 14a 
shows the DP options selected: Record Organization, Delimited; Field delimiter, Tab; No 
field enclosures. DP assigns a default Record type in the pop-up menu and saves the 
workform information in a field. 
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Fig. 14a Delimited Import Format (Pro-Cite Records), Pt. 1
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Fig. 14b Delimited Import Format (Pro-Cite Records), Pt. 2

• Select all fields by shift-clicking in the Fields Window and drag them as a group into the 
Format Window. 

The fields and their sequence in the list must match the records in a character-delimited 
import file. 

• If necessary, use the mouse to drag the fields into their correct order. Scroll to see the 
composite of all the fields used by Pro-Cite (Figure 14b and Figure 14c). 

Pro-Cite uses double slashes to separate names. However, saving the names of authors in 
separate fields provides additional formatting flexibility. To retain the Pro-Cite convention, 
use the ‘Ignore’ subfield default (Figure 14a), and DP stores all names separated by ‘//’  in a 
single field. 

To separate the names into separate fields, choose ‘Split Into Separate Fields’ on the 
Subfields pop-up menu (Figure 15) and assign the characters that identify the subfields (‘//’ 
in Figure 14a).
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Fig. 14c Delimited Import Format (Pro-Cite Records), Pt. 3

Fig. 15 Subfield Options Menu

After verifying several records, click the close box of the Import Format Window. 

• Click OK to import the records or Cancel to abort the process.

DP parses the data first and then imports the records.

• Examine the records in the Browse and/or Data Entry views.

Tagged Record Import

Each field in a tagged record (Figure 16) is preceded by a character string that is used to match 
the field tags in the input stream. Each tag must begin on a new line. The fields within a 
record in the input stream can be in any sequence. Not  every field need appear within a 
record. The tag lengths can be up to 15 characters. If the tags exceed this generous limit, use a 
word processor to replace the longer tags with shorter, but unique, tags and save the file as a 
plain text file. Do not save the styling information, i.e., don’t use the word processor’s native 
format.
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Fig. 16 Example of a Tagged Record (from Agricola)

Let’s illustrate the process of importing a tagged file exported by EndNotePlus using the 
‘~Refer Export’ style supplied as a part of that application and a tag file based upon 
EndNotePlus’ field names. The tags consist of the ‘%’ character followed by a single character 
and a space. 

The steps in the tagged import parallel those for delimited records, despite the substantive 
differences. Before you can import data, you must define the DP database structure needed to 
receive the data. This means you must select, modify, or create a tag file. Let’s use the 
supplied tag file, ‘EndNotePlus 1.1’. The procedures for creating a tag file are discussed at the 
end of this chapter. 

• Optionally, choose EndNotePlus 1.1 tags window from the Windows menu to review the 
tags.

The file contains numbered tag icons; the formal, extended name for a field; and a familiar 
(or informal) abbreviated name for the same field. The familiar name and, optionally, the 
tag number, are displayed in the Data Entry view next to the space reserved for the contents 
of that field. These field names are the identifiers used by EndNotePlus 1.1. If necessary, 
scroll to review the entire list.

• Click the Tag Window’s close box or choose the Close Tag File command on the File menu 
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(  W).
The EndNote file was exported as a text file (ENP Refer tagged export) by selecting ‘~Refer 
Export’ on the Styles menu and then using the Export command on the Files menu.

To import tagged records:

• Use the New command to create a database file using the EndNotePlus 1.1 Tags, i.e., select 
the database icon, choose EndNotePlus 1.1 tag file from the pop-up list, supply a name for 
the database file (e.g., ENP Example), and choose a file destination. 

Refer to the discussion in the preceding example for additional details. The database name is 
displayed in the open database view.

• Choose the Import command on the File menu.

In the dialog that appears (Figure 17):

Fig. 17 Import File Dialog

• Select the ‘Refer (into EndNotePlus)’ Import Format from the pop-up menu.

• Choose a destination (Import Into) for the records, e.g., ‘All Records’.

This is a new database so there are no previous records in the database.

• Select the text file containing the tagged records, i.e., ‘ENP Refer’ tagged export.

At this point there are three alternatives: 1) Import proceeds immediately with the import 
process, 2) New Format allows you to begin anew with an import definition, as if you had 
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used the Import command on the Formats menu, and 3) New Format opens the import 
Format window with the Refer (into EndNotePlus) Import Format. The contents of the first 
record are shown. 

Verify that the fields and data match (Figure 18a). Drag the window divider horizontally, if 
desired. Scroll through several records using the arrows at the bottom right corner of the 
window. DP immediately implements interactive changes, e.g., choice of fields, field 
delimiter, etc. 

The import format in DP 1) must match the tags in the records being imported (the sequence 
of the fields is immaterial) and 2) must use the same field separators and record terminators. 
Figure 18a shows the DP options selected: Record Organization, Tagged; Subfield Marker, 
‘//’; Field Terminator, cr; Record Terminator, CR/LF. The Record type in the pop-up menu 
is the assigned default; DP saves the reference type information in a field (%0 tag), but does 
not assigned it to the pop-up menu automatically. Select the list of fields by shift-clicking in 
the Fields Window and dragging the selection into the Format Window. The field names in 
the list should be the composite of the records in the import file. DP ignores data 
corresponding to tags omitted, intentional or not, during the import process. Scroll to see 
the composite of all the fields used by ENP (Figure 18a and Figure 18b). 
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Fig. 18a Tagged Import Format (EndNote Plus Records), Pt. 1

Fig. 18b Tagged Import Format (EndNote Plus Records), Pt. 2

Fig. 19 Subfield Options

ENP, as well as DP, uses double slashes to separate names. However, saving the names of 
authors in separate fields provided by both ENP and DP provides additional formatting 
flexibility. 

To separate the names into separate fields, choose ‘Split Into Separate Fields’ on the 
Subfields pop-up menu (Figure 19) and assign the characters that identify the subfields (’//’ 
in Figure 18a)

After verifying several records, click the close box of the Import Format Window. 

• Click OK to import the records or Cancel to abort the process.

DP parses the data first and then imports the records.

Examine the records in the Browse and/or Data Entry views.

To import fixed length records (Figure 20):

The steps are the same as for a tagged import, except the dialog obtained when you choose 
Open Format is different.

• As above, use the New command to create a database file using an appropriate tag file. 
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• Choose the Import command on the File menu.

In the dialog that appears:

• Select the desired fixed length record import format from the pop-up menu.

• Choose a destination (Import Into) for the records, e.g., ‘All Records’.

• Select the text file containing the fixed length records.

• Use Open Format to show how you want DP to import the contents of the first record. 

Verify that the fields and data match (Figure 21). Drag the window divider horizontally, if 
desired. Scroll through several records using the arrows at the bottom right corner of the 
window. DP immediately implements interactive changes, e.g., choice of fields, field widths, 
etc. 

The import format in DP must match the records, their sequence, and their lengths. 
Figure 21 shows the DP options you selected: Record Organization, Fixed Length. The 
Record type in the pop-up menu is the assigned default. Elect to remove the trailing spaces 
used to pad fields. You selected the list of fields from the Fields Window and dragged them 
into the Format Window. The field names in the list should be the composite of the records 
in the import file.

From Other Applications

MacRegistrar, a course grade management database, exports the end of term grades to the 
Registrar using fixed length records (Figure 20). DP can read these files (Figure 21). 

To import fixed length records:

• Create a suitable tag file (MacRegistrar Tags) that includes all the fields you want to import.

• Create a new database using this tag file. 
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Fig. 20 A Fixed Length Record Sample (MacRegistrar)

• Choose Import on the File menu.
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• Select the import text file.

• Click Open Format to obtain the Format window (Figure 21).

Fig. 21 Fixed Length Import Format (MacRegistrar Records)

• Choose Fixed Length for Record Organization and set the Default Record Type.

• Check ‘Strip Trailing Spaces’ unless you need to preserve the original form.

• Drag the field names from the Fields window into the Format window and match the 
sequence of the input data stream by dragging, if necessary.

• Assign field widths to match the input (Figure 20)

• Add a blank field of length 1 to skip the end of record marker (which is not needed but 
must be accounted for.) 

Note: The total field width includes this blank character.
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Locate
Retrieval of stored records is one of the primary uses of a database. The larger the number of 
stored records, the more valuable a database becomes, especially if it offers you commands to 
locate relevant information quickly and easily.

Simple Search Criteria

In Chapter 2 we discussed the simplest of searches, i.e., examining every record in the 
database or within a Set folder for one, two, or three text strings, regardless of field. Because 
that process is so simple, no further comment is needed in this Chapter.

Complex Search Criteria

Sometimes you need more complex search criteria; DP provides a graphical environment 
for forming arbitrarily complex searches. These searches are always performed from the 
Browse view. Selection criteria include: 1) record attributes (record size, record type, number 
of tags, absolute record identification, date created, date modified, membership and text 
without regard for its field location), 2) field attributes (contents, size, type), and 3) keyword 
lists of terms extracted from user-selected fields.

After gaining access to the Search window (Search command on Records menu in Browse 
view) you form each search condition within a ‘tile’ in the Search window. You create tiles 
concerning record attributes by selecting a characteristic from the Tiles menu and create tiles 
concerning field attributes by dragging field tags from the Fields Window and dropping 
them into the Search list box. Consider some examples.

To locate all records either created or modified since a certain date (Figure 22).

• Choose Date Created and Date Modified from the Tiles menu and two tiles appear in the 
list box of the Search Window. Note: Each tile forms a separate search condition.

Tile 1

Tile 2

Conditional 
divider

Fig. 22 Locate Records Created or Changed Since a Certain Date

The tiles (i.e., Boolean conditions) are connected by the logical ‘AND’ and ‘OR’ operations. 
One conditional divider is always present, but you may need to change its default position 
and operator to achieve the desired results. You can add as many conditional dividers as 
needed. To remove a tile or a divider, click the double-headed, vertical arrow at its left end 
and use the ‘Delete Tile’ command on the Edit menu.
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• Drag the conditional divider (the thicker line with the small ‘OR’ pop-up menu) by its 
double-headed arrow and drop it into a position between the two tiles (Figure 23).

You can choose either ‘OR’ or ‘AND’ on the divider’s pop-up menu to select record which 
satisfy EITHER one condition or the other or to select only records which satisfy BOTH 
conditions.

• Select ‘OR’ from the pop-up menu at the middle of the conditional divider.

• Use the middle pop-up menu (that reads ‘is’) on each tile to choose ‘is after’ as the operator 
for each tile.

• Adjust the dates. As required, click on the month, day, and year and adjust using the 
arrows, just as you adjust the Alarm Clock on the Apple Menu.

A few additional choices complete the specifications. 

• Choose the search location (All Records or a Set folder) using the pop-up.

The number of records in each location is shown in brackets. Also, the name you assigned to 
the Set folders replaces the generic names (Set 1 and so forth).

• Choose ‘Insert In:’ and Set 1 (which currently contains no records).

You can append the records located in the search to a set already in a folder, or you can 
replace any existing records in the destination folder.

• Click ‘Search’ to perform the search.

• Open the destination Set folder in either Browse or Data Entry views to review the results 
of the search.
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Name assigned to 
this set of conditions

Source of 
search records

Menu of 
record 
attributes

Menu of choices 
for this attribute

Boolean 
operator 
relating tiles

Destination of 
records found 
in search

Append to or 
replace any 
existing records

Fig. 23 Search Window Showing Record Tiles

To conveniently repeat a particular search:

• Name the set of conditions established in the Search Window using the New command 
on the Search Name pop-up menu (Figure 24).

Fig. 24 Search Name pop-up menu

When you wish to repeat a search, just choose the search name to re-establish all the 
conditions previously defined (Figure 23).

To delete or rename a set of search conditions, first select the name and then select the 
command.
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To perform a field-dependent search:

• Use the New command on the Search Name pop-up menu to clear the search list box of 
conditions. Assign a search name, e.g., Stoma.

• Open the Fields Window, if not already open.

• Drag field names from the Fields Window and drop them into the list box of the Search 
Window.

• If necessary, add conditional dividers.

• Re-arrange the fields and conditional dividers (by dragging the double-headed arrows) to 
form the desired search criteria (Figure 25).

Field-specific tile Field attribute menu Contents relationship menu

Publication year tile

Fig. 25 Search Conditions (Tiles)

The conditional dividers establish the Boolean operators and create parentheses that 
separate groups of conditions. If you choose ‘OR’ on the conditional divider, the ‘AND’ 
operator separates all the tiles between the dividers. Conversely, if you choose ‘AND’ on the 
conditional divider, the ‘OR’ operator separates all the tiles between the dividers.

• Set the ‘Where’ and destination conditions, as discussed in the previous example.

If you click on the arrow on the field name tile, its tag number and formal name are 
displayed just above the list box.

• Click ‘Search’ to perform the search.
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• Open the destination Set folder in either Browse or Data Entry views to review the results 
of the search.

• Perform additional searches, if necessary, appending the results to this Set folder.

• If you wish, sequentially refine the results of a search by selecting it as the ‘Where’ set and 
choose a different destination folder for the next search.

You can perform very extensive and detailed searches using techniques described in this 
section. However, searches of this type require that DP read every record in the database. If 
you work with thousands of records, you need a faster search process; such a search process 
is described in the next section.

Indexing
DP can build an index to the records which serves a role analogous to the an index in a 
textbook, i.e., a list of topics and their locations. Using this list speeds the browsing, making 
the examination of every record unnecessary. DP automatically generates such a lists of the 
‘words’ and record numbers for any fields you designate. DP treats name fields (i.e., those so 
designated in the Tags Window) as a single entry in the index. It defines a word as a strings 
of letters separated from other strings by a space on either side, and it saves each individual 
word in a field you designate before it adds the word to the index. To retain a compound 
word such as bull moose, type option-space rather than only a space character between bull 
and moose.

To build an index:

• If necessary, open the database to the Browse view.

• Choose the Index command from the Records menu.

• Drag the name(s) of the field you want to index from the Fields window into the Dialog 
window (Figure 26).

The order of the fields is immaterial; DP creates a separate file for each.

• Optionally, exclude short words and specific other non-descriptive words from the list 
(Figure 27)
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Drag any number of field name(s) from the Fields Window;
tag numbers are displayed too.

Exclude of short and/or 
non-descriptive words.

Fig. 26 Field Index Dialog
• Click OK.

DP examines the specified fields of every record and creates an index file for each field 
included in the list box. These files bear the name of the database and have the tag number 
of its field appended (Figure 28).

Fig. 27 Index Word Exclusion Dialog
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Fig. 28 Database and Index File Icons

Note: If you modify the database, the index no longer matches and, therefore, is 
automatically disabled by DP.

To search an indexed field:

• If necessary, open the database to the Browse view.

• Choose the Search command on the Records menu.

• Use the New command on the Search Name pop-up menu to clear the search list box of 
conditions. Assign a search name, e.g., Stoma. 

When you repeat this search later, just select the search name from the pop-up list to restore 
all the conditions you assign here.

• If necessary, open the Fields window.

• Drag the name(s) of the indexed fields you want to search from the Fields window and 
drop them into the Search window.

• If necessary, add conditional dividers.

• Re-arrange the fields and conditional dividers (by dragging the double-headed arrows) to 
form the desired search criteria.

The conditional dividers establish the Boolean operators and create parentheses that 
separate groups of conditions. If you choose ‘OR’ on the conditional divider, the ‘AND’ 
operator separates all the tiles between the dividers. Conversely, if you choose ‘AND’ on the 
conditional divider, the ‘OR’ operator separates all the tiles between the dividers.

• Select ‘Index’ from the leftmost pop-up menu on the tile associated with field name 
(Figure 29).

If the index for this field is available (and has not been disabled), this displays the index list 
(and the frequency of each term) in the Search window. The insertion point appears in the 
text box on the tile.

• In the second pop-up menu on the field’s tile, choose ‘has item matching’.

• Place one of the index entries in the text box. Either scroll through the list and click on 
your choice to transfer it into the tile, or type your entry in the tile. As you type the list 
scrolls to match the entry. Either type the entire entry or at any time click on an entry in 
the list automatically to transfer it into the tile.
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Although you can combine indexed searches with non-indexed searches, ordinarily avoid 
this to experience the dramatic speed increase of an indexed search.

Fig. 29 Indexed Search

• Set the ‘Where’ and destination conditions, as discussed in the previous example.

If you click on the arrow on the field name tile, the tag number and formal name of the field 
are displayed just above the list box.
• Click ‘Search’ to perform the search.

• Open the destination Set folder in either Browse or Data Entry views to review the results 
of the search.

You can print the index of words of a field and the frequencies of the words and can 
export them to a text file, as discussed in a later section. Using a spreadsheet program, 
you can, for example, sort the entries according to frequency of occurrence.
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Sorting
In general, DP stores the records in data entry order. If you need to rearrange the list in 
alphabetical order, DP creates and sorts a list of pointers to the records without rearranging 
the physical order of the records. In other words, you sort the viewing order, not the 
physical order. 

You can sort the list in ascending or descending order for any field and the record attributes 
(record size, record type, number of tags, unique record identification number, date created, 
and date last modified). Furthermore, records that have common sort fields can be sorted 
according to the contents of as many additional fields (second, third, etc.) or record attributes 
as you require. DP maintains only one sort sequence at a time, but you can quickly repeat the 
process with other sort choices. 

The sort applies to ‘All Records’ and to all Set folders because these folders allow you to 
view subsets of the entire set of records. If you manually rearrange the sequence of records 
in any of the Browse views by dragging, that change applies to the database (in ‘All Records’ 
and in all Set Folders) regardless of the view in which you made the change.

To sort the records of the database:

• If necessary, open the database to the Browse view.

• Choose the Sort command on the Records menu.

• If necessary, open the Fields Window.

• Drag the name(s) of the sort fields you want to search from the Fields Window and drop 
them into the Search window.

• If necessary, drag the field names into the desired order in the Sort window.

The first name is the primary sort field. Succeeding fields, if any, specify an order for 
resolving matches in the field listed immediately above. The sort order applies to the 
Browse, Data Entry, and Export views.

• Click ‘Sort’.

• Examine the records in either the Browse, Data Entry, or Export views. The sort order 
applies to All Records, and hence to all the set folders too.
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Output
DP provides three primary channels for output: screen, printer, and files (text and RTF data 
interchange files), several secondary paths (editions, Apple Events, and styled text), and a 
few tertiary paths (clipboard and export files).

Screen 

We have discussed already the Browse and Data Entry views and the intimately related 
Formats menu. DP provides exceptional flexibility in letting you choose and sequence fields. 
You can assign style attributes (font, size, and style) for text fields and display size for pictures 
and movies. One important screen view remains to be discussed.

Export Window

The Export command on the File menu coupled with the Export command on the Formats 
menu provides DP’s most general form of output. This output channel sends formatted 
output to the screen and to files (plain text, styled text and RTF). Consider the formatting 
first.

To format text for export:

• If necessary, open the database.

The export format command is accessible from the Database, Browse, and Data Entry views.

• Choose Export from the Formats menu.

Fig. 30 Export Format Dialog
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The italicized export formats (US MARC, and USMARC Formatted Dump) are uneditable 
defaults. All other entries are user-defined and, if selected, can be renamed, duplicated, 
deleted, or edited. Use New to start anew.

• Click New (Figure 30).

• Assign a descriptive name to the format.

• Choose a record type from the list box on the left and assign field names by dragging them 
from the Fields Window and dropping them into the Format Window. Double-click 
entries in the other list box to add record variables and special characters at the position of 
the insertion point.

• If necessary, use cut and paste to move or to remove the field tokens.

• Use the pop-up menus to specify a field length, to indicate whether you want to include all 
subfields, to select a name style (if designated as a name field in the Tags window), to 
determine field options (e.g., text to precede or to follow the field), and to indicate whether 
you want to replace the field contents with an expanded form. The lookup option uses the 
Abbreviations Window to replace the entire field (not just a single word) with an 
expanded form. For example, if you stored abbreviated journal names, the lookup option 
uses a user-defined abbreviations conversion list appropriate to a specific journal. These 
options are the same as discussed for the Browse view.

• Assign text attributes to the field tokens and to any user-supplied non-varying text using 
the Font, Size and Style menus.

The text attributes are passed to the text that replaces the token during export.
• Choose another Record Type of interest and repeat this process.

• Click the close box (top left corner of window) to close the Format window.

• Save the format.

DP copies the information specified in this format from the records and sends it to the 
screen or to a file when you use the Export command.

To export records:

The generic term ‘Export’ denotes the generation of output from DP records—whether sent 
to the screen, to a printer, or to a file. The process involves three operations: 1) selection of 
the fields you want to copy, their order in the output, the modifications that you made 
(abbreviation replacements, additional punctuation, text attributes, etc.); 2) selection of the 
records from DP from which to take data; and 3) selection of a destination (window, file, and 
file type). 

Step 1: Formatting: This step was discussed in the immediately preceding section.

Step 2: Selection of Records: This step was discussed in Chapter 2 and in the section on 
locating records in this Chapter.  After completing steps 1 and 2:
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• Close the Data Entry view, if necessary, and choose Export from the File menu (Figure 31).

Fig. 31 Export Dialog

• Select an Export Format and a source of Export records from the pop-up menus.

Step 3: Destination of Output: 

• Select a destination: window (i.e., screen), a new file, or an existing file.

To generate a new file, you must choose a file destination, name and type.
• Click ‘Export’.

If DP sent the output to a new window, you can scroll through the output, edit the text, and, 
if desired, print the window. If DP sent the output to a styled text file, DP can open that file 
later and print it. If you saved the output in a text file (without text formatting attributes), 
any word processor can read it. Most word processors can also read RTF files that preserve 
text formatting information.

DP supports special formatting for bibliographic records. Refer to Chapter 4 for the details.

To export an index file:

The index (generated to  locate records rapidly) provides a revealing characterization of the 
topics covered in a database file and has value apart from DP. You can transfer a copy of the 
index words and their frequencies to a text file which can be read by word processors, 
spreadsheets, and by DP, of course.

• If necessary, use the Index command on the Records menu when you are not in Data 
Entry view to create an index for a field. 

• Choose the Index command (again and, if necessary, drag the field name into the Index 
Window again.

• Click on the field name to enable the Save Index As Text command on the File menu and 
choose that command.
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• When DP requests, supply a file name and file destination and click ‘Save’.

DP saves all the indices as a tab delimited text file which can be read by many Macintosh 
applications.

Printer 
DP provides numerous types of printed output. As discussed earlier DP can print both Data 
Entry and Browse views of records and the tag files without special considerations. Various 
other special reports and files can be printed too. The first step is to connect your Macintosh 
to a printer and then use the Chooser command on the Apple menu to select a print driver 
and a particular activated printer. Remember to use the Page Setup command on the File 
menu to select (or confirm) the paper size, orientation, printer effects, and other options.

To print an index:

You can print the index from within DP or export it as a text file to edit and print in a 
spreadsheet or word processor program.

To print an Export Window:

The Export window provides additional format controls for polished reports.

• Create or open a styled text file (Figure 32).

The creation of an Export window is described earlier in this chapter. To open an existing 
styled text file use the Open command on the File menu (with the Styled Text file type 
selected). 

• If desired, edit the Export window as if it were a word processor file because it actually is a 
simple word processor.

• Choose the Print command on the File menu and select options such as number of copies, 
page range, header, and page numbering.

• Click ‘Print’.

File
DP creates several file types. The DP database file stores the records. The tag file stores the 
field names and various other lists. The styled text files contain formatted text for 
subsequent reading and printing by DP. The plain text and RTF files provide an interchange 
path. As discussed in the next section, DP also generates ‘Publish and Subscribe’ files for 
other applications compatible with this System 7 feature.
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Fig. 32 An Export Window

The DP file management dialogs provide check boxes so that the list box shows only folders 
and files of the type of interest. In addition to the New and Open commands on the File 
menu, file handling is provided by the Tag window, the Index Window, the Import and 
Export commands for individual fields and for records. The Publish and Subscribe feature 
discussed in the next section saves excerpts from the Export window as intermediate files to 
be shared with System 7 applications.

Interact
Applications which are compatible with this System 7 feature can interact with DP through 
intermediate files called ‘editions’. 

To Publish Text:

• Use DP to create an Export window (Figure 32), as discussed above.

• Select text using the mouse or keyboard.

This enables the Create Publisher command on the Edit menu.

• Choose the Create Publisher command,  supply a file edition, and specify a file destination 
(Figure 33)

• Click ‘Publish’.
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Published selections are identified by borders, when you toggle ‘Hide Borders’ to ‘Show All 
Borders’ on the Edit menu.

• Use the Publisher Options command on the Edit menu to update editions manually or to 
save editions. If DP subscribes to an edition, the Publisher Options command changes to an 
analogous ‘Subscriber Options’.

Fig. 33 Create Publisher Dialog
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Maintain
The creation and use of a database usually extends over many sessions. Duplicates 
accumulate, especially when records are imported, and they waste storage spac Probably 
even more annoying is the confusion which arises when you update one but not all copies. 
Sometimes you need to move data from one field to another. Sometimes your needs 
expand, and you must add new fields. When you delete records, you create gaps in the 
database file; you need this wasted space. Finally, catastrophic failures due to faulty storage 
media, power outage, etc. can make a database file unusable. DP provides a limited recover 
process. We now discuss how DP deals with these maintenance issues.

Duplicates
In order to remove duplicate records, you must first establish criteria for establishing the 
similarity of records.  Select any combination of fields to identify potential matches. You can 
examine the matches and make a decision on disposition or, automatically, delete the 
suspect records. Because removal is irreversible, be very cautious about using the automatic 
removal option.

To identify and to remove duplicates:

• Make a duplicate copy of your database before beginning this or any irreversible operation.

• From the Browse view, choose Duplicates from the Records menu.

The Duplicates dialog (Figure 34) allows you to compare records on the basis of Record IDs 
or on the basis of user-selected fields. 

• Establish comparison criteria.

The Record ID is a unique record number generated by DP using the Macintosh clock 
reading when you create the record. Duplicates of this type can occur only by duplication of 
an existing record within the database. A more likely situation for encountering a duplicate 
happens when you import records from an online search or from a CD. Because no check 
for duplicate record occurs when you manually create a record, duplicates can arise from this 
process too. 

Warning: Use multiple fields for comparison. For example, if you were to use only the 
author and date fields, DP would consider equivalent all records published in a given year 
but having no author listed .
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Fig. 34 Duplicates Dialog Box
• Click OK.

Fig. 35 Disposition of Duplicates Dialog

Be patient, DP retrieves and compares every record in the database. When the process is 
complete, you must decide upon the disposition of any duplicates found (Figure 35). You 
can option-click on any of the check boxes to select that particular choice for all duplicate 
groups. Otherwise, make a choice for each group of duplicates. The choices are to disregard, 
that group of suspected duplicates, delete the most recent duplicates, or insert or append the 
suspected duplicates in one of the set folders.

DiscoverPro  3.41



• Open the set folder and compare the records in Browse view.

• Manually select the duplicates.

If necessary, change the Browse format or temporarily switch to Data Entry view to verify 
that a duplicate exists. Either drag the duplicate records individually into a set folder for 
subsequent removal from the database or command-click duplicate records to select a 
disjoint group and subsequently drag them as a group into the set folder.

If you must make all the comparisons from the Data Entry view, use ‘UnSelect All’ in the 
Browse view, switch to Data Entry view, and use the ‘Selected’ check box to designate the 
records you want to delete. When you return to the Browse view, the checked records are 
highlighted. Drag the highlighted group into a set folder.

• Drag the duplicates from the Browse view into a set folder.

• Open the set folder of duplicates, Use Select All on the Edit menu, and press and hold the 
option key as you drag the duplicates into the title bar.

The cursor changes to a trash can icon and an outline of the records follows the cursor. If 
you fail to press and hold the option key as you drag the records into the title bar or outside 
the database view, DP deletes the records  ONLY from the set folder, not from the database 
too.

• Click OK to confirm that you want to throw away these records.

Replacements
The Find/Replace command is a powerful tool for modifying the contents of your database. 
Two cases are particularly noteworthy. 

Suppose you wish to change the contents of some field for some or all records.

To replace the contents of a user-selected field with an expanded or abbreviated form when 
you are going to apply a field-specific change to a subset of records,

•  Place the records you want to modify in a subset before invoking the Find/Replace 
Command.

• Choose Find/Replace from the Edit menu, and a dialog appears (Figure 36).

• Select the records you are going to modify (All Records, a set, or this record) using the 
Where menu (Figure 37).

• Choose a method, e.g., Find/replace Text, from the Methods menu (Figure 38).
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Fig. 36 Find/Replace Dialog

Fig. 37 The Where Menu For Find/Replace Command

Fig. 38 Methods Menu For Find/Replace Command

• Supply the text string you want to locate, using wildcard characters (any digit, any 
uppercase letter, any lowercase letter, any alphabetic character, any character, or the special 
tab, carriage return, or line feed characters selected from the pop-up menu at the right of 
the Find Text text box). For example, to shorten the year from four digits to two use 19##.

• Choose whether to require whole words (i.e., not just an embedded string) and case (upper 
or lower) matches.
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• Click the Selected Fields button and drag the field names from the Fields window into the 
list box that appears with this choice. For example, choose publication year.

• Supply the replacement string. For example, to shorten the year to two digits, use the 
character number of the selection from the pop-up, twice selecting characters 3 and 4.

• Click Find and then repeatedly click Replace, Then Find or Replace All just once.

To modify records by moving the contents of one field to another field:

Suppose you have stored the authors in main author (Field 100a) and additional authors 
(Field 700a) fields, and you wish to list each author in a separate Main Author field.

• If you want to apply a change to a subset of records, place the records you want to modify 
in a subset before invoking the Find/Replace Command.

• Choose Find/Replace from the Edit menu.

• Choose Find/Replace Fields from the Methods menu.

• Select the records you want to modify (All Records, a set, or this record) using the Where 
menu.

• Drag the field names you want to search from the Fields window and drop them into the 
list box that appears with this choice. For example, choose Add. Author.

• Choose All Fields from the Include pop-up menu to include multiple instances of this 
field.

• Drag the replacement name from the Fields window and drop it into the Change To box. 
For example, choose Main Author.

• Click Find,then repeatedly click Replace, and finally click Then Find or Replace All just 
once.

You can undo the swap just completed if you exchange the roles of the two fields in the 
Find/Replace window and choose ‘All But The First Field’ from the Include pop-up list.

Adding Fields

If you maintain a database for an extended time, you will inevitably need to modify what is 
stored. You might wish to have multiple fields for an existing field (e.g., a separate field for 
each author) or even need a field not anticipated when you created the tag file. Both cases 
can be accommodated. 

To create a duplicate of an existing field:

• In Data Entry view, click to select a field.

• Press command-return, i.e., hold the command key down while you press the return key.

DiscoverPro  3.44



• Choose a field type and enter data.

If you leave the new field empty, DP does not save it with the record. If you subsequently 
clear that field and save the record, the field vanishes.

To add a completely different, new field:

You can modify the tag file to restructure the database at any time.

• Open the Tag file by clicking on the tag icon at the bottom of the Browse or Data Entry 
view.

• Click on an existing tag category or tag to establish a general location for the new field and 
choose the New Tag (or New Subfield) command on the Tags menu.

• Supply the remainder of the tag identifier and click ‘OK’.

• Successively click on the formal and familiar name positions on the tag and supply those 
names.

• Open the Fields window, if not open, and drag and drop the new tag there.

• Click on the Close box of the Tag window to save the modification.

• Select Data Entry from the Formats menu and double-click on the name of the format 
where you want to add the new field.

• Choose a Record Type from the list box.

• Drag the new tag from the Fields Window into its intended position within the existing 
list of field names.

• Click on the close box and then on the save button.

When you return to the Data Entry view and select the modified format, the new field 
appears. It remains defined even if you supply no data for the field.

Compact Database

Whenever you delete a record, DP does not automatically compact the database to recover 
that no longer used file space. Similarly, use of the Find/Replace command can fragment 
the database storage.

To compact a database file:

• From the Browse view choose the Compact Database command.
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Repairs

A catastrophic failure, such as loss of power, interruption of a file saving operation, etc., can 
corrupt a database file. Therefore, save an extra copy of any important file on a separate 
storage medium to hedge against such failures. In case of such a failure, the Repair 
command can sometimes salvage the file.

To repair a damaged database file:

• With no database files open, choose the Repair command on the File menu.

• Select the damaged file.

• Assign the appropriate tag file.

The tag files currently known to DP appear in a pop-up menu. Use the Locate Other button 
to select a tag file not listed in the pop-up menu. This is the same dialog available from the 
Assign Database Type on the File menu.

• Click ‘OK’.

DP attempts to read and recover each file. This can be a lengthy process so don’t abort the 
process to soon.  Note: The recovery process reinstates deleted files that have not been 
permanently expunged using the Compact command. 

Database segmentation

Sometimes you need to transfer records among database files. We recommend that you 
produce a precautionary backup file before making any global change to the database.

To split a database into two files:

• Close the file you want to split if it is open.

• Switch to the Finder level.

• Choose the Duplicate command to create a duplicate copy of the database file.

• Activate DP and open each file in the Browse view.

• Select the records in the second part of the first file and use the Delete Records command 
on the Records menu.

• Use the Windows command to switch to the other database file.

• Select the records in the first part of the second file and use the Delete Records command 
on the Records menu.

• Close the files.
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If desired, rename the files.

Sometimes you need to copy some records from one database file to another. The process is 
the same whether you wish to append some records to another file or to copy some records 
into a new database.

To append records to another database:

The process of transferring records from one database to another using the same tag file is 
simple—drag a selection of records from one open database and drop them into another 
open database.

To copy records from one open database into another open database:

• Open the originating database and note its tag file name shown at the bottom of the 
Browse view.

• Open the destination database (or use the New command on the File menu, Figure 39, and 
create a new file having the same tag file as the original file).

Fig. 39 New Database

• Choose the name of the originating database from the windows menu and drag its 
Browse view such that the ‘All Records’ or set folders of the destination database are also 
visible.

• Select the records from the originating database you wish to transfer.
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• Drag the records onto the destination database icon for ‘All Records’ or onto one of the set 
folder icons.

Fig. 40 Copy Records to Another Database Window

After DP copies the records, you can examine the results or close the files.
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Chapter 4

Command Reference

This chapter is command, rather than task-oriented; we examine each menu command in 
detail. In Part I we discuss the database file and the associated commands for creating, 
locating, modifying, and retrieving records. In Part II we describe the tag files used to 
structure databases—how to create them and how to use them to configure DiscoverPro for 
other uses. Before plunging into a discussion of the specific commands, let’s first discuss a 
few ideas we use throughout the chapter. 

DiscoverPro provides an environment for storing, viewing, and retrieving multimedia 
information (text, pictures, sounds, QuickTime movies). This breadth makes DP useful in a 
broad range of applications concerning the management of the non-numeric data in the 
scholar’s workplace. 

The efficient management of bibliographic citations for all types of intellectual materials was 
a core design requirement. To achieve this breadth we implemented the USMARC system; 
this motivated the implementation of tags to endow the database with structural flexibility. 
We have deferred our detailed discussion of Tag files to Part II of this chapter because you 
can use the supplied Tag files without learning how to create them. 

DP goes beyond the scope of the USMARC standard by providing broad multilingual 
support, graphics support (including mathematical and chemical structures and symbols), 
sound (human voice for pronunciation of technical and foreign words, for example, and 
music), and movies that combine sound and color. 

DiscoverPro can also be a file of books. It stores formatted text, color pictures, and sounds 
separately, but can combine them in a movie. You can view images of pages of journal 
articles and books (stored as frames in a movie file) as a sequence of still images. DP, thereby, 
becomes a vehicle for the electronic distribution of books and journals.

Another distinguishing DP feature is its ability to provide multiple views of stored 
information quickly and easily. The Browse (or Scan or View-Only) view (Fig. 1) and the 
Data Entry (or Edit) view (Fig. 2) illustrate two types of views. These text-only examples 
illustrate two important ideas: ‘field’ and ‘record’. The highlighted rectangular region in 
Fig. 1 and the entire view in Fig. 2 pertain to a single bibliographic citation. That 
information, including the other aspects of that citation not visible in either view, 
constitute a Record. The related, but separately stored elements such as the names of authors 
and journal title, are Fields. The fields collectively form the record, the fundamental 
organizational unit in DP. Fields and Records are key concepts for the following discussion.
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An entire menu is devoted to record management—adding, removing, modifying, locating, 
grouping, searching, sorting, and removing duplicates. These tasks, however, use the 
structure provided by the fields and contents of the fields. The internal structure provided 
by the fields makes possible some very powerful and useful commands.

When you double-click the DiscoverPro icon , a menu bar appears, but no database file 
opens automatically. When you open a database file, either a Browse view or a Data Entry 
view appears, depending upon the previously established user preference. 

•To switch from a Browse view of a record (Fig. 1) to a Data Entry view: 
double-click on a record.

• To switch from the Data Entry view of a record (Fig. 2) to the Browse view:
 click the  button.

The Browse view (Fig. 1) displays all or part of multiple records of one or more lines in a 
view-only manner. 

In contrast, the Data Entry view shows all or part of a single, editable record. 

Figure 1 The Browse (Scan) View
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To scroll to a different record in the Browse view, drag the vertical scroll bar. As you scroll, 
DP updates the record at the top of the scroll window to indicate the approximate position 
within the sorted database.

To scroll to a different record in the Data Entry view (Fig. 2) , click the arrow icons 
 

for first, next, previous, or last record, respectively, or drag the horizontal scroll icon to the 
relative number of the record.

In our discussion of the Formats menu later in this chapter, you will learn how to choose 
the particular records and their sequence for these two types of views (and for the Import 
and Export windows).

Figure 2 The Data Entry (Edit) view

The structure of the database file is contained in the Tag file optionally named at the base of 
the Data Entry view. When you transfer a database file to another computer, you must 
transfer its companion Tag file too. Otherwise, the field names and the formatting 
information is unavailable. Without its companion tag file, you can open a database file, but 
not edit it.

DiscoverPro is disk-based, i.e., only the active record must be memory-resident. 
Consequently, the allowable file size is determined by the available disk storage; the number 
of records is arbitrarily restricted to 65,535 records (although a simple recompilation using a 

DiscoverPro  4.3 
  



long integer for file indexing would allow DP to handle millions of records). Except for 
sorting and indexing, RAM requirements do not depend upon the size of the database. DP 
automatically saves either when you either scroll to another record or when you leave the 
Data Entry view.

Part I: Menus for Managing the Database

There is a common main menu (Fig. 3) for the Browse and Data Entry views, but special 
purpose menus appear when you select a picture, sound, movie, or Document field in the 
Data Entry view. 

Figure 3 Main menu

The leftmost (or Apple) menu (Fig. 4) always provides information about the application, 
including the copyright and other credits (Fig. 5).

Copyright notice
& splash screen

Figure 4 Apple menu (first entry only)

Figure 5 About DiscoverPro dialog box
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File Menu
The second menu (Fig. 6) is also common to all applications: it provides the standard file 
management commands for creating and opening files, reading and writing files for data 
exchange with other applications, file maintenance commands (compact, repair, change tag 
file) and configuration defaults, printing, and quit commands.

Create a new database, tag or export file
Open a database, styled (formatted) text, or text file
Close the active window

Manually compress the database file (cf. Preferences)

Read a file (text, picture, sound, movie)
Create output window or file (display/print/file)

Establish printer and paper specifications
Print (individual records, formatted export files, etc.)

Establish operating defaults

Terminate session

Select a different file structure/format file for database

Rebuild a corrupted database file

Figure 6 File menu for Browse and Edit views

There is no ‘Save’ command (Fig. 6). DP automatically saves edited records when you 
change records. Optionally, you can require a user-confirmation before each record save 
operation. 

New... (  N) The New command dialog (Fig. 7) creates new files of three types: Database, 
Tag, and Export (styled text and plain text) files (Fig. 8). To create a database file you must 
first select an existing tag file from the pop-up menu (such as ‘Bibliographic Database’ in 
Fig. 9) to define the file’s structure. The name of the tag file thereafter remains associated 
with the database file, and DP accesses that tag file automatically whenever you open the 
database file. As a corollary, a copy of that tag file must accompany the database when you 
relocate it to a different computer. 
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Figure 7 New dialog box

Figure 8 Some file icons

If you relocate the database and tag files, DP prompts you to supply the path name of the tag 
file implicitly by selecting it using the standard directory navigation techniques. To assign a 
tag file manually to the active database, use the Assign Database Type on the File menu. A 
single tag file can be associated with multiple database files. Separate icons (Fig. 8) identify 
the database, tag, styled text, and plain text files.

If the tag files in the pop-up list (Fig. 9) are unsuitable, create a tag file using the Tags File 
option (Fig. 7), as described in Part II of this chapter. We include only a brief discussion here 
to facilitate the discussion of the other features.

Figure 9 Pop-up list of currently available tag files
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To illustrate a tag file, a small portion of the Bibliographic Database file (Fig. 11) used by the 
USMARC system is shown in Fig. 10. This comprehensive list of potential field names 
encompasses the full range of citations used by the U.S. Library of Congress. There are ten 
logical groups of tags (0XX, 1XX, through 9XX). Click on the triangles near the tags to expand 
or to collapse these ten lists in a manner analogous to the Finder’s handling of files. The tags 
are identified by a three digit number (the first digit identifies the logical grouping); a formal 
name; and a shorter, familiar name. 

Tags identify the fields. In the Data Entry view (Fig. 2) the informal name always appears 
near the field contents. The Show/Hide Tags command of the Edit menu controls the 
appearance of the tag number next to the informal field name. The Show/Hide Field 
Description command, also on the Edit menu, controls the display of the formal (extended) 
field name at the bottom of the Data Entry view, as well as the tag file name. The formal 
name identifies the currently selected field which is surrounded by a dotted rectangle, 
(Fig. 2). A special menu applicable to the selected field and its type appears automatically in 
the menu bar.

Subfields, identified by lowercase letters in Fig. 10, provide one additional level of structure 
for related fields. DP’s special formatting allows you to include or to exclude these subfields 
in the output. A complete listing of a bibliographic tag file is included in the Appendix. The 
tag file is a composite of all fields used in the database. Actual records use subsets of these 
fields. For example, citations of books, journal articles, and maps require different 
combinations of these fields. These user-defined, named combinations of field tags are called 
Record Types (Fig. 11). The names of these combinations are assigned in the Tag Edit 
window (as discussed in the Appendix), but you assign the choice of fields and formatting 
using the Formats menu, as discussed later in this chapter.

Export File: Choosing Export Format (Fig. 7) creates a word processor-like window for 
formatted text. You can save a text document created here, open it later within DP, modify it, 
and print it. You can save the Export window as plain text to be read by TeachText or any 
word processor.
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Figure 10 Bibliographic Tag File

Figure 11 Record Types for Bibliographic Database tags
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To add records to a new database, you must use the New Record command of the Records 
menu where you create a record template in the Data Entry view. You must also select an 
appropriate data entry format from the bottom portion of the Formats menu. If you have 
not defined any Data Entry formats for this tag file, DP uses the ‘Tagged Format’ default; but 
since no fields of a new record contain any data, the screen is blank. If no formats are 
available, you must use the Data Entry command (second on the Formats menu) to define at 
least one. Data entry techniques are discussed in the next section on opening an existing 
database.

Figure 12 A New Database

Open... (  O) 

The Open command provides access to three types of files (Fig. 13): database, styled text (a file 
used by DiscoverPro to preserve formatting), and a general-purpose text-only file that word 
processors and other applications can read. Only folders and the files belonging to the 
categories checked appear in the list. The usual Macintosh file navigation controls are 
available.

Database Files: When you open a database file, you encounter either a Browse view (Fig. 1) 
or a Data Entry view (Fig. 2) according to the Preferences you set in Preferences on the File 
menu. Because of the considerable user control over formats, the views can differ markedly 
from these examples. For example, all of the Browse mini windows might be closed. In that 
case you will see the ‘All Records’ and eight folders that store subsets of records of the 
database (Fig. 12). Double-click any combination of these nine icons to open their associated 
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mini windows. Fig. 14 shows the set folders and two open mini windows representing two 
different sets of records displayed using two different Browse formats. 

Records are displayed individually in the Data Entry view. As you did with the Browse 
view, choose one of the user-defined Data Entry formats appropriate to your needs. The 
Tagged Format default displays only the non-empty fields. The Data Entry view is the 
simplest of the four views because the text attributes (font, font size, and font style) are 
common throughout. Use the Preferences command on the File menu to assign the default 
font and font size for the Edit view. However, you can reassign different text attributes to 
specific selections.

Figure 13 Open dialog box
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Figure 14 Another Browse View Example

To enter data in a field (Fig. 15), click in the Data Entry view to the right of the vertical 
divider and on the same horizontal level as the field name and select the field. If necessary, 
adjust the choice of field type using the Field Type: pop-up menu. The field type designation 
also places a support menu of the corresponding type on the menu bar. For a text field, the 
field expands vertically, as necessary, to store up to 32K of data. Automatic word wrap is 
supported. You can import text, picture, sound, and movies from a file or paste them into a 
field. If your Macintosh is properly equipped, you can record sound and the data in the 
database or in another file. Movies are always stored separately. Refer to Chapter 3 for 
additional details.
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Figure 15 Sample Bibliographic Record

To satisfy the various, commonly used, stylistic preferences, DP provides extensive 
formatting for name fields. For example, you can store an author name in a standard ‘Last, 
First Middle’ format and automatically generate all the other commonly used forms from 
that standard form. When you must use the same citations in papers for different journals, 
DP handles this re-formatting chore for you. To use this feature you explicitly designate the 
name field for this special treatment in the tag file as discussed in Part II. Of course, you can 
store names in any field without this special designation for the tag, but in that case DP 
cannot perform tasks such as reversing the last and first name of the first or other authors or 
replacing the first and middle names with initials (with or without periods) during output.

Styled Text Files: You can open styled text files here and with the Export command on the 
File menu.

Text Files: Rather than containing font attribute (font, size, style) information, text files 
contain just plain text which can be used by all word processors as well as by many other 
applications. 
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Close (  W) 

You can have an unlimited number of windows open simultaneously. Use the Close 
command or the close box in the top-left corner of the window to close the frontmost 
window, i.e., the one with the lines in the title bar. If you have modified any associated 
windows, such as Export or Data Entry, since their last save, DP prompts you to save data 
that would otherwise be lost.

Import... 
In addition to the creation of records individually, DiscoverPro creates records from text1 
files—whether they originated from a word processor file, originated from compact disks, or 
were created automatically by other applications such as on-line searches of a bibliographic 
database. This feature, often provided in a separate application, is one of DP’s most powerful 
and important features. DP imports records having tagged, character delimited (e.g., tab 
character), and fixed length fields. Tab-delimiters are a simple, widely used format for data 
interchange for personal computer software. Another very general format, USMARC, is 
used by the United States Library of Congress for its machine-readable records; each file is 
identified individually and unambiguously by a name, i.e., a tag. DiscoverPro supports this 
broad spectrum of formats, including USMARC. Using DiscoverPro’s graphical interface, 
you can create, name, and reuse user-defined, import formats.

We illustrate the import process for four different record organizations (USMARC, Tagged, 
Tab Delimited, and Fixed Length) using the record shown in Fig. 15. This same record is 
illustrates the export process also. The citation shows DP’s preferred method for handling 
multiple authors, i.e., one field per author.

You could manually enter the sample journal article citation in Fig. 15, as discussed in 
connection with the Edit menu, but the power of DP lies in its import capabilities. DP can 
read records organized according to four standard methods. Professional librarians use the 
USMARC Formatted Dump record (Fig. 16). (We have used nonstandard tag numbers in 
this example). However, the information in the machine readable USMARC record, 
including unprintable characters, is more forbidding to mere mortals, as illustrated in 
Fig. 17.

Commercial bibliographic services use the tagged fields (Fig. 18) to distribute their records. A 
short descriptor precedes and identifies each field. The fields can appear in any order and 
any unneeded fields can be omitted. DP assumes that each field begins a new line, and the 
entire file terminates with two returns. 
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Figure 16 USMARC Formatted Record

Figure 17 USMARC (Machine-readable) Record
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Figure 18 Tagged Record

Microcomputer software such as spreadsheets and bibliographic applications often use tab or 
comma delimited fields (Fig. 19). This organization is simple and convenient if relatively 
few records are involved. However, a missing or an extra delimiter can result in a mismatch 
between fields and the data. An extra author field or a delimiter unintentionally embedded 
within a field can create havoc. The delimiter must not inadvertently appear within a field.

Figure 19 Tab Delimited Record

General purpose databases often use fixed length fields (Fig. 20), but this form is poorly 
suited for bibliographic records. The number of authors varies, as does the length of the 
names, title, abstract, and other fields. The handling of abstracts is especially awkward 
because when the length of the fields is fixed, either the truncation of content or needlessly 
wasted storage space results.

Figure 20 Fixed Length Record

We shall now examine the import process for each of the four formats illustrated 
in Fig. 17 through Fig. 20.

Choose the Import command on the File menu when in Browse view; the import dialog 
(Fig. 21) appears. Use pop-up menus to select an existing import format, the destination of 
the records (Fig. 22), and whether the new records are to replace or to be appended to an 
existing database file. The usual file navigational options are provided. The New Format 
and Open Format buttons provide access to an interactive import window in which you can 
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adapt the import format to match the organization of the input records. The process is 
detailed in Chapter 3.

Figure 21 The Import dialog box

The Format pop-up (Fig. 22) permits you to choose a format previously defined. The Import 
Into option allows you to direct the records to the main database and, optionally, into one of 
eight folders. Because DP supports a simple ‘drag and drop’ process for copying records from 
one open database into another, you ordinarily should import records into an empty 
database. However, if you import the records into a set folder, you can delete them easily 
from the set by dragging; use option-drag to delete the records from both the set and from 
All Records (i,e, from the database). Use these sets to group records that you want to search, 
sort, or print. To transfer records (or more specifically, pointers to records) manually, drag 
the record images among the folders.

    
Figure 22 Import format and destination folders within a file
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Suppose we wish to import the data for the record shown in Fig. 15.

To import USMARC records:

• Open a database file or, preferably, create a new database file having an appropriate tag file.

• Select USMARC from the Format pop-up (Fig. 21 and Fig. 22).

• Select the import file.

• Click Import.

The format for USMARC records is standardized and built into DP, but you must define the 
other formats before you can import records. In the following three examples, we previously 
defined the format. In Chapter 3 we illustrated the technique for interactively defining the 
import templates.

To import tagged records:

• Open a database file or, preferably, create a new database file having an appropriate tag file.

• Select Tag Import Format from the Format pop-up (Fig. 21 and Fig. 22).

• Select the import file (Fig. 18).

• Click the Open Format button.

Fig. 23 displays an import window for a tagged record with Record Organization as Tagged, 
the Default Record Type, the record terminator (or separator), and a field terminator. 

The tagged field import window (Fig. 23) now contains the names of the fields you selected 
to receive data. Place the names in the window by dragging the field labels from the 
Abbreviations window. The order of the fields in the list is immaterial, but you can 
rearrange the order by dragging. DP has added the tag name associated with each field. The 
maximum tag length is 15 characters; you can drag the vertical divider horizontally, if 
necessary. The import preview window displays the assignment of the data from the first 
record to the tagged fields. To preview another record, click on the arrows at the bottom 
right of the window. You can drag the divider between the tags and the data to adjust the 
widths, if necessary.

DiscoverPro supports subfields, so you can store the names of multiple authors separately. If 
you store names in separate fields and the tag file contains name information, DP provides 
extensive formatting control. However, you can store all the author names in a single field, 
but doing so denies you the automatic formatting support. When you select a field name, 
the subfields pop-up menu at the right of the window allows you to specify the disposition 
of the subfields of that field: Ignore, Remove, Change To Space, Split Into Separate Fields. In 
Fig. 23 the ‘Auth’ field is split into as many author fields as there are coauthors; only one is 
shown in the preview.
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Figure 23 Tag Import Format
After making any necessary adjustments and verifying the results, click the close box. You 
are asked whether you want to import the records.

To import delimited records:

• Open a database file or, preferably, create a new database file having an appropriate tag file.

• Select Tab Import Format from the Format pop-up (Fig. 21 and Fig. 22).

• Select the import file (Fig. 19).

• Click the Open Format button.

Fig. 24 displays the import window for a tab delimited record (Fig. 19). Note the choices 
selected for Record Organization (Delimited), the Default Record Type, the Field Delimiter, 
Field Enclosures, and the Subfield Marker. DP can use quote marks and double slashes as 
field enclosures and subfield markers, respectively.

The delimited field import window now contains the names of the fields to receive data. 
Place the field names in the window by dragging them from the Abbreviations window. The 
order of the fields must match the order of the fields of the records in the input file; you can 
drag the field names to rearrange their order, if necessary. 
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Figure 24 Delimited Import Window

The import preview window displays the assignment of the data from the first record to the 
designated fields. To preview another record, click on the horizontal arrows at the bottom 
right of the screen. You can drag the vertical divider between the field names and the data to 
set their widths, if necessary.

DiscoverPro supports subfields so you can store the names of multiple author separately. If 
you store names in separate fields and the tag file contains name information, DP provides 
extensive formatting control. You can store all the author names in a single field, but that 
does not give you the automatic formatting. When you select a field name, the subfields 
pop-up menu allows you to specify the disposition of the subfields of that field: Ignore, 
Remove, Change To Space, Split Into Separate Fields. 

• Click the close box after making any necessary adjustments and verifying the results. 

• You are asked whether to import the records.

To Import Fixed-Length Records:

• Open a database file or, preferably, create a new database file having an appropriate tag file.

• Select Fixed Length Import Format from the Format pop-up (Fig. 21 and Fig. 22).

• Select the import file (Fig. 21).
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• Click the Open Format button.

Figure 25 Fixed length record import

DP supports fixed-length files (Fig. 20), although they are infrequently used for bibliographic 
files (Fig. 25). Because DiscoverPro supports variable-length fields, you can strip any trailing 
spaces that pad the field in order to reduce storage size. Drag the names of the fields from the 
Fields window into the Import window. Assign the lengths of the fields in the first column, 
editing the default if necessary. Buttons at the bottom of the window allow you to insert the 
record type field and blank fields. Remember to include the record terminator character (e.g., 
carriage return) in the record length character count.

• Click the close box after making any necessary adjustments and verifying the results. 

Export... 
DiscoverPro can create complex formatted reports. With the exception of printing 
individual records in the Browse and Data Entry windows, you normally create and format 
output using the Export command which is available only in the Browse view. Then you 
route the output to a printer or a file. The Export dialog (Fig. 26) permits you to select the 
entire database, selected records, or folders of selected records (Fig. 28). You can send records 
to a window or to a file (Fig. 28). Designate an export format (Fig. 31) in the pop-up menu 
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before clicking the Export button. The italicized names are the defaults and cannot be 
modified or deleted; you can define the remainder of the formats in the list using the 
Format menu.

Figure 26 Export dialog box

The Export (Fig. 27) source of records includes those you have selected in either the Browse 
or Edit views, all records in the database file, or just those included with a set folder. The 
Send Records To option (Fig. 28) allows you to send the output to a currently open text or a 
styled text window. You can open such windows using the File menu’s New and Open 
commands or by the New Window choice on this pop-up. Choosing the New File option 
produces a file management dialog. The export file name you assigned appears adjacent to 
Send Records To. Use the associated pop-up (Fig. 29 and Fig. 30) to choose either a plain text 
file or Styled Text. Styled Text preserves assigned text format attributes (font, size, and style), 
and plain text does not. Plain text files can be read by other applications, but Styled Text can 
be read, edited, saved and printed only by DP. To export formatted files, use the Publish and 
Subscribe commands on the Edit menu of an Export window.  The content and formatting 
of the export output is governed by the Export Format (Fig. 31).

Figure 27 Export Source Group
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Figure 28 Send Records To options

Figure 29 File Output Choices

Figure 30 File type selection

Figure 31 Export format pop-up list

Use the Formats menu to define or to edit the formats listed here. For completeness we 
show the format windows used to export the tagged, delimited, and fixed-length exhibits 
displayed in the import examples above (Fig. 18 - Fig. 20). Refer to the discussion of the 
Export command of the Formats menu for details. You define a format for each record type 
in the list box.
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Figure 32 Tag Export Format Example
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Figure 33 Tab Delimited Export Format Example

Figure 34 Fixed-Length Format Example

You determine the tokens and their order when you drag the field name from the 
Abbreviations window. When you drag and drop a field name, it is automatically position 
at the insertion point. The  in the tagged window is an explicit command for a return 
(ASCII 13); an implicit word processor return would also serve this purpose. The arrow  in 

DiscoverPro  4.24 
  



the tab delimited window is an explicit tab. Using the menus, you assign the text attributes 
(font, size, and style) for the tokens and any text you type between the tokens (as in Fig. 32). 
The usual cut/copy/paste commands apply to the tokens as well as to the text. The pop-up 
menu on each field token provides commands for assigning field length and various field 
options, as described in the section about the Formats menu. 

Export Window Menus

A revised set of menus (Fig. 35) becomes available when you Export to a New Window. The 
File menu has the usual commands for creating, opening, closing, saving, page setup, and 
printing export files. The Edit menu provides the editing commands usually associated with 
a word processor. In fact, the Export window behaves as a simple word processor. The four 
Publish and Subscribe commands at the bottom of the Edit menu are available when you are 
using System 7. 

The Publish and Subscribe feature allows you to select all or part of the text in the Export 
window for sharing with another application compatible with this System 7 feature. After 
you select the text you want to publish, use the Create Publisher command to create an 
intermediate file called an ‘edition’. Optionally, a border in the Export window identifies text 
that has been published (Show/Hide Borders). Once published, another application 
compatible with System 7’s Publish and Subscribe can ‘Subscribe To’ the edition. DP adds the 
published text to the active document of the subscribing application. If you subsequently 
modify the published selection, you can manually or automatically update the changes to 
the edition (i.e., intermediate file) when you save the Export window. These Publisher 
Options (Fig. 36) become available when you place the insertion point within the published 
selection of the Export window.
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Figure 35 Export Window Menus

The Font, Size,  and Style menus apply character formatting in the customary manner. The 
Windows menu is described later in this Chapter.
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Figure 36 Publisher Options

 

Compact Database 
This command compresses the open database file by removing unused space; the command 
performs a function comparable to that in HyperCard. Using the Preferences command 
discussed in the next section you can specify either manual or automatic file compaction.

Preferences...
You can prescribe several startup options: record saving, file compacting, startup window, 
the default font for the Data Entry view, and choice of screens. In particular, click Save 
When Finished Editing to save the files as you leave the Data Entry view. Click Save After 
Editing Each Record to save each record as you leave it. The former is faster; the latter more 
secure. Click Compact Manually to save disk space when you are not actively entering data, 
but click Compact After Editing to have this performed when you complete a record. Choose 
In Browse Mode or In Edit Mode to designate the view you want to appear as you open the 
database. You edit data only from the Data Entry view, but you perform most information 
retrieval and record import activities from the Browse view. If you elect to open a database 
in the Data Entry view, you can also designate a specific folder of records for editing (Fig. 38). 
In contrast with the Browse view, the Data Entry view displays the text fields of records with 
a common font and font size. Establish your text preferences here (Fig. 38). You can use the 
Text menu to over-ride the default for specific selections. 

DP saves the information in the Preferences window in each database file, and also in the 
Prefs file. When you create a new database file, DP pulls this information out of the Prefs file 
and copies it into the new database file. You can use the ‘Set Default’ and ‘Use Defaults’ 
buttons to copy the contents of the Prefs file to the current database file, and vice versa.
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Figure 37 Preferences Dialog

  
Figure 38 Preferences pop-up menus
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Assign Database Type...
The Assign Database Type command (Fig. 39) allows you to assign a different tag file to the 
current database. The tag file supplies the names of the fields and stores the various 
formatting definitions for browsing, editing, importing and exporting files; stores the named 
search sets and named sort sets; etc. Reassigning tag files should be done with caution. 

If you move your database from one environment into another, you can lose the path link 
between the database and tag file. If you fail to locate the correct tag file when you open the 
database, you can open the file, but not edit it. Use the pop-up list (Fig. 40) to select one of the 
tag files already known to DP or use the Locate Other button to link to a tag file (Fig. 41) not 
located within the folder.

Figure 39 Assign Database Type Dialog

 
Figure 40 Pop-up of Known Tag file

Figure 41 Tag File Locator 
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Page Setup... 
The page setup dialog box is the familiar word processor dialog (Fig. 42a). The form and 
contents of this dialog are affected by your choice of printer in the Chooser command of the 
Apple menu.

Figure 42a ImageWriter Page Setup

Figure 42b StyleWriter Page Setup

Figure 42c LaserWriter Page Setup

The LaserWriter Page Setup dialog provides several additional printing options. If you 
change your printer choice using Chooser on the  menu, use the Page Setup command 
before using the Print command.
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Figure 42d Additional LaserWriter Options

Print... (  P) 

The print dialog box varies slightly according to the choice of printer and active window; the 
options resemble the standard word processor print dialogs.

.
Figure 43a ImageWriter Browse/Edit Print Dialog
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Figure 43b StyleWriter Browse/Edit Print Dialog

Figure 43c LaserWriter Browse/Edit Print Dialog
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Figure 43d LaserWriter Export Print dialog

Repair...
A database file frequently contains data accumulated and used over an extended time. 
Prudence requires you to make backup copies regularly and to make changes to its structure 
cautiously. A database file can be damaged by faulty or misused recording media, power fai-
lure, user error, etc. The Repair command (Fig. 44) can sometimes recover a damaged file. A 
file being repaired must not be active (open), and you must designate the tag file associated 
with it. This can be a slow process because DP must read every record and repair damaged 
ones. Be patient. Note: Records you have deleted, but not obliterated by compaction, will be 
recovered.

Figure 44 Repair Dialog

Quit (  Q) 

This command reminds you to save work in progress, closes all windows, and quits.
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The Edit Menu

This menu resembles a word processor Edit menu; the commands associated with editing 
are also typically grouped in the third menu. Remember the standard operating procedure 
for the Macintosh that applies here — make a selection first and then choose a command 
applicable to that selection. DiscoverPro supports the usual undo, cut, copy, paste, clear, and 
select all commands. A generalized find and replace command is a powerful database 
maintenance tool. Three commands adjust screen utilization, i.e., modify the amount of 
displayed information in the Data Entry view. The last command provides an optional 
warning if you have modified the record being saved.

Undo the last operation

Remove selected object to Clipboard
Reproduce selected object to Clipboard
Copy Clipboard object at Insertion Point
Remove selected object; Clipboard unaffected
Select all objects in active window

Global/Field find and replace

Show/Hide Tag numbering
Show/Hide Complete Field & Tag Info.

Deselect all records in Browse view

Preserve same fields in Edit view
Warn of all record modifications

Figure 45 The Edit Menu

Undo (  Z)

You can undo most of the immediately previous commands with the Undo command. 
Global find and replace is a notable exception, so save a duplicate copy of the database before 
you use Find/Replace.

Cut (  X)

Cut removes the current selection and places a copy of it on the clipboard for subsequent 
pasting.
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Copy ( C)

Copy places a copy of the current selection on the clipboard for subsequent pasting but does 
not remove the original selection.

Paste, Paste Text, Paste Picture, etc. ( V) 

The paste command has several variants depending upon the contents of the clipboard. 
This command becomes Paste Text when you want to paste text, Paste Picture when you 
want to paste a picture, etc. When you click one of the Paste commands, DP inserts the 
clipboard contents at the position of the insertion point. The field type (text, picture, sound, 
or movie) of an empty field changes to match the contents of the clipboard. If the field is not 
empty, DP issues a warning if the existing data in the field is of a different field type from 
that being pasted. A DP field cannot contain a combination of text, picture, sound, or movie, 
but each DP record can contain any combination of fields and field types.

Clear
Clear removes the current selection without saving a copy to the clipboard, i.e., the 
equivalent of the delete key. This command is especially useful for removing large 
selections when memory or disk space is limiting. The Undo command can recover the 
removed selection if you use it as the next command.

Select All (  A)

This command selects all the objects or text within the scope of the insertion point.

Find/Replace... (  F) 

DP’s Find/Replace is a powerful maintenance tool. The menu bar (Fig. 46) changes to 
support these expanded features. Use this command to locate individual records that 
contain specific phrases and to replace globally any expressions within the selected set folder 
(Fig. 48). For example, you might replace the name of a journal with an abbreviation to 
reduce the size of a record. You can automatically replace the abbreviation with its expanded 
form during export. 

Because the search feature is much faster than the multi-featured Find/Replace feature, you 
might use Search to collect the records you want to modify in a set folder, select that folder 
using the Where menu, and then perform the replacement in either the Browse or Data 
Entry view. 

The Find/Replace command locates and replaces field-specific, embedded strings; leading, 
trailing or embedded spaces; wild cards; whole words; and case changes and matches. DP can 
even move the contents of one field to another.

DiscoverPro  4.35



The Find/Replace Menus

The menus added for Find/Replace (Fig. 46) are Method and Where. 

Figure 46 Find/Replace Menu

Figures Fig. 47a - Fig. 47d are the specialized Find/Replace menus.

Close the search window

Terminate the session

Figure 47a

 

The Edit 
commands 
are not 
available

Figure 47b

These commands change 
the scope of Find/Replace 
(and change the Dialog 
box options).

Figure 47c
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These 
choices 
affect the 
scope of 
the 
Find/Repl
ace 
command.

Figure 47d

Now let’s look at the three items on the Methods menu.

Method: Find/Replace Text

Find/Replace text (Fig. 48) corresponds most closely with the find/replace implemented in 
most word processors. If you are using All Fields, DP checks each record in the set designated 
in the Where menu for a match without restriction to specific fields. If you check Match 
Words, a match occurs only if the text string appears as a separate word. If you check Match 
Case, a match occurs only if the upper and lower case of the characters in the Find Text box 
match exactly. Eight wild cards (Fig. 49) are provided in the pop-up menu associated with 
the Find Text box. 

Wildcard 
pop-up 
menu

Figure 48 Find/Replace Text Dialog box
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Figure 49 Find Text wildcard tokens

In addition to finding matches, this command can also replace the located string with the 
text in Replace With. Two wild cards (Fig. 50) are provided for the replacement text when  
you click in that box—the selection you placed in the Find box and a specific character 
number within that selection.

Figure 50 Replace With wildcard tokens

For field-specific searches (Fig. 51), click Selected Fields and a list box appears; drag the 
name(s) of the search fields from the Fields Window into this Restrict Search To box.

Figure 51 Field-specific Text Find/Replace

Method: Find/Replace Text Patterns

The pattern matching feature (Fig. 52) allows you to change fields (or records) that are all 
uppercase or all lowercase to all lowercase or all uppercase, respectively, or to capitalize the 
first character in the field or the first character of each word (Fig. 53). Leading, trailing, or 
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embedded spaces can be replaced. For example, you can shorten records imported from a 
fixed-length format by stripping the trailing spaces (Fig. 54) in specific fields.

Figure 52 Find/Replace Text Patterns Dialog

Figure 53 Find/Replace text pattern choices

Figure 54 Field-specific replacement of trailing spaces
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Method: Find/Replace Fields

The Find/Replace Fields method cuts the field contents from one field and pastes it into 
another. 

If a global change in a field name would suffice, an alternative to this technique exists. If the 
current tag file is shared by other databases which you wish to leave unaffected, close DP and 
return to the Finder to make a duplicate of the tag file. When you return to DP, use the 
Assign Database Type command to assign the duplicate tag file to the database. Finally select 
the name of the duplicate tag file from the Windows menu and edit the field name in the 
tag file. The details of this process are found in Chapter 3.

Figure 55 Find/Replace (Switch field contents to another field)

Figure 56 Pop-up for handling multiple occurrences of a field

The Find/Replace requires that records be located, decompressed, modified, and stored 
again; consequently, this can be a time-intensive operation. One way to shorten the time is 
to limit the effect of this operation to sets of user-selected records if you place the records in a 
set folder and use the Where menu to limit its scope. The Search command is much faster 
than the Find/Replace command. Therefore, if you need to change only a few records in the 
entire database, move those records into a set folder using the search command and then 
limit the changes to that set using the Where menu.

Return now to the Edit menu commands.
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Show/Hide Tags 
By clicking this command you toggle between show and hide. If the command says Hide 
Tags, the fields in the Data Entry view are identified by labels at the left margin of the Data 
Entry view. You can hide these tag numbers (Fig. 57) to increase the screen area available to 
data display. These numbers are especially useful when you deal with complex structures 
such as allowed by the USMARC system. 

Figure 57 Show/Hide Tags

Show/Hide Field Description 
By clicking this command you toggle between show and hide. If the command says Hide 
Field Description, each field displayed in the Data Entry view is identified by a familiar 
name at the left margin of the Data Entry view. In addition, when you select a field in the 
Data Entry view, DP displays the more complete, formal name of that field at the bottom of 
the Data Entry view (Fig. 58) just above the name of the tag file.

Figure 58 Field Description

Maintain Scroll Position
When the entire record is larger than the screen, Maintain Scroll Position preserves the 
vertical scroll position within the Data Entry view as you change records. If this command is 
not checked, vertical scroll automatically reverts to the top of the next record. As discussed 
later, an alternative approach is to display the fields of greatest interest at the top of the 
record view using the Formats menu.

Confirm Changes
When you enable Confirm Changes, DP awaits confirmation before saving a revised record. 
This is especially useful when you are editing an established database and must guard 
against unintended changes. If you want no changes to the database file whatsoever, check 
the pencil icon (Fig. 58) at the bottom of the Data Entry view to write-protect the database. In 
addition, the file locking feature of the Finder that is available from the Get Info command 
also prevents unintentional modifications.
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The Records Menu

The Records menu provides the primary tools for managing records. These commands 
create, remove, edit, locate, sequence the display order, and group records; create a list terms 
for rapid searches; and manipulate folders. 

Add a new blank record
Delete Record(s)
Remove a record from a set folder
Open edit view for selected record

Go to the first record
Go to the immediately previous record
Go to the immediately following record
Go to the last record
Go to a specific record number

Search all fields of all records
Boolean searches
Sort on any number of fields
Create index for rapid searches
Locate and remove duplicate records

Keyboard control 
of folders

Figure 59 The Records menu

New Record (  R)

Use this command from either the Browse or Data Entry view to create a blank record in the 
Data Entry view. DP stores the name of the last used of each format type (Browse, Data Entry, 
Import, and Export)in the Tag file and uses it unless this is the first usage of the tag file. If 
the new record is the first usage of a new tag file, the database contains no data, so it uses the 
default ‘Tagged Format’. The Tagged Format displays only non-empty fields and their field 
names. Hence, a new record appears as an empty window with this format. In this case you 
must select one of the formats listed in the lower portion of the Formats menu or create one 
using the Edit command in the top portion of the Formats menu before you can enter any 
data. Each DiscoverPro format specifies a combination of fields and their order.
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Record Type Field Type

Choice of fields and their sequence is established 
using the Data Entry command on the Format menu.

Theses fields are a subset of the fields in the Tag file.

Figure 60 A new record

To enter data you must select a Record Type appropriate to the new record from the pop-up 
menu in the record header. Each record type contains a relevant subset of the field names 
from the tag file that characterize that record type. You assign these using the Data Entry 
command on the Formats menu. Click within a field to select the field and assign the Field 
Type (Text, Picture, Sound, or Movie) from the other pop-up menu in the record header. A 
record can contain any combination of field types, but each field contains only  text, picture, 
sound, or movie - not a combination of any of these. When you select a field, an additional 
menu appropriate to its field type appears on the menu bar to the right of the Windows 
menu. DP automatically stores a record either when you leave the record or when you end 
the editing session, whichever you specify using the Preferences command. 

For each of the following, we assume that you have selected a field and assigned a field type. 
The field type of an empty field changes automatically to match the contents of the 
clipboard. A new record can store text, picture, sound, movie and document pointer fields in 
any combination. Let’s consider each of these types.

Text Field

A text field can hold up to 32K. The contents can be typed, pasted from the clipboard, or 
imported from a text file using the File menu command. The text field (Fig. 61) supports 
word-wrap and character level styling attributes (size, style, and font). The default (No Text 
Style Info) stores more compactly, of course.
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Figure 61 Text Menu for Edit View

Picture Field

A picture field holds PICT graphics (Fig. 62). The contents can be pasted from the clipboard 
or imported as a Picture File using the File menu command. 

Picture zoom icon

Figure 62 Picture Field

The Picture menu (Fig. 63) controls the display size of the picture. The zoom icon that 
appears in the top right corner of a selected picture field (Fig. 62) provides the same control, 
as do the keyboard equivalents of the Full Size and Thumbnail commands. 

The Line Height pop-up menu in the Browse Format window controls the picture display 
size for the Browse view. In the Data Entry view additional size control is afforded by the 
Open Picture Window command which displays the picture in a floating, re-sizable 
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window. If the image is larger than the floating window, use the scroll bars or the keyboard 
equivalents ( ←,   →, ↑,  ↓) to scroll the image within the window (Fig. 64).

Display picture at 100% size
Display picture at reduced size

Move picture into a moveable, 
resizeable floating window
Adjust display size

Figure 63 Picture menu for Edit view 

Key Scroll Witnin Frame Equivalent 

 ← Scroll left 

 → Scroll right 

 ↑ Scroll up

 ↓ Scroll down

 opt ← Scroll left one window width

 opt → Scroll right one window width

 opt ↑ Scroll up one window height page up

 opt ↓ Scroll down one window height page down

home Top of page

end Bottom of page

Figure 64 Floating picture window controls

Sound Field

A sound field is identified by playback icons (Fig. 65). When you select the field, the Sound 
menu (Fig. 66) appears; and a dotted rectangle borders the field. The field icons provide an 
alternative to the Play and Stop menu commands and their keyboard equivalents. You can 
paste Macintosh supported sound resource into the field, import it using the File menu, or 
record it. DP supports Macintosh, AIFF , and AIFC files.

Figure 65 A sound field when selected
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Play the sound recording in the selected field.
Terminate playback.

Record sound of quality and to destination set below.
Quality (Good, Better, Best)
Destination (database or separate file)

Figure 66 Sound menu for Edit view

If your Macintosh is equipped with a microphone, the Record command is enabled. Before 
using it, set the Recording Quality (Fig. 68) and choose the desired destination with Record 
To (Fig. 69). If you elected to store the recording in a separate file, when you choose the 
Record command, DP asks you to name a file. The recording control panel (Fig. 67) appears.

Figure 67 Control panel for recording

Figure 68 Recording Quality submenu

Figure 69 Record To submenu

Movie Field

When you select a movie field, a dotted rectangle borders the field identified by an icon 
(Fig. 70) and a Movie field (Fig. 71). You can import the field contents using the Import 
Movie command on the File menu. Actually, DP establishes a pointer to the movie, that is 
stored separately in a MooV file.

Figure 70 Icon for an empty movie field
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Figure 71 Movie field and icon

A movie is identified in the database by a representative frame, the Poster Frame. A movie 
clip icon superimposed on the frame (Fig. 71) identifies this as a movie. When you select the 
field, a control bar (Fig. 72) and the Movie menu (Fig. 73) appear. You can control the movie 
playback from either. If you prefer, transfer the movie into its own floating, re-sizable 
window with its own control bar (Fig. 72). You can set the size using its resize box or by 
using the Size submenu (Fig. 74). The Movie menu provides commands to play, stop, 
single-step backward and forward, and rewind the movie as well as keyboard equivalents 
that duplicate those of the control bar. In addition, you can repeat the movie indefinitely as 
an endless loop or repeatedly play it forward and backward. You can select a frame to 
represent the movie and can go immediately to that picture.

Figure 72 Movie Poster Frame
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Play movie
Stop movie
Go to previous frame
Go to next frame
Go to first frame

Play repeatedly
Play forward then
 backward repeatedly
Play asynchronously

Display in floating window
Set display size
Print movie frames

Establish startup frame
Go to startup frame

Figure 73 Movie menu for Edit view

Figure 74 Set movie frame scale

The term ‘movie’ also applies to sequences of engineering images (Fig. 75). An exciting 
application of this QuickTime movie capability is the storage and display of each page of a 
complete manuscript as a movie frame; see Chapter 3 for additional details. You need 
additional keyboard controls to single-step through the frames, i.e., pages, of a manuscript 
(Fig. 76).
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Figure 75 An engineering movie

Key Action

← Backward one frame (same as -)

opt ← Backward one frame &  scroll to bottom

 ← Scroll left (same as left scroll bar arrow)

 opt ← Scroll left one window width

→ Forward one frame (same as =)

opt → Forward one frame & scroll to top

 → Scroll right (same as right scroll bar arrow)

 opt → Scroll right one window width

↑ Rewind movie (same as 0)

 ↑ Scroll up (same as up scroll bar arrow)

 opt ↑ Scroll up one window height (same as page up)

↓ Play/Stop (same as <spacebar> & .)

 ↓ Scroll down (same as down scroll bar arrow)

 opt ↓ Scroll down one window height (same as page down)

Figure 76 Paging controls for an electronic manuscript movie

When you leave a record (unless you choose Cancel Record), DP stores the record. The 
number of the record is the number of its relative position in the current sort order of all 
the records in both Browse and Data Entry views. If you remove a record, the number of all 
records with a higher number adjusts downward. Each record also has a unique absolute 
record number based upon the internal clock when you create the record. 

Delete Record(s)
To remove a record, select it in either the Browse or the Data Entry view and choose the 
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Delete Record command. Because you cannot undo this operation, a warning message 
appears. You can select and delete multiple records in the Browse view. To select a 
contiguous range, click to select a record at one extremity of the range and press and hold the 
shift key and click the record at the other end of the range. To select multiple, non-
contiguous records, press and hold the command () key and click them. An equivalent 
warning message results if you drag a record or selection of records from the All Records 
category outside the boundary of the database view or into the title bar. Then DP warns you 
that data will be permanently lost. 

The drag and drop technique simply removes a record from a set folder, but not from the 
database unless you also press and hold the option key as you drag the selection outside the 
window. Otherwise, DP deletes the record from the set folder only.

Remove Record From Set 
You can save eight distinct sets or groups of records in the Set Folders (Fig. 77). Store records 
(or more precisely, pointers to records) in these folders by dragging the records from the 
Browse view or from other set folders. In addition, the search and sort commands can use 
these sets, as can the import and export commands. Unlike Delete Record discussed above, 
this command only removes a selected record from the set folder, not from All Records, i.e., 
not from the entire database.

Figure 77 Set folders

Edit Record (  E)

This command, equivalent to double-clicking a record in the Browse view, provides 
keyboard control for switching to the Data Entry view. Select a record in the Browse view 
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(using command and 1, 2, 3, 4 or ←, ↓, ↑, →) to move to the first, next, previous, or last 
record, respectively, or use the scroll bars) and then use  E to view that record in the Data 
Entry view. To return to the Browse view, click the End Editing button, not  the database 
close box.

First (  1)   

Use the First command with either the Browse or the Data Entry view to select the first 
record using the current sort order. In the Data Entry view the same function is provided by 
the first record icon.

Previous (  2)    

Use the Previous command with either the Browse or the Data Entry view to select the 
immediately previous record in the current sort order. In the Data Entry view the same 
function is provided by the previous record icon.

Next (  3)    

Use the Next command with either the Browse or the Data Entry view to select the record 
immediately following the current record in the current sort order. In the Data Entry view 
the same function is provided by the next record icon.

Last (  4)    

Use the Last command with either the Browse or the Data Entry view to select the last 
record in the current sort order. In the Data Entry view the same function is provided by the 
last record icon.

Go To Record...     
The Go To Record command provides direct access to any record by its record number. 
Either choose the Go To Record command or double-click the record number above the 
record scroll bar in the Data Entry view to obtain a dialog (Fig. 78).

Figure 78 Go To Record dialog

Simple Search... (  S)

When you are working with a large database, paging through the records manually to find 
particular records is too slow. Two search commands provide an effective alternative to find 
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records. Searches are performed in the Browse view. A simple search (Fig. 79) is often 
sufficient for finding records that contain user-specified text strings. DP’s simple searches 
examine all fields in all records in the database to locate records that contain any of the one, 
two, or three search strings provided, regardless of case, whole word, or field. The mini 
windows for all the set folders close after a search when DP locates records to avoid 
confusion caused by a cluttered screen.

Upon completion of the search, DP reports the number of records having at least one of the 
strings and then opens the All Records set in the Browse view with the ‘hits’ selected, i.e., 
highlighted. The first selection in the database appears in the Browse view. You can scroll 
through the highlighted selections embedded within All Records or drag the selected 
records into a set folder set (Fig. 77) for further examination in Browse and/or Data Entry 
view(s). 

Figure 79 Simple Search Window

Search... (  L) 

DiscoverPro provides a graphical interface for forming syntactically correct, complex 
Boolean searches while the Browse view is active. The search window (Fig. 80) can include 
an arbitrary number of conditions which a record must satisfy to be selected. You form each 
condition within a ‘tile’ in the Search window that contains a double-headed up and down 
arrow. Fig. 80 contains three tiles The first applies a condition to the record without regard 
to any specific field, and the second and third apply conditions that are field-specific. The 
conditional divider (the thick horizontal line immediately below the first tile) is also treated 
as a tile. 
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Figure 80 Search window

You can change the search criteria by dragging the double-headed arrow on the tile(s) and 
conditional divider(s) to reposition their vertical order. The Boolean algebra expression 
equivalent to the meaning conveyed by the tiles is formed automatically at the left of the 
scrollable Tile window. 

The conditional divider command (Fig. 80) creates groupings for the Boolean logical ‘and’ 
and ‘or’. The implied parentheses, shown in the left margin of the Search Dialog window, 
group all the tiles between the conditional dividers. All the tiles within such a group are 
connected by either ‘or’ or ‘and’, depending upon the choice you set using the pop-up menu 
on the divider. Use of the pop-up on the conditional divider switches every ‘and’ to ‘or’, and 
‘or’ to ‘and’. 

In general, the search expressions can have either the form [(tile1 OR tile2 OR...) AND (tile3 
OR tile4 OR ...) AND ... ] or the form [(tile1 AND tile2 AND ...) OR (tile3 AND tile4 AND ...) 
OR ... ]. The pop-up moves on the conditional divider instantly makes this swap. This 
format supports the simplest form, a single condition tile, to the most complex combination 
of tiles.

The Simple Search (Fig. 79), for example, can be formed here as follows (Fig. 81):

• To remove all tiles quickly, create and name a new search set (Fig. 85). At least one 
conditional divider must remain—even if nothing follows it. 

• Place tiles and conditional dividers in the Search window to form search conditions. 
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Select field independent attributes and the conditional dividers from the Tiles 
menu (Fig. 89). We note in passing that you form field-specific conditions by 
dragging the field names from the Fields window and dropping them into the 
Search scrollable list. 

In this example, choose Record Contents from the Tiles menu.

The attributes for tiles are listed in Fig. 82, and the operators are listed in Fig. 83.

To remove an unneeded tile, select its double-headed vertical arrow and use the Delete Tile 
command (Fig. 88). 

Figure 81 The Simple Search Revisited

Class Attribute

Records
Record Size, Record Type, # Tags in Record, Record ID, 

Date Created, Date Modified, Record Contents

Sets
Set 1, Set 2, Set 3, Set 4
Set 5, Set 6, Set 7, Set 8

Conditionals AND, OR
Fields Contents, Size, Type, Index

Figure 82 Attributes
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Most of the operators require that you type values in a text box for completion, but you set 
the date values using the Alarm Clock DA approach—click on month, day, or year and 
scroll with the arrow icons. Select the field types from a pop-up menu. 

Attribute Operator

Record Size
is, is not, is less than, is greater than

is less than or equals to, is greater than or equal to

Record Type is, is not

# Tags in Record
is, is not, is less than, is greater than

is less than or equals to, is greater than or equal to

Record ID
is, is not, is less than, is greater than

is less than or equals to, is greater than or equal to

Date Created is, is before, is after, is not

Date Modified
is, is not, is less than, is greater than

is less than or equals to, is greater than or equal to

Record Contents contains, does not contain
Sets in, not in

Divider OR, AND

Field Contents
contains, does not contain, starts with
 ends with, is, is not, is before, is after

Field Size
is, is not, is less than, is greater than

is less than or equal to, is greater than or equal to
Field Type is, is not
Field Index has item matching, has no item matching

Figure 83 Operators

Indexed Searches
You form index search tiles (Fig. 84) in a similar manner. Indexed searches are 
astonishingly fast because the index file created using the Index command on the Records 
menu makes an exhaustive search unnecessary. The index contains an alphabetical listing 
of the non-trivial entries from that field, a frequency indicator for each entry, and a non-
displayed pointer to the record storage location associated with each entry. Indexed searches 
are faster because DP has to read only the target records from disk. However, if you edit or 
otherwise modify the database, you must rebuild the index file. DP can index any field 
automatically using the Index command.

If an index exists for a particular field (e.g., Main Author in Fig. 84), choose ‘Index’ in the 
first pop-up on the tile. An alphabetical index with frequency count appears in the Search 
window when you place the insertion point in the text box on the tile for that indexed field. 
Scroll to locate an entry. Then click on the index entry to transfer it into the tile. If you type a 
portion of the entry the list, DP automatically scrolls to match each letter as you type (to the 
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extent possible); whatever item DP selects in the list, whether it exactly matches the contents 
of the field or not, is the item DP locates.DP displays with the entry, the frequency associated 
with the term and uses it to indicate the scope of that search condition.

The Search menu (Fig. 84) specifies the set of records DP will search, a destination folder, 
and whether the records it locates are to replace or be added to any already in the destination 
folder. This feature allows you to refine the results of one search by using the results as 
input for another search.

Figure 84 A simple search using an index

Because you repeatedly use sets of search conditions, for example, each time you import 
current records from a commercial bibliographic database, you can create and name an 
arbitrary number of complex search conditions. In subsequent searches simply recall the 
previously named and used set of search criteria.
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Figure 85 Named Search Sets

The Search Menus
Several new menu commands become available to support search operations (Fig. 86 - 
Fig. 90).

Figure 86 Search menu bar

File (Search)
While you are formulating a search, the File menu applies to the Search window only 
(Fig. 87).

Close the active search window

Quit the application

Figure 87 Search/File menu

Edit (Search)
The Edit menu performs only one search task—deletion of a tile which you first have to 
select by clicking on the arrow. The entries in the search table are referred to as ‘tiles’, 
including both the Boolean expressions formed graphically and the ‘Conditional Dividers’ 
which connect the Boolean expressions. 
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Remove the selected tile

Dimmed 
commands 
are 
unavailable

Figure 88 Search/Edit menu

Tiles (Search)
The Tiles menu (Fig. 89) places record attribute tiles, set tiles, and conditional dividers into 
the Search window.

Windows (Search)
The Windows menu (Fig. 90) behaves the same as described in detail later in Part I (of this 
chapter). The Fields command opens the floating Fields window which lists the most 
frequently used field names (and tags). To place a field name into the Search window, drag 
the field name from the Fields window and drop it into the Search window. This assures 
completely consistent names and eliminates unnecessary typing.
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Searchable 
record 
attributes

Grouping parentheses 
and Boolean operator

Searchable 
set 
membership

Figure 89 Search/Tiles menu

Abbreviations/Authority List
Most frequently used fields List

Available tag files

Open windows

Figure 90 Windows/Search menu

This completes discussion of the search menus. Now on to the next Record menu 
command.
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Record Menu

Sort... 
While in the Browse view, DiscoverPro can sort the records (or, more precisely, the pointers 
to the records) in ascending and descending order using any field or any combination of 
fields. To place a field into the Sort window, drag the desired field name(s) from the Fields 
window into the Sort window (Fig. 91) and click on the arrow adjacent to the field name to 
specify ascending or descending order. If you drag multiple field names into the Sort 
window, then DiscoverPro performs a hierarchical sort; it sorts all entries that match at one 
level according to the next lower field name. 

Name of Sort 
Conditions

Sort field
Ascending 
sort

Figure 91 Sort Windows

For example, if you drag the Additional Author and Date fields from the Fields window into 
the Sort window (Fig. 92) and set the sort orders, DP sorts the entries by Main Author (in 
ascending order), Additional Author (in ascending order) and by Date (in descending order). 
In this case, DP sorts records first according to the name of the Main Author. It sorts records 
having the same Main Author according to the Additional Author and sorts records 
matching with respect to Main Author and Additional Author in descending order by Date.
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Figure 92 Sort on multiple fields

For convenience, you can store named sets of sort criteria for quick recall from the pop-up 
menu list (Fig. 93).

Figure 93 Named sets of sort criteria

Index...
This utility creates the index files used for fast searches as described above. Although you 
can create an index for any field, ordinarily you only create index files for the most often 
used search fields. The index file name identifies its associated field, e.g., database_
name.tag_number (Fig. 94).

Figure 94 Database and Index File Icons

According the custom in DiscoverPro, drag the name of the fields you want to index from 
the Fields window and drop them into the Index window (Fig. 95). To exclude useless index 
words such as ‘a’, ‘an’, ‘the’, and the conjunctions, use the Excluded Words button (Fig. 95). 
This creates exclusion criteria and lists (Fig. 96).
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Figure 95 Index window

Figure 96 Excluded words window

Duplicates...
Duplicate records waste disk space and lead to confusion if updates are scattered among 
multiple versions of a record. Because we consider the importing of machine readable 
records a core task, an efficient procedure for removal of duplicates is vital. Access the 
Duplicates command from the Browse view and specify the conditions for identifying 
records likely to be duplicates (Fig. 97). 
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As you add each record, DP creates and adds to the record a unique identification number 
based upon the internal clock reading. Therefore, records having the same Record ID are 
suspect. In addition, you can compare a user-selected set of fields to locate duplicates by 
dragging field names from the Abbreviations window into the Duplicates window. If three 
fields such as author, date, and title are the same, duplicates are also likely. 

Drag field names from Fields 
Window and drop into list box.

Figure 97 Duplicates Window

The duplicates command identifies the records that meet the conditions specified (Fig. 98). 
DP presents all groups of suspect records for individual or collective disposition. You can 
ignore the suspected duplicates, delete the most recent versions, or place the suspects in a 
user-designated set folder for further examination and disposition (Fig. 99). 
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Figure 98 Disposition of Suspected Duplicates

  
Figure 99 Save Duplicates in a Folder

Open Folder (  [ )

Open Folder facilitates keyboard operation of DiscoverPro, requiring less dependence upon 
mouse commands. It opens the folder sets used in searches and opens the ‘All Records’ set.

Close Folder (  ]) )

Close Folder facilitates keyboard operation of DiscoverPro, requiring less dependence upon 
mouse commands. It closes the folder sets used in searches.

This concludes the discussion of the Records menu. Next let’s look at the important role of 
the Format menu.
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The Formats Menu
The Formats menu (Figure 100) supports four classes of views: Browse, Data Entry, Import, 
and Export. This menu handles DP’s stylized layout, as well as its extensive format 
capabilities. Use the first four commands to create, rename, duplicate, delete, or edit these 
format classes. When you are in the Browse or the Data Entry view, the bottom portion of 
the Formats menu lists the existing format choices for the current window. A check mark 
identifies the currently used format. At any time you can reformat the current window by 
choosing another format for the current window type from the bottom portion of the list. 
To edit one of these formats, select it from the menu and then use the Edit command in the 
middle of the menu. 

Create Browse formats
Create Data Entry  formats
Create Import formats
Create Export formats

Edit current format of current view

Select uneditable default format
Select user-created format(s)

Figure 101 The Formats Menu

The initial step in creating a new format is to choose the desired format class (Browse, Data 
Entry, Import, Export) from the list at the top of the Format menu (Fig. 101). For each format 
type (e.g., Browse, Fig. 102), you can select a format name from the scrolling list and then 
rename, duplicate, delete, or edit it, or you can create a new format. Each class includes one 
or more uneditable default formats listed in italics (Fig. 103). The Browse default shows only 
the record type and record size. The Edit default lists all non-empty fields in tag number 
order. The Import and Export defaults are for USMARC records as used by the US Library of 
Congress.
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Figure 102 Format (Browse) dialog
View Default Format

Browse Default Browse Format

Edit Tagged Format

Import USMARC

Export
USMARC

USMARC Formatted Dump

Figure 103 Default Formats

When you create or modify a format, DP provides additional supporting menus and 
commands (Fig. 104 through Fig. 105g). The Font, Size, and Style menus (Fig. 105c - Fig. 105f) 
are enabled only for the Browse and Export Formats. The name of the Layout file appears on 
the Windows menu (Fig. 105g. 

Figure 104 Formats Menu bar

Close the Open Format Window

Terminate the Session

Close the Open Format Window

Rename the Selected Format
Duplicate the Selected Format
Delete the Selected Format

Figure 105a File (Format) Menu
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Undo the Last Command

Remove Selection to Clipboard
Duplicate Selection to Clipboard
Place Clipboard Contents At Insertion Point
Remove Selection Without Clipboard Copy

Select All Objects 

Figure 105b Edit (Format) Menu

 

Fonts Currently 
Installed Can Be 
Applied to Field 
Tokens and Text

Figure 105c Font (Format) Menu
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Fonts 
Sizes 
Can Be 
Applied 
to Field 
Tokens 
and Text

Figure 105d Size (Format) Menu

Figure 105e Size Other Dialog

Fonts Styles 
Can Be Applied 
to Field Tokens 
and Text

Case 
Changes 
Supported

Figure 105f Style (Formats) Menu
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Abbreviations Replacement Window
Floating Window of Fields from Tag File

Currently Available Tag Files 
of Field Names and Formats

Open Database Window

Open Format Window

Figure 105g Windows (Format) Layout Menu

Choosing a name on the Windows menu opens and brings that window to the front as the 
active window.

Browse... 
The Browse view displays the contents of user-selected subsets of fields for multiple records 
simultaneously. In contrast, the Data Entry view deals with only a single record. You 
prescribe the choice of fields, their sequence, and their formatting and layout (length, text 
attributes, etc.) using a format-by-example process in a word processor-like window 
(Fig. 106). You can create any number of Browse formats and quickly switch among them. 
Unlike the Export format (described in another section) used to create output, the Browse 
format is for viewing and comparing records on the screen.

To assign the fields to a Browse format, drag field names from the Abbreviations Window 
and drop them into the Format Window. A formatting token representing the contents of 
that field forms at the insertion point. You can add, rearrange, and remove the tokens and 
added text using the usual Cut, Copy and Paste commands. In the Browse view (and Export 
Window discussed later) the Font, Size, and Style menus apply to the tokens (and to the text 
they represent) and to the text added to the Format window. Carriage returns create new 
lines (or paragraphs), as is customary for word processors. 
To place a record attribute field (Record Size, record Type, # of Tags in Record, Record ID, 
Date Created, Date Modified, or Name Field Group) or a special character, such as a tab or 
any other ASCII code (e.g., 13 for carriage return) in the Browse view, double-click an entry 
in the ‘Variable/Special Characters’ list.

Records displayed in the Browse view have a common height. To set that record height, use 
the Line Height pop-up menu (Fig. 107). DP automatically adjusts line height to the font 
size. Setting the absolute height in pixels lets you control the display size of pictures and, 
when used in conjunction with fixed length, text fields, allows multiple line wrapping 

DiscoverPro  4.69



within a field. Otherwise, to create multiple line records, use carriage returns between field 
tokens. Note: The Export window, the primary output path, does support word wrap.

To assign attributes such as field lengths and other such options, use the pop-up menu 
located on the field tokens (Fig. 108). The record variables use the abbreviated versions 
(Fig. 108a-c). The field variables require the more complete set of options (Fig. 108d-e). Let’s 
examine each of the options (not tokens).

Figure 106 Browse Format Window

Figure 107 Line Height
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a b c

d e
Figure 108 Field Token Options

Fixed Length... : The fixed length options (Fig. 108a andFig. 109) limit the length of text 
fields (in units of Characters, Points, Inches, and Centimeters). Remember that unless you 
are using a monospaced font, such as Courier, a character limit can result in the vertical 
misalignment of columns. The text can be (Left, Center, and Right) aligned within the fixed 
length field. If the actual text exceeds the assigned length, you can truncate the field and add 
the three dots ellipsis in the center, at the end, or not at all.

Variable Length: The Variable Length format (Fig. 108a) lets the length of the field display 
equal the length of the field contents. Type spaces or other text between the tokens for 
greater display clarity. In general, use of this format does not produce vertical alignment of 
fields, making comparisons more difficult, but formatting convenient for a quick glimpse.

Date Style...: You can form dates (Fig. 108b) using any combination of the ten options 
(Fig. 111 and Fig. 112). The dialog box illustrates your choices.

Name Style...: Because bibliographic citation standards vary greatly among publishers and 
uses, DP has an especially rich set of formatting options. The least complicated and least 
flexible, of course, is storing names in ordinary text fields. In that case, you forego the on-
demand flexibility described below of changing the form of names (order of names, use of 
initials, absence of periods after initials, etc. You lose the ability to sort records by co-author 
names, too. However, you can still locate records by co-author names using embedded 
search strings.
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Figure 109 Fixed Length Options

Figure 110 Fixed Length Width and Justification

Figure 111 Date Style Dialog
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Figure 112 Date Style Options

Fig. 113 gives you the name options available if you store every name in the database in a 
separate field in the form Last, First Middle and if you identified the field as a name field. (In 
the Tag window you first select the field and then use the Tag Contains Name Information 
on the Tags menu to designate the ‘selected’ record as a name field.) See Chapter 2 for the 
details, including how to generate alternative forms and multiple name fields on demand. 

Figure 113 Name Style Dialog

In scientific literature the ordering of the authors’ names usually conveys a ranking of their 
contribution to the work, but the ordering of the parts of an author’s name in bibliographic 
citations is often decided by publisher fiat, rather than by the roles of co-authors or by their 
preferences. In Figure 110 the pop-up menu (the triangle near the first field) moves 
automatically to the box containing the insertion point. You can form the names of authors 
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using the options shown in Fig. 113 and Fig. 114. 

For example, you can assign the form of the name of the author using the whole name; or 
the last, first and middle names in any order; or abbreviate the first and middle names with 
or without a period and with or without a space. You might use the last name first for the 
senior author and use the normal order, or any of the other combinations listed, for the 
others. If there are multiple authors, you can shorten the list using et al. If successive 
citations have the same first author, you can replace that author’s name with a string such 
as ‘__’. 

Fields Options: Any text field not designated explicitly as a Name Field, as discussed in the 
previous section, has an alternative set of field options (Fig. 115). Because any field can 
appear any number of times within a record (such that a separate name field exists for each 
author as required for USMARC records), you can elect to display one or all instances of a 
field having that same tag. You can automatically create multiple fields while DP is 
importing the record, or you can create them manually by pressing command-return. If a 
field exists in the current record, you can elect to precede the first field with numbering 
(Fig. 116) and/or text, precede the remaining fields with numbering and/or different text, 
and follow the last with numbering and/or text.
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Figure 114 Name Style Options

DiscoverPro  4.75



Figure 115 Field Options Dialog

Figure 116 Field Options Numbering

Include All Subfields: DP’s tag structure supports subfields, as described earlier in this 
chapter and in the Appendix. Because these subfields normally pertain to and elaborate 
upon the field to which the subfield is attached, this command allows you to include all 
such fields with a single command. You can select the subfields independently and place 
them in the Formats Window.

Lookup Abbreviations: Because an individual’s scholarship often centers on a few dozen 
primary journals, you can compress the database if you store abbreviated names and allow 
DP to expand them to the full name (in whatever form is required by the particular 
publisher) when you generate the list. If you check this command, DP matches the complete, 
case-sensitive field during output (Browse and Export windows). However, remember that 
the Sort command uses the abbreviated, rather than the expanded, form.

This is a dual use of the code for the Abbreviations Window for data entry in the Data Entry 
view, so refer to the discussion of the steps to create lists and to use them for rapid and 
controlled input. See the section on the Abbreviations command on the Windows menu. 

Edit...
The Edit (or Data Entry) view (Fig. 117) has a strikingly simple layout and minimal need for 
text formatting. Again, use the drag and drop technique for transferring field names from 
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the Floating Fields window (also shown in Fig. 117). You can rearrange the order of the 
fields by dragging and dropping the field names; dropping a name outside the borders of the 
window (or into the title bar) removes a name from the list. Because you can choose those 
fields of immediate interest for review and modification, you need not tab through fields 
not of immediate interest nor expose those fields to unintended modification. You can 
prescribe the order of the fields used so you need not move back and forth through the fields 
or transcribe the order of the data to match the screen layout. 

The names of the record types you defined in the Tags Window, as discussed in Part II, 
appear in the Record Types scrollable list (Fig. 117). To attach substance to those definitions, 
select the name of each Record Types list and assign the field names and their order 
pertinent to that record type using the drag and drop technique. A bullet appears in front of 
all names in the list having defined record types. During data entry use the Records Type 
pop-up menu to choose the template you create here.

Figure 117 Edit (Data Entry) Format

Import...
Bringing data stored in a file into a DP database under program control is called importing. 
Importing into a single field is discussed earlier in this chapter. Now we concentrate on the 
important ask of bringing text files of records into one or more fields. This task assumes a 
prominent role because most bibliographic databases are created in this manner. This 
feature overcomes one of the primary deterrents to the use of bibliographic software by 
working scientists—manual data entry. 
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One of the greatest strengths of DiscoverPro is its ability to import data files of various text 
formats into its internal structure. Import is especially useful for bringing records retrieved 
from various online services and CD ROM sources into DiscoverPro. Once the data is in 
DiscoverPro, you can use the full range of search, sort, and report generation tools of DP. 

In order to match the data fields with the field structure of the database, these fields must 
possess some structure. The three organizing structures recognized by DP are Tagged, 
Delimited, and Fixed Length. 

The Tagged form is the most general and flexible. Each field is preceded by a short name tag 
that indicates its destination within the record. These fields can appear in any order, and you 
can omit unused fields without disrupting the automatic matching of fields and their 
contents. No tag name can appear within a field, so a special character, such as a colon, is 
often a part of the tag. Finally, each tag must occur at the beginning of a new line.

You can assign the subfield marker, e.g., double slashes to separate author fields, as well as 
the choice of field and record terminator. 

Figure 118 Tagged Format Window
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Figure 119 Tagged Format Options

The Delimited form uses a designated character, such as tab or a comma, to separate the 
input data into fields. This structural organization is simple and widely used in 
microcomputer software. Spreadsheets usually support this file format. Fields can be empty, 
but the delimiter must be present. In fact, every record must be organized in a standard 
form—you must present the contents of the fields of each record in the expected order and 
with precisely the same number of delimiters. Fields can be empty, but must not contain the 
delimiter character as part of a text field because that would disrupt the matching of fields 
and data. The choices for field delimiter, subfield marker, and field enclosure are shown in 
Fig. 121. Many microcomputer applications use quotation marks as text field enclosures to 
distinguish text and numerical fields.

Figure 120 Delimited Import Format Window
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Figure 121 Delimited Format Options

The Fixed Length form does not insert field delimiters, but instead, allocates the input 
stream to fields based upon the known sequence of fields and their lengths. Place the field 
names in the Import window (Fig. 122) by dragging them from the Fields window and 
dropping them into place. You can change the sequence of fields, which must match the 
input stream, by dragging the field names. You can remove fields from the list by dragging 
and dropping the field names outside the Export window. 

Figure 122 Fixed Length Import Format

Once you have established the sequence, provide the lengths of the fields in the Width 
column. You might include trailing spaces in the input stream if the records originated in a 
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fixed length database and can be stripped automatically to take advantage of DP’s variable 
length fields.

Figure 123 Fixed Length Options

Export...
Although DP can display and print records from the Data Entry and Browse views, the 
primary channel for formatted output is through the Export formats—including an Export 
window for viewing and printing formatted output as well as sending formatted and 
unformatted records and parts of records to files. The Publish and Subscribe feature of 
System 7 is available through the Export window.

The Export Format window resembles the Browse window. Both use a word processor’s 
format-by-example environment. Field placeholder tokens represent the choice and 
sequencing of fields. The font, size, and style attributes you apply to the tokens apply to the 
text they represent. The text you type before or after the tokens appears in the output as you 
formatted it in this window. The Export Format and Browse windows also have the 
Variables/Special Characters scrollable list of variables. Refer to the discussion of the Browse 
format for details on these common features. Only one small difference exists in the Fields 
Options pop-up (Fig. 127). The Record Types feature, while not in the Browse window, is 
included in the Data Entry window. Please refer to the Formats menu section for the details. 

Figure 124 Export Format window
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Name Field Group

Ordered Record #

Tab

Character Code

Figure 125 Record Variables and Special Characters

Figure 126 Character Code Entry

Figure 127 Fields Options Numbering (cf. Fig. 116)

Edit “ ” The middle portion of the Format menu provides edit access to the format 
used in the open Browse or Data Entry view. The name of the current format appears in the 
Edit command name.

(Format List)  The names of the user-defined formats for the current window 
(Browse, Data Entry) appear at the end of the Formats menu. To use one of these, just 
choose it from the menu; and the window immediately reformats according to its 
specifications.
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The Windows Menu

The Windows menu lets you select and open any window and make it the active window. 
The first two choices, Abbreviations and Fields, are floating utility windows that can remain 
active at all times. The next group lists the tag files currently available to DiscoverPro. The 
final group lists all other currently open database and layout windows.

Open/Close Abbreviations Floating Window
Open/Close Floating Short List of Fields

Click to 
open a 
tag file 
window

Click to make an open database active

Figure 128 The Windows menu

Abbreviations 
The Abbreviations feature is both a typing macro and an authority control list. The 
Abbreviations window (Fig. 129 and Fig. 130) displays lists of names and their abbreviations. 
Under the conditions described below, DP automatically replaces any abbreviation you type 
in a field with its expanded form. Double-clicking on the abbreviation or expanded name in 
the Abbreviations window copies the expanded name into a text field at the insertion point. 
Use of this feature for frequently used terms, such as journal titles, assures consistency in 
journal name and spelling. The Index command on the Records menu is also useful for 
locating inconsistencies.

If you select Automatic Lookup on the List menu (Fig. 131), DP automatically replaces the 
abbreviation with the full name when you type an abbreviation followed by the designated 
character (e.g., shift-space in Fig. 134) and any modifier key(s) you assigned to the Set Lookup 
Key command (Fig. 134). This substitution is done without interrupting your typing. You 
can create multiple lists (Fig. 130 and Fig. 131) and make the abbreviations field specific.

To create an abbreviation list, use the Lists menu on the Abbreviations window (Fig. 132). 
The names of the lists appear in the View menu of the Abbreviations window. 
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To add entries to a list, select the name of the desired list from the View menu. Then choose 
New Entry from the Entries menu (Fig. 131) and supply the expanded name and the 
abbreviation (Fig. 135).

To make a list field-specific, click the zoom box on the Abbreviations window to expand the 
Abbreviations window (Fig. 129), if necessary, and drag field names from the Fields window 
into the ‘Applies To These Fields’ list box.

 
Figure 129 The Abbreviation window: Example 1

 
Figure 130 Abbreviations window: Example 2

Use the Lists pull-down menu (Fig. 131) to create multiple lists such that DP places certain 
words only in specific fields. You name the new lists (Fig. 132), and DP warns you when you 
choose to delete a list (Fig. 133). You can specify any combination of the shift, command, and 
option keys you want to use with the space character to trigger the lookup process. 
Abbreviations can be up to ten characters in length (Fig. 134).
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Figure 131 Abbreviations window menus

Figure 132 New Abbreviations List command

Figure 133 Delete Abbreviations List Dialog

Figure 134 Set Lookup Key dialog
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Figure 135 New Abbreviation Entry

Fields
The Fields floating window (Fig. 136) contains a user-selected subset of all the tags in the tag 
file. Since the Fields window remains active at all times even when another window is 
active, dragging its entries into other windows from this window is quicker than using the 
Tags window. 

Figure 136 The Fields Window: Full
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The Options menu (Fig. 137) provides alternative views of the Fields. 

  
Figure 137 The Fields Window and its Options menu

(Apple Events Tools) DP supports Apple Events, the System 7 technique for 
communication between applications. DP can be controlled externally by another 
application such as a word processor to find records and then pass the data to it. Three 
standalone applications have been created to expand the functionality of DP, making DP 
extensible. If these applications are present on your hard disk when you launch DP, their 
names appear as commands on the Windows menu. These tools are described in the 
Appendix.

(Tag files) The names of all tag files currently available to DiscoverPro are displayed 
on the Windows menu. Selecting the name of a tag file name from the WIndows menu 
opens the Tag editing window described later in Part II. If no tag file is listed on the 
Windows menu, you must use the New command on the File menu to create one or place 
one or more of the tag files supplied with DP on your hard disk (and restart DP) before you 
can define a database file. 

(Open Database Windows)  The names of all currently open DiscoverPro 
database windows is displayed at the bottom of the Windows menu. Select a window name 
to bring that window to the front.
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Part II

Tag Files
The supplied Tag files support a very broad range of DP uses. If your needs are satisfied by 
the supplied Tag files, you need not be concerned with the following discussion. However, 
because of the user-definable nature of the Tags, you can apply DP to a very rich class of 
problems—expanding the scope of DP far beyond a traditional bibliographic database 
programs. Read on if you wish to define or modify the tag files.

Contents of Tag Files: A tag file (Fig. 138) stores the complete set of field identifiers. Each tag 
has a three digit field number (used to identify fields in the USMARC system), and formal 
and familiar names for each field. The Bibliographic Database tag file supplied with DP 
conforms to this comprehensive standard for bibliographic citations and is listed in the 
Appendix. The tag file also stores various other definitions used by the databases associated 
with that tag file: the names record types, including the combinations of fields used by that 
record type, all format definitions for Browse, Data Entry, Import and Export windows, the 
Abbreviations window lists, and named sort and search instructions. The procedures for 
creating and using these several lists are described throughout this chapter in connection 
with the respective commands; here we consider only the creation and editing of the tags.

Figure 138 Bibliographic Tag File

Earlier in this chapter you learned that each field is identified by a 3 digit tag number, a 
familiar (or informal) field name, and a formal field name. In the Data Entry window 
(Fig. 139) the familiar field name appears along the left border of the window adjacent to the 
contents of that field. Subfields share the tag number of their host field, but have a lowercase 
letter appended. 

The familiar field name is usually shorter than the formal field name and is used to identify 
the fields in the Data Entry Window. The name of the Tag file and the formal field name of 
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the currently selected field are displayed at the base of the Data Entry Window if you specify 
this using the Edit menu commands in the Data Entry window).

Field Contents
Familiar field nameTag 100a

Formal field name
Name of Tag file

Figure 139 Data Entry Window Excerpt Showing Tag Information

To Create and Edit a Tag File

DP has a built-in editor for creating and modifying tag files. The tag editor window has an 
identifying icon  at its top right corner. 

• To create a completely new tag file: Choose the New command on the File menu, and in 
the dialog box that appears, click Tags File (Fig. 140), assign a file name and destination, and 
click the ‘New’ button. For convenience you should place the tags files in a Tags folder, but 
you can place them anywhere. If you transfer your database file to a different computer, 
remember to transfer the associated file tag file too. 

 
Figure 140 New dialog box

• To edit an existing tag file: Either double-click the tag file’s icon from the Finder, select the 
tag file’s name from the DP Windows menu, or double-click the active tag file name at the 
base of either the Data Entry or Browse view.

Tag file description: Fig. 141 shows a small portion of the comprehensive Bibliographic 
Database file used by the USMARC system. This list of potential field and subfield names 
encompasses the full range of citations used by the U.S. Library of Congress. There are ten 
logical groups of tags (0XX through 9XX). Click on the triangles adjacent to the tags to expand 
or to collapse these ten categories (analogous to Finder list view of folders). The tags have an 
identifying three digit number and two names—a formal name and a usually shorter, 
familiar name. You assign and edit these field names just as you do for Folders using the 
Finder, i.e., click to create an edit box. A lowercase ‘n’ identifies a field used for storing 
names. If you store the names of persons in a standard form, DP can format the name 
according to a publisher’s requirements, e.g., ‘Last, First Middle’. Note: Use the Tags menu to 
designate a field as a name field. 
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Click to 
collapse or 
to expand 
the entry.
'n' 
denotes a 
name 
field.

Subfield
Field

Tag number  Formal name  Familiar name

Figure 141 A Tag File Segment

Subfields, identified by lowercase letters, provide one additional level of structure (Fig. 141). 
DP’s special output (export) formatting allows you to include or exclude the contents of 
these related subfields in the output.

Tag Files
When the tag editor window is open (Fig. 142), a revised set of menu appears (Fig. 143). We 
identify these modified menus in this section by appending ‘(Tag)’ to the section headers. 
The File, Edit and Windows commands have specially adapted commands and, in addition, 
a special Tags menu appears. We now examine the commands on each of these menus.
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Figure 142 The Tags Window

Figure 143 Tag Window Menu bar

File (Tag):
The File menu (Fig. 144) is a subset of the database window File menu that retains the 
commands for creating a new tag file and closing and printing the active tag file. The Open 
command does not apply to tag files, but provides access to database, styled (formatted), and 
text (without character formatting) files. As expected, the Quit command appears at the end 
of the File menu.

Create a new tag (database or export) file
Open a database, styled (formatted) text, or text file
Close the active tag window

Establish printer and paper specifications
Print tags

Terminate session

Figure 144 File Menu for Tag Window

Edit (Tag):
The usual commands on the Edit menu of the Tag window (Fig. 145) do not apply to tags 
and have been dimmed. Instead, you use the ‘drag and drop’ technique to transfer your 
choice of a working subset of fields from the Tag window into the Abbreviations window. In 
addition to speed, the drag and drop technique eliminates typo problems. The Abbreviations 
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window, unlike the Tag window, remains active while other windows are active, making 
the drag and drop technique an especially attractive way to drag and drop field names from 
the Abbreviations window into dialogs for sort, search, and other field dependent 
operations. To select a range of tags, use the usual shift-click technique. To add individual 
name to the list, use command-click.

Define Names of Record Types

The standard edit commands 
are unavailable.  Use the 'drag 
and drop' technique to transfer a 
selection of one or more field 
names to the Abbreviations 
window

Figure 145 Edit Menu for Tag Window

Because bibliographic lists normally include numerous types of intellectual property (books, 
journal articles, etc, DP provides for a record-to-record variation in fields included. Use the 
Record Types command to create a list of record types (Fig. 146). 

Of course, you could create a single composite type of record that contains all possible fields 
needed to catalog any citation, but that would produce needless clutter and excessive tabbing 
through irrelevant fields. A better approach is to create and name multiple record types so 
that each record type, e.g., a book, contains only a subset of fields applicable to that record 
type. In DP you can create an arbitrary number of such record types; Fig. 146 illustrates one 
such list of record types defined for the Bibliographic Database tags. 

Record Types: Use the Record Types command (Fig. 145) to create a list of names  of record 
types, such as book and journal article. The associated dialog box (Fig. 147) allows you to add, 
edit and remove names from this list and to associate a MARC format with each type. The 
three remaining steps — naming fields, associating specific fields with the record types and 
assigning a record type to a specific record—are handled separately. You only create the list 
here. 

Note: Here’s how to complete this process: Use the Tags menu commands to create of 
the list of field names. Next, use the Formats menu commands to associate the fields 
with the record types as needed for any of the four types of windows—Browse, Data 
Entry, Import, and Export. Later when you are ready to create new records, open or 
create a database using the desired tag file, open the Data Entry window, select the 
desired Data Entry Format from the Formats menu and then assign a record type 
from the pop-up menu at the top of the Data Entry window. This means that your 
choice of record type specifies the input template, i.e., the set of fields and their 
sequencing. Only the subset of fields associated with and relevant to this record type 
are displayed!
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Figure 146 Record Types for Bibliographic Database tags

Figure 147 Record Types Dialog

To add a record type to the list click the New button (Fig. 147), supply the name in the box at 
the top-right of the dialog box, and click the OK button.

To edit the name of a record type, select its name in the scrolling window, modify the name 
in the box at the top-right of the dialog box, and click the OK button.

To delete the name of a record type, select its name in the scrolling window, click the Delete 
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button, and then click the OK button. Warning: Do not delete record types that are in use by 
an active database.

To associate a MARC format to the record type, use the pop-up menu (Fig. 148). 

Figure 148 MARC Formats

Tags (Tag) 

The Tag window has an identifying tag icon at its top right corner, indicating that you edit 
tags, not records, in this window. Here you create and name the field tags; later when you 
create a database, you will choose a subset of these tags to give structure to those records. 
Ordinarily you will copy a working subset of tags from the Tags window into the floating 
Fields window for easier access. When enabled from the Windows menu, the floating Fields 
window remains available and active while other windows are active, allowing you to drag 
and drop field names into dialog boxes to define searches, sorts, etc. 

The Tags menu (Fig. 149) provides the tools to create the field and subfield tags, to delete 
tags, to collapse or expand the hierarchical (or outline) list of tags, and to designate fields 
with special formatting support for names. 

Adds an new field/subfield tag
Deletes selected tag

Collapses/Expands Tags/Categories
Collapses all tags at once

Designates field for special formatting      

Figure 149 Tag Menu for Tag Window

The first step in creating a database structure is the clarification of your needs. You must 
provide field names and group them into logical categories. You can modify the fields of the 
database structure at any time, whenever possible, establish this before you begin data entry.

The second step is to assign names to the categories. For example, the USMARC system uses 
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the categories shown in Fig. 150. To assign or to edit a category name, click on the category 
name (not the category tag) and DP forms an edit box (Fig. 150).

Figure 150 Tag Categories

New Tag/Field...
To create a tag for a new field or subfield, use the New Tag command on the Tags menu to 
assign its formal name, familiar name and tag number (Fig. 151). Each of the 10 categories 
(Fig. 150) can have up to 100 field tags and each of these can have up to 26 subfield tags. This 
means that a database can have up to 1,000 different field names and 26,000 subfields. These 
numbers prescribe the order of the tags in the Tags window and the order of the entries in 
the Data Entry’s default format. Note:  Only the non-empty fields appear in the default view.

In the dialog (Fig. 151) supply a formal field name, a familiar field name (preferably a short 
mnemonic), and a 3-digit tag number (not already in use). To create a subfield for an existing 
field tag, enter the tag number followed immediately by a lowercase letter to identify the 
new subfield. Only two tag levels are supported—fields and subfields.

Figure 151 Field Tag Number

A working subset of tags: DP uses a drag and drop technique to assign field names whenever 
you must refer to specific fields, e.g., in search and sort tasks. This process is made even 
easier through the use of a floating Fields window. You can transfer a set of working tags 
into the Fields window to reduce the clutter and to have the working list always available. 
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To populate the Fields window, select a set of tags by clicking, shift-clicking, and/or 
command-clicking and drag them into the Fields window.

Note: Use the Formats menu to define templates for the Browse, Data Entry, Import, 
and Export windows. You cannot enter data until you define the Data Entry format. 
(See Data Entry format discussed earlier in this chapter. You can also drag a field name 
into a specific record in data entry view to modify the structure of that single record.)

Print Tags: To print a copy of the tags, first click on the triangular icons   in the left 
column of the tag window display the desired level of detail. Then use the Page setup and 
Print commands on the File menu.

Close the Tag window: When ready to close the Tag window, click the close box or 
equivalently, use the Close Tag File command on the File menu. Now let’s look at the 
remaining commands on the Tags menu. 

Delete Tag, Delete Subfield

To delete a field or a subfield tag, click to select the tag (or subfield tag) and choose the Delete 
Tag (or Delete Subfield) command. Deleting a tag also deletes any associated subfield tags.

Collapse Tag, Collapse Tag Category
Expand Tag, Expand Tag Category
The tag structure can become quite lengthy, as is the case for the Bibliographic Database file 
(Fig. 138). The collapse and expand commands perform the same function as clicking on the 
triangular icon adjacent to a tag, just as you do when viewing files names according to file 
name at the Finder.

To expand a category (or a tag list) click to select a category (or a tag) and choose the expand 
command.

Collapse All
You do not need to select a tag to collapse all tags to the most compact form (Fig. 142).

Tag Contains Name Information

To satisfy the various, commonly used, stylistic preferences in bibliographic citations, DP 
provides extensive formatting for name fields. For example, you can store an author name 
in a standard ‘Last, First Middle’ format, and DP can reverse the last and first name of any of 
the authors, or replace the first and middle names with initials (with or without periods) 
during output. This requires certain formatting features explained below.

To use the special formatting features, three data entry requirements must be met: 

1) You must identify fields that are to receive this special treatment by selecting the field and 
then choosing the ‘Tag Contains Name Information’ command from this menu. A 
lowercase ‘n’ identifies name fields (Fig. 141).
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2) You must enter each name in a separate field. Easy! To obtain additional fields having the 
same field name (Fig. 152), press command-return while the insertion point is within the 
field you wish to duplicate.

This works for any field, not just name fields. If you leave the added field blank, it will not 
be retained in the saved record. If you are importing records from another database that 
places the names in a single field separated by special characters such as ‘//’, DP’s import 
commands can split the names into separate fields automatically. The Find/Replace 
command can move the contents of one field into another for all records.

1. Place insertion point within field to be duplicated.

2. Press command-return to duplicate the field.

3. Enter the contents.

Figure 152 Create Duplicate Fields

3) You must enter a name in a particular order: ‘Last, First Middle’. Enter the last name first, 
followed it by a comma, and follow the comma by the first and middle names (or initials). If 
multiple authors exist, use this same order for each of the author fields.

DP provides some data entry assistance. If you use any of the following forms (Fig. 153) 
when entering a name into a blank name field, then when you leave the name field, DP 
automatically formats the name into Last, First Second Third, Jr. or Last, F. S. T., Jr. 
depending upon the amount of information you provide. Other entry forms are unaffected.

First, second and optional third names can consist of any combination of uppercase initials 
(with or without periods and with or without a separating space), or both names can be 
spelled out in full. Any combination of initials and complete names is acceptable. The 
optional iteration (or suffix) can be anything—Jr., Sr., III, etc.—as long as it comes after the 
comma. Placing the iteration at the end after a comma (rather than as part of the last name) 
preserves the sort order on family names. Fig. 153 illustrates the forms that are 
automatically parsed to a standard form.
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(comma) (comma space)

Last,FST Last, FS

Last,F S Last, F S

Last,F.S. Last, F.S.

Last,F. S. Last, F. S.

Last,FSecond Last, FSecond

Last,F.Second Last, F.  Second

Last,First S Last, First S

Last,First S. Last, First S.

Last,First Second Last, First Second

Figure 153 Automatically Parsed Name Entries

Refer to the discussion of the Browse and Export name formats (cf., Formats menu) for 
details on the many automatic formatting benefits of using this standardization. Specifically, 
notice that the ‘Fields Options...’ is changed to ‘Name Style...” for fields declared to contain 
name information using the ‘Tag contains Name Information’ command. 

Figure 154 Name Style Options

There are two style options for the iteration (i.e., suffix). All these tiles are conditionally 
dependent on the existence of the previous tile and the existence of the name part.

Formats (Tag)
Refer to the Formats menu discussion in Part I. Briefly, you must specify the names and the 
order of fields to appear in a record before you can enter data. For example, choose the Data 
Entry command (Fig. 155) and drag field names from the Fields window into the Data Entry 
Format window. 
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When completed, choose the name of the format from the bottom of the Formats menu 
after you have entered the Data Entry window and used the New Record command.

Assign fields and text formatting for Browse window
Assign fields to the data entry window
Match input with database fields
Assign output fields and format

Figure 155 Formats (Tag) menu

Windows (Tag)

Refer to the Windows menu discussion in Part I.

Hide/Show Abbreviations Typing Macro
Hide/Show Floating List of Fields

Select/Open Tag Windows

Select an Open Database or Layout Window

Figure 156 Windows (Tags)
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Appendix 1
Apple Events Tools for DP

DP provides a powerful set of built-in tools for managing records. DP also provides some 
powerful tools that may not be required by all users. These have been implemented as 
separate applications that interact with DP through Apple Events, the System 7 
interapplication communications link. These enhancements are not supported by earlier 
operating systems. In other words, DiscoverPro is an extensible database program. You can 
endow DP with additional functionality by placing additional Tools applications in the 
folder with DP (or better, in a Tools folder) before activating DP. These tools are used from 
within DP. Their names appear on the Windows menu just below the names of the two 
floating windows (Abbreviations and Fields) and just before the names of the database 
structure-defining tag files. When you select one of these Tools, you are actually launching a 
small application. Unlike the usual Macintosh applications, however, these Tools have a 
blank menu bar, but they are controlled through a series of dialog boxes and appear to you as 
an original part of DP. The interaction between a Tool and DP is transparent to you, and is 
handled through Apple Events.

Three such utilities (Fig. 1) are described in this Appendix: File Resolver, File Finder, and 
FTP. File Resolver examines all the pointer fields in the active database and determines 
whether the cataloged documents are present on the local hard disk or are missing. Existing 
documents (or their aliases) can be moved to a convenient location on the desktop. File 
Finder permits DP to automatically link each file or a subset of files) on your hard disk to a 
DP record using a pointer field type. Then you can search, sort, and perform the usual tasks 
on these records and then locate or even launch the file pointed to by a record. DP becomes 
an organizer of your hard disk. FTP links DP with Gopher™  to retrieve files from remote 
sites via Internet. We now review the procedures for performing each of these new tasks. 

Figure 1 Apple Events Tools
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File Resolver: 

Any field in any DP record can be used as a pointer to a document stored external to DP. In 
addition, QuickTime movies are stored external to DP and Sounds can be stored externally 
too and in that case, the field becomes a pointer too. This approach allows many large files to 
be associated with DP, but without requiring that they be stored within a the DP database file. 
If you relocate your database to a different hard disk, however, this approach requires that all 
these externally linked files must be identified and transferred too. File Resolver examines 
all these links and identifies the missing files, if any.

• Optionally group the records to be searched in one of the eight folders.

• From the Browse window choose the File Resolver command. If the Data Entry Window 
is open, either a) click the ‘End Editing’ button, b) choose the ‘End Editing’ command on the 
Records menu, or c) press the ‘enter’ key to return to the Browse window.

• Select the File Resolver command on the windows menu.

• Select one or more categories of target files (Fig. 2). 

Figure 2 File Resolver Dialog

Movies and Sound Files include only the movie and sound files (types AIFF and AIFC) that 
are executable from with DP itself. The Documents category includes all types of files such as 
word processor documents, HyperCard stacks; and, in addition, includes Movie and Sound 
files stored external to DP, but linked via the Document field type and requiring an external 
application to be executed.

As with the search and sort commands, you can apply the command to all records or focus 
the action to selected records in one of the eight subset folders.

• Specify the focus of the command for ‘Files Located From’ (Fig. 3).

• Click ‘OK’ to resolve the pointers.
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Figure 3 Source of Records to be Resolved

The File Resolver command checks all the field pointers and separately identifies the 
pointers that point to available documents and those without target documents. A progress 
indicator (Fig. 4) reports the results.Note: The FTP Tool discussed later is used to retrieve 
missing documents from a remote file server.

Figure 4 Progress Indicator

A list of all pointers is presented (Fig. 5). The status (OK or missing) is shown at the right 
margin. You can choose to hide the names of either the missing.

• Either use the usual mouse techniques to select one or more files or use the buttons. to 
either Unselect All, Select All, Select Missing or Select Found files.

• Optionally, click the now-enabled Move To button to choose a destination and relocate the 
selected files.
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Figure 5 File Resolver List of Target Files ‘Pointed To’
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File Finder

The File Finder tool creates a list of up to 500 file names from the mounted disk volume(s) 
you specify and according to simple search criteria such as an embedded string from the file 
names, file type, date created, date modified, and file size. File Finder then creates a new 
record for each of the files you select from those meeting the search criteria. Then File 
Finder can create a record for each file and establish a pointer to each selected file in a user-
selected field and can copy a specified portion of text from the file into another user-selected 
field of that record.

This tool extends the scope of the System 7 Find command. You might use this tool to create 
a DP database of file names, thereby gaining access all the power of DP for refining your 
search. You might, for example, create a list of files modified since your last backup. If you 
extract text from text files, you can use the automatic indexing of DP to locate all 
correspondence (word processor or e-mail) in which a give phrase or a person’s name is 
mentioned. You can even launch these files if the host application is resident. 

To use this tool it must reside on a mounted volume before you launch DP.  Ordinarily we 
recommend that all DP tools be stored in a Tools folder created for this purpose.

When you launch DP, the names of the resident Tools appears on DP’s Windows menu 
(Fig. 6). 

Figure 6 File Finder Command on Windows menu

• Choose the File Finder command to search for files involving any combination of 
volume, an embedded string from the file name, file type, date created, date modified, and 
file size.

The available choices appear in pop-up menus adjacent to the check boxes selected (Fig. 7). 
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Figure 7 File Finder Master Dialog

Volumes to search: You can search all mounted volumes (floppy or hard disks) or restrict 
your search to a single volume (Fig. 8).

Figure 8 Volumes To Search Pop-up

File Name: You can enter file names exactly as they appear in the directory, or you can enter 
an embedded string such as ‘txt’ or some other identifying embedded string (Fig. 9).

Figure 9 File Name Text Box

File Type: You can search all file types, or restrict your search to a particular type (Fig. 10).

DiscoverPro  App 1.6



Figure 10 File Type Pop-up Choices

Date Ranges: The creation and modification dates are convenient criteria (Fig. 11) when you 
can recall an approximate date or date interval. Three frequent categories (Today, Yesterday, 
and Within The Last Week) are supplemented by four general categories (Is, Is Before, Is 
After, Is Between). 

 

Figure 11 Date Created Choices

• Make selections from the pop-up menus and adjust the date (click on the month, day, or 
year as you do with the Alarm Clock desk accessory) to scroll the date entries.

Figure 11a Date Range
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File Size: The file size criterion (Fig. 12) allows you to select a file size range that is greater 
than, is less than, or is within a particular range.

Figure 12 File Size Choices
• Click the ‘Search’ button to initiate the search. 

A scrollable list of files meeting the search criteria will be generated. 

Figure 13 File Finder Results

• Either select all the files in the list (using ‘Select All’) or click to select a single file, shift-
click to select a contiguous range, or command-click to select a individual files.

• Click ‘Import’ to add the pointers and/or text to new records (one record for each file) in 
the active database, as specified in the next dialog box (Fig. 14).

DiscoverPro  App 1.8



Figure 14 File Finder Import Conditions

The new records can be sent to ‘All Records’ only, or to one of the eight folders (in addition 
to ‘All Records’ (Fig. 15). In the latter case, you can easily isolate the new records and delete 
them, if desired, using option-drag.

Figure 15 Destination Set Choices

 ‘Record Type’ (Fig. 14) specifies the particular combination of fields to be associated with the 
record. In this example only one type had been defined.

Check the type of data to be imported—a pointer to the actual file and/or a portion of text 
from the selected file. Next choose a storage field(s) from the pop-up menu(s).
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Figure 16 Field Destination of Pointer and/or Text

A pointer field (Fig. 17) displays the location of the file, the file creator, file type, file icon and 
the file name. The text field shows only printable characters and, therefore, should not be 
used for binary files, such as applications. 

Figure 17 A Sample Document Pointer Field
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FTP 

DP automates the process of selecting and retrieving documents from a remote site over a 
network using the FTP tool. To retrieve such documents, download and search a DP 
resource database file that describes the available resources. Each record of such a resource 
database contains descriptive fields that characterize a specific resource and that allow you to 
perform the usual selection and retrieval processes within DP. DP then launches Gopher™, 
a file transfer utility created by the University of Minnesota, and with or without 
terminating the DP session, DP transfers a list of the selected records to a Gopher Bookmark 
file. Then you complete the usual Gopher techniques to retrieve the selected files.

 DP’s powerful search and sort features supplement the usual manual techniques. In 
addition, each record must contain in tag field 990 or 990a to store the information required 
by Gopher to locate the document on a remote file server. This information is transferred 
automatically to Gopher. Note: Tag 990 is at the upper end of the USMARC tag range and is 
reserved for local cataloging uses. 

The following two sample records illustrate the retrieval procedure. In addition to whatever 
fields might be included in a record, one or more fields provide a user-characterization of 
the resource stored at a remote site. The tag field 990 or 990a must contain the information 
required by Gopher to retrieve this particular document. These are hypothetical examples 
for a text and a binary file. Only records utilizing the designated 990 tag can transfer the 
retrieval information to Gopher; the field named ‘Remote Id’ is user-defined. 

Figure 18 Sample Records For Gopher Retrieval

The DP records must contain the information required by Gopher to complete the 
retrieval process. You may have as much addition descriptive information as you wish in 
other DP fields.
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Gopher Protocol:

FTP expects the contents of the 990 field to conform to the Gopher protocol. This is a text 
string with a list of fields separated by tabs. (The # sign is used in place of a tab, since a tab is 
invisible). Tabs can be entered by typing option-tab.

The protocol is: cxNamex#xSelector Stringx#xHost Domain Namex#xPortx

This is a type code. Its currently accepted values are:

0 The item is a TextFile Entity. 
  Client should use a TextFile Transaction.

1 The item is a Menu Entity.  
  Client should use a Menu Transaction. 

2 The information applies to a CSO phone book entity.
  Client should talk CSO protocol.

3 Signals an error condition.
4 Item is a Macintosh file encoded in BINHEX format
5 Item is PC-DOS binary file of some sort.  Client gets to decide.

  (Note: this type is far from settled or final)
6 Item is a un-encoded file.
7 The information applies to a Index Server.  

  Client should use a FullText Search transaction.
8 The information applies to a Telnet session. 

Connect to given host at given port. The name to login as at this host is 
in the selector string.
9 Item is a binary file.  Client must decide what to do with it.

  (Note: this type is far from settled or final)
+   The information applies to a duplicated server.

Note: The Coalition is probably only interested in types 0 and 4.

xNamex is the name of the document or directory. This portion is what is displayed to the 
user in the bookmark file.

xSelector Stringx tells the server where to locate the file.

xHost Domainx is the name of the host that contains the server.

xPortx is the port at which to connect.
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The record retrieval process:

• Optionally select records (by clicking and shift-clicking in the Browse window or by 
checking the ‘Selected’ box in the Data Entry window) or place the records of interest in one 
of the Set folders.

• From the Browse window, select the FTP command on the Windows menu.

A dialog box (Fig. 19) identifies the active database.

Figure 19 FTP Dialog

• Assign a choice (Selected Records, All Records, or one of the set folders) to ‘Documents 
Located From’ using the pop-up menu.

• Choose some or all of the documents to be transferred (click, shift-click, or command-click) 
from the scrollable list.

• Decide whether to quit DP before launching Gopher. This is largely a matter of available 
RAM.

• Click the Fetch button to launch Gopher.

DP creates a Gopher Bookmark file (Fig. 20) containing the information needed to retrieve 
the selected files and launches Gopher.
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Figure 20 Gopher Bookmark file

The names of the files appear on Gopher’s Recent menu (Fig. 21).

Gopher

Gopher is now the active application and has access to the information supplied by Gopher. 
Fetch the files according to standard Gopher procedures.

Figure 21 Gopher’s Menubar

Figure 22 Gopher Windows

After the files have been retrieved, you can either launch them directly, or link them to DP 
using the File Finder tool discussed above.
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Introduction
Electronic publishing is now feasible using QuickTime movies with DocuView™ (DV). 
QuickTime (QT) was designed to provide animation capability for the Macintosh. With the 
current hardware limitations the image size must be limited to small sizes to achieve acceptable 
frame display rates. However, if display rate is not critical, much larger images can be 
displayed1. Furthermore, QT images are basically bit-mapped graphics that support color. Of 
course, QT can include all fonts associated with different languages and special symbols such as 
occur in mathematics and chemistry, which the 72 dots per inch resolution of the Macintosh 
screen represents satisfactorily. QT images can originate as bit-mapped graphics, or you can 
transform them into a particular format by a scanner , by conversion word processor, or other 
documents. After converting the documents into this format, you can transmit them via 
computer network and then display them using DocuView.

DocuView is a specially enhanced QT movie player; the code has been extracted from 
DiscoverPro™ to create this simple display application. The enhancements include the capacity 
to display large images on all screen sizes a) by controlling the image display size and b) by 
adding commands for convenient scrolling of the movie frames. For rapid access of specific 
portions of a document, the usual keyboard and mouse scrolling are supplemented with 
Bookmarks. These user-defined bookmarks serve as hypertext links for the table of contents. 
You can adjust the ordering of the bookmarks in the menu simply by sorting or by dragging. An 
over-ride of the picture-sound synchronization is provided so you can browse (‘play’) a 
document without repeated mouse or keyboard clicks. You can navigate throughout a 
document using either the mouse or the keyboard or a combination of these. The keyboard 
controls are listed in a ‘help’ window. Regardless of its originating application, QT movies can 
be made ‘double-clickable’ using the ‘Save As’ command. DV can also print QT frames.
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Candidates for the DV electronic documents range from text-only documents such as course 
catalogs and course and room rosters to complex technical documents involving a mixture of 
text, graphics, mathematics, etc. Apple -supplied software allows you to transform the pages of 
a word processor document into movie frames. Various third-party vendors provide QT movie 
creation tools. At least one vendor supplies hardware and software for transforming VCR 
movies into QuickTime movies. You can distribute these documents electronically and view 
them using DV. The DiscoverPro application also provides a means for organizing DV 
documents and even a link for retrieving these from remote servers on Internet.

You can change the customary publishing cycle of ‘print, then distribute’ to ‘distribute, then 
print’ for a more economical and faster distribution process.  This means, for example, that a 
faculty member might browse through journal articles electronically and print only those pages 
or articles truly relevant, assuming, of course, that the copyright holder, if any, allows this.

The DV icon and DV document icons are shown in Figure 1. DV can open and play all QT 
movies; other QT players can open DV documents, but they do not provide the convenient 
vertical scrolling required to view document images larger than the Macintosh screen.

Figure 1 DocuView icons

DV Menus
The DV menu bar (Figure 2) includes the obligatory File, Edit, and Windows menus plus three 
more control menus—Movie, Size and Bookmarks.

Figure 2 DV Menu Bar

 Menu
The first command on the Apple menu (Figure 3) provides access to the DV startup splash 
screen and copyright notice. The splash screen also notes the relationship of DV to DiscoverPro. 
A site license for DiscoverPro includes non-exclusive distribution rights for DV; copies so 
licensed will indicate this fact on the splash screen (Figure 4).

Copyright notice
and splash screen

Figure 3 Apple menu
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Figure 4 DV Splash Screen with Copyright Notice

File Menu

The file menu provides the expected file management commands: 

Open (  O): Open a QT movie file using the usual directory navigational options (Figure 6). 
Optionally, you can display a miniature portrait of the Poster frame (i.e., the frame you 
designate as the startup or most representative frame of the movie). Multiple documents can be 
open simultaneously. If you must open many large documents simultaneously, you should 
allocate additional RAM to DV. The names of all open files appear on the Windows menu. 
Command ‘O’ (i.e.,  O) is the keyboard equivalent.

• To allocate memory to DV:

1) Before opening DV, click in its icon to highlight, i.e., select, DV.

2) Use the Get Info command on the File menu of the Finder (or use  I).

3) If necessary, use the check box to unlock the file.

4) Assign the desired ‘Current size’.
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Open a file
Close the active file
Save the file (& Bookmarks)
Save file using options

Establish page specs
Print frames

Terminate session

Figure 5 File Menu

Figure 6 Open File Dialog

Save (  S) and Save As... When at least one DV file is open, the Save and Save As 
commands are enabled. No editing of the actual QT movie is possible, but there are two 
important uses for the file saving commands: saving bookmarks you add to a document and 
updating the icon associated with DV. If you save a file using DV, DV associates the DV 
document icon with the file. (When you use Save, rather than saving a new copy at a different 
location with Save As, you may need to rebuild the Macintosh desktop to update the icon by 
holding command-option down during startup. The keyboard equivalent for the Save command 
is  S.
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Figure 7 Save File Dialog

Page Setup & Print (  P) The Page Setup dialog is printer specific and contains the 
usual choices (Figure 8) These print commands operate just as they do for a word processor. 
Note: If an image refuses to print, try switching between Black & White and Color/Grayscale 
(Figure 9). The keyboard equivalent for the print command is  P.

Figure 8 Page Setup Dialog

Figure 9 Print Dialog
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Quit (  Q) Use the Quit command to terminate the program. If you have created or modified 
bookmarks since saving the file, DV warns you to save the file before terminating.

Edit Menu
The Edit menu (Figure 10) is non-functional, but is included as required by the interface 
standards.

Non-functional
placeholder for
Edit menu

Figure 10 Edit Menu
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Movie Menu
The Movie menu controls the document window (Figure 11); but you can also execute most 
commands by mouse action in the document window or by keyboard command. The Shortcut 
window contains a complete, online list of keyboard commands. The playback controls are on 
the Movie menu ,too (Figure 12). 

Scroll up 
(cmd up arrow)

Scroll

Scroll down
 (cmd down arrow)

Scroll (cmd left arrow)
Step back (left arrow)

Step forward (right arrow)

Play/Stop
 (cmd space/cmd period)

Speaker volume

Scroll

Grow box

Close document

Frame scroll (drag, click)

caps lock up/down arrow 
or page up/down
to scroll window height

See Shortcuts
Window for
complete list

Figure 11 Document Navigation commands

Play (  spacebar) If you specified a suitable frame, dwell time when you converted the 
document into a movie (say one frame per second), you can use this command for hands-off 
browsing. If the image size is large, select the ‘Play Every Frame’ command on this menu before 
choosing ‘Play’ to suppress frame skipping, ordinarily invoked to maintain synchronization with 
a sound track. The mouse equivalent for this command is the triangular icon at the lower-left 
corner of the QT window.

Stop (  .) Use Stop to interrupt the playback. Alternatively, click the stop icon on the playbar 
at the base of the QT window.

Step Backward (  - ) & Step Forward ( = )  Step Backward and Step Forward 
move you to the next lower/higher numbered frame. The keyboard equivalents are command 
minus and command equals. The icon equivalents are at the right end of the scroll bar.
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Rewind (  0) This command displays the first frame of the document.

Play movie
Stop movie
Go to previous frame
Go to next frame
Go to first frame

Play repeatedly
Play forward & backward repeatedly

Play asynchronously

Multiple screen 
choices

Figure 12 Movie Menu

Repeat and Repeat Back & Forth Repeat causes the movie to play repeatedly 
from beginning to end; Repeat Back & Forth plays the movie from beginning to end and then in 
reverse order from end to beginning before repeating the cycle. These commands are mostly of 
interest for free-running, table top displays and for animation sequences.

Play Every Frame When using the Play command to browse a document consisting of 
large images, this command assures that you skip no frames. Otherwise, the QuickTime system 
skips frames as necessary to maintain a constant frame rate.

Prefer Color Screen & Prefer Largest Screen When using a Macintosh 
which has multiple monitors, these commands determine where DV displays the document 
image.
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Size Menu

Ordinarily you view Documents at full size, the default. Sometimes a larger or smaller image is 
useful (Figure 13). 

Full Screen & Fit In Window These commands size the image width and height to 
match the full screen or the document window, respectively. DV does not preserve the width-to-
height ratio with these two commands or when you drag the Grow Box to obtain an arbitrary 
window size. 

200%, 100%, 75%, & 50% The four standard sizes do preserve the original width-to-
height ratio. Magnified or minified images sometimes reveal additional insight but cannot 
display details not included within the source image. 

Enlarge image 
without preserving 
width to height ratio

Adjust image 
size, but preserve 
width-to-height 
ratio

Figure 13 Size Menu
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Bookmark Menu

You can scroll to any frame using the controls shown in Figure 11. However, more precise frame 
location is possible. You can assign any frame to a representative, or Poster Frame, for display at 
startup. You can also identify any number of other frames by name and, subsequently, go 
immediately to any of them when you select the Bookmark name from the menu. These 
bookmarks serve the role of a table of contents. To go immediately to a bookmark frame, select 
its name from the lower portion of the Bookmarks menu (Figure 14).

Identify startup frame
Go to startup frame

Name special frames
Revise Bookmarks

Select name to go to 
Bookmark frame

Figure 14 Bookmark menu

Set Poster Frame To designate a startup frame, scroll to the desired frame, use the Set 
Poster Frame command and save the file.

Go To Poster Frame To scroll to the startup frame, use the Go To Poster Frame 
command. 

Set Bookmark... This command is a generalization of the Poster Frame command—you 
can have any number of bookmarks. To designate a bookmark frame, scroll to the desired frame, 
use this command, and supply a name (Figure 15).

Figure 15 Set Bookmark Dialog

Edit Bookmark... The default ordering of the list of bookmarks on the Bookmark menu 
(Figure 14) is the order in which you created them. Use this command to remove , edit, or 
rearrange the bookmarks (Figure 16). 
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• To delete a bookmark, click on its name to select it and then click the delete button. 

•To rename a bookmark, click on its name to select it and then click the rename button and 
respond to the dialog. 

•To alphabetize the bookmarks, click the sort button. 

•To manually assign an order, e.g., to match the order of the frames, drag the names into the 
desired sequence. 

Note: To preserve the bookmarks for future sessions, you must save the file (Figure 5).

Figure 16 Edit Bookmark Dialog
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Windows Menu

To bring an open window to the foreground, thereby making it the active window, either click 
on a visible portion of the window, or select the window by name from the Windows menu list. 
The Shortcuts window lists the numerous keyboard commands for controlling the display 
(Figure 18). The lower portion of the menu lists all open files. Select one by name to make it the 
active window.

Keyboard Command Help

List of open movies

Figure 17 Windows Menu

Shortcuts: You can navigate through a DV document using only the keyboard. The twelve 
commands are tabulated in Figure 18. Use the page up, page down, home, and end keys on the 
expanded keyboard to scroll the document while you read, moving in large increments as you 
snake through a document. On a standard keyboard without these special keys, press the 
command-option keys and up or down arrow to scroll up or down a window height. 

Note: Setting the caps lock key is equivalent to simultaneously pressing the command and 
option keys. Pressing Command-option and the left or right arrow, scrolls the screen left or right 
one window width. Without the Command-option modifier keys, the left, right, up, and down 
arrow keys set a movie back one frame (  - ), set it forward one frame (  = ), rewind it ( 0 ) , 
and toggle between play or stop (  spacebar and .), respectively.

The arrow keys in combination with the command (  ) key perform the function of the four 
screen scrolling icons. The left and right arrow keys used in combination with the option key 
scroll to the bottom of the previous frame or to the top of the next frame.
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Figure 18 Keyboard Command Shortcuts
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